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S E C T I O N

Chapter 1Introduction

PC Configure™ Programming Software for Portable and Mobile Radios (PC Configure) 
is the application you use to configure EFJohnson’s portable and mobile radios.

The following sections describe these aspects of PC Configure:

• Computer requirements
• Programming setup
• Operating and service manuals
• Software installation
• Starting and exiting
• Programming file types
• Help files
• Main screens
• Other screen information
• Programming scanning
• Firmware upgrading restrictions

1.1 Computer Requirements
The computer used to run PC Configure must meet the following minimum requirements:

• Windows® 95/98/NT/2000/XP (You cannot use Windows 3.1.)
• Pentium® processor or equivalent
• At least 16 MB of RAM
• A hard disk drive with at least 4 MB of free space
• A CD-ROM drive
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• An available serial port

1.2 Programming Setup
You need the following to program the various radios: 

• Windows®-based computer
• PC Configure
• The items listed in Sections 1.2.1 through 1.2.4
Figure 1.1 shows the connections you must make to program a portable radio. Figure 1.2 
shows the connections you must make to program a mobile radio.

Figure 1.1 Portable Radio Programming Connections 

Figure 1.2 Mobile Radio Programming Connections

Programming Cable
Connect To
Serial Port

To
Battery

To
Antenna

To
Ignition Sense

Remote Programming Interface (RPI)
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1.2.1 51xx Portable

Programming cable from computer to radio, Part No. 023-5100-920 

Note This cable, the -488 programming software, and the PDF file for this manual are included 
in Programming Kit, Part No. 250-5100-003.

1.2.2 53xx Mobile

• Programming cable from RPI to radio, Part No. 023-5300-005 
• Remote Programming Interface (RPI), Part No. 023-5300-000. 

Note The -005 cable, 5300-000 RPI, -488 programming software, and the PDF file for this 
manual are included in 5300 Programming Kit, Part No. 250-5000-004. 

1.2.3 Connecting Mobile Radios To Computer

With 53xx radios, only RPI, Part No. 023-5300-000, can be used. Other RPIs such as 023-
9800-000 and 023-9750-000 are not compatible with this radio.

The Radio Programming Interface (RPI) provides the required logic interface between the 
computer and radio. The cable from the RPI to computer is not included with the RPI or in 
the programming kit. The current RPIs have a female DB9 connector, and most computer 
serial ports have a male DB9 or DB25 connector. Therefore, a male DB9 to female DB9 or 
DB25 cable is usually required. This is a standard cable available at most computer supply 
stores or order 6 ft. DB9M to DB9F cable, Part No. 597-5900-002.

Figure 1.3 Radio Programming Interface (RPI) for 5300 Mobile Radios

The cable from the RPI to the radio is not included with the RPI, but it is included with the 
programming kits or can be ordered separately as previously described. 

This cable plugs into the microphone jack of standard front or remote mount radios. With 
53xx radios using the Handheld Control Unit (HHC), the connection point is the 10-pin 
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programming jack on the HHC junction box through a special adapter plug (Part No. 023-
5300-140). If the HHC is not equipped with the junction box (Part No.023-5300-130), it is 
also required for programming. 

1.2.4 Connecting Portable Radios To Computer

Note Although they may look the same, the 5000 portable programming cable cannot be used to 
program a 5100 portable and vice versa.

51xx Series - No RPI is required because the radio contains the interface circuitry. The 
programming cable has a female DB9 connector for connecting to the computer.

Figure 1.4 5000 Portable Programming Cable 

As with mobile radios, the cable between the RPI and computer is not included with the 
RPI. Refer to preceding description for more information. 

1.3 Operating and Service Manuals
This manual includes brief descriptions of the various programmable parameters. For 
detailed radio operating information, refer to the applicable radio operating or service 
manuals.

1.4 Software Installation

Note Before you remove an old version of PC Configure, be sure to transfer the files in the Data 
and Keys folders to those folders of the new version.

1 Ensure there are no other applications open during this installation procedure. Also, 
ensure the computer meets the minimum requirements listed in Section 1.1.

 

1-4 PC Configure Programming Guide Draft: June 29, 2006



Introduction
2 Insert the PC Configure CD-ROM in the CD drive of your computer.

3 In the lower left corner of the screen, select Start > Run and then click the Browse 
button. Select the CD-ROM drive and the file PCConfigurex_x.exe (x_x is the PC 
Configure version number). Click the Open button and then from the Run window, 
click OK and the installation process begins. 

4 Follow the on-screen instructions. The default directory for the program is \Program 
Files\EF Johnson\PCConfigure\ During installation, you can specify a different 
directory to install the program in if you wish to do so.

1.5 Starting And Exiting

1.5.1 Starting PC Configure

To start the PC Configure program from Windows, select Start > Programs > EF 
Johnson > PCConfigure 1.2x.xx.

You can also start PC Configure from an MS-DOS command prompt (C:\). To display the 
PC Configure options that can be selected from the command prompt line, enter 
PCConfigure /?. The following information then displays. 

1.5.2 Exiting PC Configure

Select File > Exit or press the <Alt> and <F4> keys.

1.6 Programming File Types
Programming data is stored in a disk file that can be saved, read, copied, and deleted. 
Refer to Section 3.1. This file automatically receives the extension .rcf .
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1.7 Help Files
To display help information on the current screen, click Help in the menu bar.

Note For a list of changes made with the various releases of this software, refer to the 
ReleaseNotes.txt file in the PC Configure program files folder.

1.8 Main Screens
You can select four different screens by clicking the tabs at the top as shown in Figure 1.5. 

Figure 1.5 Main Screen (Global screen shown)

The functions of these screens are as follows:

Global - Figure 1.5 shows this screen. It programs parameters that are the same for all 
Conventional, Project 25 Trunked, SMARTNET™, and SmartZone® systems. Refer to 
Section 4 for more information on parameters in this screen.

Radio Wide - This screen programs the parameters that are the same for all programmed 
Conventional (Project 25 and analog), Project 25 trunked, and SMARTNET/SmartZone 
systems (a different screen is displayed for each). The screen system type is selected in the 
system specific box. Refer to Section 5 for more information on parameters in this screen.

File Size
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Organizer
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Per System - This screen programs the parameters that are unique to each programmed 
system. Select the system you want to edit by clicking it in the Systems box. Refer to 
Sections 7, 8.1, and 9.1 for more information on parameters in this screen.

Zone - This screen programs the channels and zones. Unique channel parameters include 
system number and type, frequency, and talk group. Refer to Section 6 for more 
information on parameters in this screen.

1.9 Other Screen Information
This section describes the following items that appear on the PC Configure main screen:

• Programmable title and logo
• Organizer
• File size indication
• Decimal/Hexadecimal select

1.9.1 Programmable Title and Logo

You can program the title that is displayed after “Radio Configuration” at the top of the 
screen. Refer to Figure 1.5. You use the Tools > Organization Identity menu item to 
program it. You can use this, for example, to display a company name on the top line. In 
addition, you can customize the logo that is displayed on the right end of the menu bar. 
Refer to Section 3.4 for more information.

1.9.2 Organizer

Clicking the organizer button  on the right end of the toolbar displays a screen is 
used to organize the various programming files into groups and subgroups. This can make 
it easier to administer the programming files of a large organization. Refer to Section 3.8 
for more information.

1.9.3 File Size Indication

The maximum number of channels that you can program may be limited by the available 
memory space in the radio. Figure 1.5 shows the Size: box in the status bar on the bottom 
of the screen that displays a running indication of the amount of memory used by the 
current data if it was downloaded to the radio. The Size: box displays this as a percentage. 
When this percentage reaches 100%, the available memory is full and some you may have 
to delete some channels if more information remains to be programmed.
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1.9.4 Decimal/Hexadecimal Select

On some screens, such as the SMARTNET Talk Group, you can enter numbers using 
either a decimal or hexadecimal format. The format is selected globally. This means that 
when a you select a format, you must use that format to enter all applicable numbers on all 
screens. 

The currently selected format is indicated in the status bar on the bottom of the screen in 
the box next to the file size indication. Refer to Figure 1.5. A “D” indicates the decimal 
format is selected, and an “H” indicates the hexadecimal format is selected. The 
background color indicates the number type. The color is ivory for hexadecimal numbers, 
and white for decimal and other entries. 

To toggle between the decimal and hexadecimal formats, right click the H/D box and click 
“Yes” in the confirmation box that appears. This mode can also be toggled using the Tools 
> Preferences screen described in Section 3.4.

1.10 Creating Systems

Note To view the current and added systems, select the Per System tab and all programmed 
systems appear in the Systems pane on the left side.

A system as used with these radios is a collection of channels or talk groups typically 
assigned to the same repeater site. The Per System screen shows unique system 
parameters, including the scan list, various timers, and talk groups. You can create up to 
sixteen systems of any type.

To create a new Conventional, SMARTNET, SmartZone, or Project 25 Trunked system, 
select Radio > Add Systems in the menu bar and then select the desired system type. 
Refer to Section 3.2. 

Another way to create a system is to click  in the toolbar and select the desired 
system type from the drop down list. To delete a system, select it in the Systems box and 
then select the Radio > Delete System in the menu bar or  in the toolbar.

1.11 Programming Scanning
The two types of scanning that can be programmed are Radio Wide and Priority 
(Standard): 

Radio Wide Scan - Use this type when two or more types of channels must be scanned 
at the same time such as conventional and Project 25 trunked. If this is not a 
requirement, use the more efficient Priority Scan which follows because there is less 
chance of missed calls.
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Priority (Standard) Scan - Use this type to monitor only channels that are the same type 
as the selected channel. For example, if a conventional channel is selected, only 
conventional channels can be scanned. Trunked channels must also belong to the 
system of the selected channel.

1.11.1 Programming the Radio Wide Scan Mode

1 On the Radio Wide screen, program the Radio Wide Scan List and Scan Hold time as 
described in Section 5.1. You must set up the channels that you want to include in the 
scan list as described in Section 6.

2 Program the Radio Wide Scan option button by clicking the Assign Buttons button on 
the Radio Wide screen as described in Section 5.3. With 51xx portables, a Radio Wide 
Scan menu parameter can also be programmed as described in Section 5.2.

1.11.2 Programming the Priority Scan Mode

You set up Priority scan on the Per System screen because it is unique for each system 
type. Proceed as follows:

1 On the Per System screen, select the desired system in the left pane. 

2 In the System Lists drop down list near the bottom of the screen, select Priority Scan 
List. Then click the Edit List button and program the scan list as described in Section 
7.2, 8.2, and 9.2. You must set up the channels that you want to include in the scan list 
as described in Section 6.

3 With conventional channels, program the per system scan list settings on the Per 
System screen. There is also the option to link a particular scan list to a zone. Refer to 
Section 6.1 for more information.

4 Repeat the preceding steps for each system that will have Priority Scan function.

5 With trunked channels (SMARTNET/SmartZone/Project 25), you may need to 
program each channel to select a scan list and auto scan. Select the Zone screen and 
program this information for each channel if required (Sections 8.3 and 9.3).

6 Program the Scan option button by clicking the Assign Buttons button on the Radio 
Wide screen as described in Section 5.3. With 51xx portables, a Scan menu parameter 
can also be programmed as described in Section 5.2.

1.12 Firmware Upgrading Restrictions

Note Version 1.24 or later PC Configure software can only upgrade radios with later firmware 
versions. Refer to the following for more information.

Beginning in approximately June 2004, all 51xx and 53xx radios began shipping with a 
new version of firmware that uses a different memory configuration for storing the radio 
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operating program. One effect of this change is that you must use a new firmware upgrade 
utility to program radios with this firmware. PC Configure includes the firmware upgrade 
utility. You select it by the Transfer > Write Application Code To Radio menu 
described in Section 3.3. The following information describes which firmware versions 
can be upgraded with this version of PC Configure.

1.12.1 Compatibility

You must use PC Configure Version 1.24.0 or later to upgrade radios with the following 
firmware versions: 

51xx Series
Non-SEM - Version 1.14.0 or later
SEM - Version 2.04.0 or later
UCM - Version 3.04.0 or later

53xx Series
SEM - Version 2.04.0 or later
UCM - Version 3.04.0 or later
ARM - Version 1.27.0 or later

To summarize these restrictions:

• To upgrade radios to the above firmware versions or later, you must use PC Configure, 
Version 1.24.0 or later. 

• To upgrade radios to earlier versions than those shown above, you must use PC 
Configure, Version 1.22.0 or earlier. 

• If you try to upgrade firmware with the wrong version of PC Configure, the procedure 
halts and an error message is displayed.

• The boot loader code must also be upgraded when upgrading firmware versions earlier 
than the preceding. You must do this before you update the application code. Two 
passwords are provided by EFJohnson with new firmware. One selects the boot loader 
utility and the other the application code utility. 

• This limitation does not apply to standard programming of radio personality parameters. 
PC Configure is backward compatible. You can use it to program radios with earlier 
versions of firmware. However, some parameters may be available only with certain 
versions of firmware.

Some parameters described in this guide apply only to certain revision levels. Index 
numbers in superscript appear next to the names of such features (for example, “Example 
Feature9”). Table 1.1 shows the relationship between these numbers and the revision 
levels they represent. 
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1.12.2 Safeguards to Prevent Downloading Wrong Code Version

Note The following applies only to downloading application code (firmware), not to 
downloading standard personality information.

PC Configure software, Version 1.25 or later includes safeguards to prevent downloading 
an incorrect firmware version. For example, it prevents you from downloading 5100 SEM 
code (Version 2.x) to a 5100 UCM radio (Version 3.x). If this did happen, no damage 
occurs. The radio simply would not operate. You could solve this problem by simply 
downloading the correct version.

To determine the radio version, check the radio boot code version, as Section 1.12.2.1 
describes. To determine the firmware version, check the file name of the firmware being 
downloaded, as Section 1.12.2.2 describes.

Table 1.1 Key to Feature Indexes and Revision Levels

This number next to a feature 
name... ...means that you need this revision level.
1 51xx models with Flash code 1.9.0 or later and (if applicable) 53xx 

models with ARM code 1.22.0 or later.
2 Firmware Version 1.16/2.6/3.6/4.2 or later. Earlier versions may be 

different.
3 51xx models with Flash code Version 1.11.0 or later and 53xx models 

with ARM code 1.24 or later.
4 51xx models with Flash code Version 1.9.0 or later and 53xx models 

with ARM code 1.23 or later.
5 Code Version 1.24.1/2.2.1/3.2.1 or later.
6 51xx models with Flash code Version 1.11.0 or later and 53xx models 

with ARM code 1.19.0 or later.
7 51xx models with firmware Version 1.16/2.6/3.6/4.2 or later.
8 PC Configure software version 1.27.1.0 or later.
9 5300i SEM or 5300i UCM model with software from the Q3 2004 or 

later
10 51xx Firmware Versions 1.16/2.6/3.6/4.2 and (53xx) 1.28/2.6/3.6/4.2 

or later
11 51xx models with code 1.12.1/2.2.1/3.2.1 or later and 53xx models 

with code 1.24.1/2.2.1/3.2.1 or later.
12 51xx Version 1.14.0/2.4.0/3.4.0 or later and 53xx Version 1.26.0/

2.4.0/3.4.0 or later.
13 51xx models with Flash code Version 1.8.0 or later and 53xx models 

with code 1.21.0/2.x/3.x or later.
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1.12.2.1 Radio Version Detection
Since the boot loader code version number is unique for each radio type, it can be used to 
determine the radio type. However, the version numbers used by mobiles and portables are 
similar, so it does not indicate if the radio is a mobile or portable. This is determined by 
detecting the serial port type (RS-485 = mobile, RS-232 = portable).

Version 1.25 or later PC Configure software can only upgrade firmware in radios that have 
boot code with the built-in ability to identify its version. With portables, code versions 
with this ability are 1.10/2.1/3.1/4.0 or later. With mobiles it is 2.0/3.0/4.0 or later. If radio 
with an earlier version needs to be upgraded, either the boot code must be upgraded first or 
an earlier version of PC Configure must be used.

ARM 53xx radios (code Version 1.x) do not have the ability to report the boot code 
version. Therefore, if no response is received to a boot loader code version inquiry, the PC 
Configure software assumes it is an ARM radio. The file must then be named accordingly 
for an ARM radio (Section 1.12.2.2).

1.12.2.2 Code Version Detection
When you download 51xx and 53xx firmware files, you must name the files according to 
the naming conventions specified in Table 1.2 and Table 1.3. If a file name does not 
conform to these naming conventions, an error occurs and it is not downloaded. To 
download older files that do not conform to these conventions, rename them so that the file 
names conform.

Table 1.2 51xx Portable File Naming Convention
Boot Version File Naming Convention
1.x (NonSEM/UCM) 5100NonSEM_Ver_01_yy_zz
2.x (SEM) 5100SEM_Ver_02_yy_zz
3.x (UCM) 5100UCM_Ver_03_yy_zz
4.x (new SEM) 5100x_Ver_04_yy_zz

Table 1.3 53xx Mobile File Naming Convention
Boot Version File Naming Convention
1.x (ARM) 5300ARM_Ver_01_yy_zz
2.x (SEM) 5100iSEM_Ver_02_yy_zz
3.x (UCM) 5100iUCM_Ver_03_yy_zz
4.x (new SEM) 5100x_Ver_04_yy_zz
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S E C T I O N

Chapter 2Programming Procedure

This section describes the general procedure that you follow to program a radio. This 
section describes the following PC Configure procedures:

• Getting started
• Creating systems
• Entering global parameters
• Entering radio wide parameters
• Setting up zones and channels
• Entering conventional system and channel parameters
• Entering SMARTNET/SmartZone system and channel parameters
• Entering Project 25 trunked system and channel parameters
• Programming the radio (writing the file)

2.1 Getting Started

1 Select a programming file as follows:
Create a New File - To start with a new file containing default parameters, select File 
> New . When the dialog box appears, select the frequency band of the radio:

VHF
UHF 380 (380-470 MHz)
UHF Low (403-470 MHz)
UHF High (450-512 MHz)
700/800 MHz (762-870 MHz)
800 MHz (806-870 MHz)
900 MHz (896-940)

Open An Existing File - To open an existing file stored on disk, select File > Open and 
then the name of the file that you want to open.
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Read a File From a Radio - To transfer a file from a radio to the computer for editing 
or use as a basis to program another radio, connect the radio to the computer as 
described in Section 1.2. Then turn the radio on and select Transfer > Read 
Parameters From Radio in the menu bar. For security reasons you cannot upload 
encryption parameters. Refer to Section 3.3 for more information.
When setting up a new file, the following ESN Input screen is displayed.

Figure 2.1 ESN Input 

Press Cancel to read the file from the unit.

2 Be sure the correct radio type (such as the 53xx mobile or 51xx portable) is selected by 
the Radio > Series menu. Refer to Section 3.2.

3 With trunked operation, you must select the correct system key on the Per System 
screen. Refer to Section 13 for more information.

Note Some operating protocols and options may not be available with your radio. To display 
the options that have been factory-enabled for your radio, select Transfer > Read Options 
From Radio. Refer to Section 3.3.

2.2 Creating Systems
When you create a new programming file, PC Configure automatically sets up a 
conventional system. Create the desired number and type of Conventional, SMARTNET, 
SmartZone, and/or Project 25 Trunked systems by selecting Radio > Add System or 

 in the toolbar. Refer to Section 1.10 for more information.

Note The Per System screen must be selected to view the current systems.

2.3 Entering Global Parameters

1 Display the Global Parameter screen by clicking the Global tab at the top of the screen.

2 Program the applicable parameters in this screen as described in Section 4. Parameters 
that do not apply to the selected radio series are grayed out.
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2.4 Entering Radio Wide Parameters

1 Display the Radio Wide screen by clicking the Radio Wide tab at the top of the 
screen. 

2 Program the applicable parameters for all Conventional, SMARTNET/SmartZone, and/
or Project 25 Trunked systems as described in Section 5.

Note You cannot program the Radio Wide Scan List until the channels are set up as described 
in the next section.

2.5 Setting Up Zones and Channels 

1 Display the Zone screen by clicking the Zone tab at the top of the screen.

2 Set up Zones and Channels as described in Section 6. Zones can include up to 16 
channels of any type from any system.

2.6 Entering Conventional System and Channel Parameters

Note If no conventional channels are programmed, proceed to Section 2.7.

1 Display the system programming screen by clicking the Per System tab at the top of 
the screen.

2 Select the system in the left pane and program the applicable parameters for each 
Conventional system as described in Section 6.3.1.

Note You may have to define the channels further as described in the next steps before 
programming the standard scan lists.

3 Display the Zone screen by clicking the Zone tab at the top of the screen. Program the 
individual channel information of each Conventional channel in each zone as described 
in Sections 6.3.1 and/or 6.3.2.

4 If necessary, program the priority scan lists in each system (preceding Step 2). After 
you have programmed all channel information, program the Radio Wide scan list in the 
Radio Wide screen. Refer to Section 2.4.

2.7 Entering SMARTNET/SmartZone System and 
Channel Parameters

Note If no SMARTNET or SmartZone channels are programmed, proceed to Section 2.8.
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1 Display the system programming screen by clicking the Per System tab at the top of 
the screen. Make sure the correct System Key is selected as described in Section 13.

2 Select the system in the left pane and program the applicable parameters for each 
SMARTNET and SmartZone system as described in Section 8.1.

Note You may have to define the channels further as described in the next steps before 
programming the various system lists.

3 Display the Zone screen by clicking the Zone tab at the top of the screen. Program the 
individual channel information of each SMARTNET and SmartZone channel in each 
zone as described in Section 6.4.

4 If necessary, program the system lists (preceding Step 2). After you have programmed 
all channel information, program the Radio Wide scan list in the Radio Wide screen. 
Refer to Section 2.4.

2.8 Entering Project 25 Trunked System and Channel 
Parameters

Note If no Project 25 Trunked channels are programmed, proceed to Section 2.9.

1 Display the system programming screen by clicking the Per System tab at the top of 
the screen. Make sure the correct system key is selected as described in Section 13.

2 Select the system in the left pane and program the applicable parameters for each 
Project 25 Trunked system as described in Section 9.1.

Note You may have to define the channels further as described in the next steps before 
programming the priority scan lists.

3 Display the Zone screen by clicking the Zone tab at the top of the screen. Program the 
individual channel information of each Project 25 Trunked channel in each zone as 
described in Section 9.3. 

4 If necessary, program the priority scan lists in each system (preceding Step 2). After all 
channel information is programmed, program the Radio Wide scan list in the Radio 
Wide screen. Refer to Section 2.4.

2.9 Programming the Radio (Writing the File)
After you have entered all the required programming information in the various 
programming screens, you can write the information into the radio; this step is also called 
“downloading”. When writing a file, ensure that you have done the following:

• Secured all connections between the computer and radio
• Turned the radio on
• Selected the proper serial port is selected (Refer to Section 3.3.)
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Then proceed as follows:

1 Select Transfer > Write Parameters To Radio from the menu bar.

2 If no file is currently loaded, a dialog box appears to select the desired file. Otherwise, 
the current file is transferred to the radio.
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S E C T I O N

Chapter 3Menus and Tools

This section describes the controls you find in the following PC Configure navigation 
tools:

• File menu
• Radio menu
• Transfer menu
• Tools menu
• Help menu
• Toolbar
• Status bar
• Organizer

3.1 File Menu
Figure 3.1 shows the File menu.

Figure 3.1 File Menu

New - Creates a new programming file named untitled.rcf containing default parameters. 
Also displays a dialog box for selecting the frequency range.
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Open - Opens a programming file that was previously saved to disk. If a modified file is 
open, PC Configure asks you if you want to save that file before the new file is opened.

Save - Saves the current file to disk using the current file name. If it is the first time a new 
file is being saved, the following Save As screen displays to specify the file name and 
destination.

Note You cannot save any type of new programming file to disk without a radio connected. 
Refer to Section 15.2.1 for more information.

Save As - Saves the current file to disk and displays a screen for selecting a file name and 
destination if desired. The default file name is the Project 25 Unit ID in the format 
UnitID_xx

Close - Closes the current file without exiting the program so you can open or create 
another file. If you modified the current file but did not save your changes, PC Configure 
asks you if you want to save your changes before closing.

Send to Selected Organizer Group - Adds the current file to the group that you select in 
the organizer. Refer to Section 3.8 for more information.

Print - Prints the information in the current file. A screen displays to select if Global, 
Radio Wide, Per System, or Zone information is printed.

Convert Band - If the current file type is UHF 380 (selected when you create it by  
File > New), you can use this to change it to UHF LO type and vice versa. Also, you can 
use this command to convert an 800 MHz file to 700/800 MHz and vice versa.

Exit - Closes the PC Configure program. If you modified the current file but did not save 
your changes, PC Configure asks you if you want to save your changes before closing.

3.2 Radio Menu
Figure 3.2 shows the Radio menu.

Figure 3.2 Radio Menu
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Series - Selects the specific type of radio to program. You can then select only parameters 
that apply to that radio. Other parameters are grayed-out. 

Add System - Adds a new Conventional, SMARTNET, SmartZone, or Project 25 
Trunking system as described in Section 1.10. “Multi-Net” is available with Ascend radio 
models only.

Delete System - When you set-up two or more systems, this function deletes the system 
selected in the Per System screen.

Load System Keys - Allows the system keys to be loaded from a folder other than the 
default Keys folder. A dialog box displays to let you select the desired folder. Refer to 
Section 13 and “Preferences” in Section 3.4 for more information. After you have loaded 
the key from the Keys folder, proceed to the Per System tab and select the desired system. 
In the IDs System pull-down box, select the .key file. (Please refer to the Per System Initial 
screen in Sections 8 and 9.)

View Programmed Radio Wide Functions (All Protocols) - Displays the screen shown 
below that indicates the functions you assigned to the programmable option buttons on the 
Radio Wide screen. Refer to Section 5.3. You can program these buttons for a different 
function in each mode (conventional, SMARTNET, SmartZone, Project 25 Trunked). The 
screen displays a maximum of two modes selected by the pull-down lists.

Figure 3.3 Radio Wide Programmed Functions screen 

Organize Zones - Zones are programmed by protocols.
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3.3 Transfer Menu
Figure 3.4 shows the Transfer menu.

Figure 3.4 Transfer Menu

Note To stop a data transfer in progress, click  in the toolbar. Refer to Section 3.6.

Comports ... - Displays a dialog box in which you can select the serial port used to 
program the radio. Refer to Section 1.2. The default is COM1. PC Configure saves the last 
selected port, then automatically selects it again whenever someone starts the program. 
You can select Ports 1-12. Refer to “Preferences” in Section 3.4 for more information.

Baud Rates - Select the following baud rates for the following radio models. You can 
perform DSP and ARM code download functions at the higher baud rates. Refer to 
“Preferences” in Section 3.4 for more information.

Read Parameters from Radio - Transfers the information programmed in a radio into a 
new programming file. If you have not saved the current file when you select this function, 
PC Configure displays a dialog box that asks whether you want to save it. You can view, 
edit, or save the transferred data to a disk file. You many have to enter an upload password 
Refer to Section 10 for more information.

Write Parameters to Radio - Programs the radio connected to the computer with the data 
in the current programming file. You many have to enter an upload password Refer to 
Section 10 for more information.

Radio Model Baud Rate [baud]
5300 mobiles with the Rev 4 logic board 9600
5100 portables 
5300 mobiles with Rev 6 or later logic boards

19200 (default)
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Note Later 51xx and 53xx models have safeguards to prevent unauthorized cloning. Refer to 
Section 15 for more information.

Write DSP Code To Radio - Reprograms early 5300 radios. Refer to Section 16.

Write Application Code to Radio - Programs all 53xx and 51xx radios with updated 
firmware (operating software). With “F” and earlier 5300 radios, this code is referred to as 
ARM code. 

Note You can only use PC Configure to upgrade radios to the latest radio firmware release. 
Refer to Section 1.12.

Proceed as follows:

1 Obtain from EFJohnson a special computer file containing the operating code. The 
application code has a .hex extension, and the 5300 DSP code (if applicable) has an .out 
extension. With all 51xx models, copy the .hex file to the PPC\5100\ folder of the PC 
Configure program. With later 53xx models, copy it to the PPC\5300_i\ folder. With 
early 53xx ARM models, copy the .hex file to the ARM\5300\ folder, and the .out file to 
the DSP\5300\ folder. You can also use other file locations if you wish.

2 Put the radio in the firmware programming mode as follows. 

53xx - Turn power on with the special Flash Mode Select Plug, Part No. 023-5300-010, 
plugged into the microphone jack. Another way to do this is to short Pin 3 to Pin 7. 
With the HHC, plug it into the programming adapter plug that is plugged into the 
junction box programming connector.
51xx - Turn power on with the option button above the PTT switch pressed.

3 For 51xx radios, select the 115,200 baud rate. For 53xx radios, select the 57,600 baud 
rate.

4 If applicable, make sure the radio is connected to the computer, then select this 
function. Enter the password (obtained from EFJohnson) in the screen that displays and 
click the OK button.

Note You may need to update the boot loader code as well as the application code. Update the 
boot code first. You select the Boot Loader utility by one password and the application 
utility by another. Refer to Section 1.12.
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5 The Radio Code Download screen is displayed. Enter your password and press OK.

Figure 3.5 Radio Code Download screen 

5 The following screen displays. Select the loader and code files if required by clicking 
the Change button. The PC Configure software includes the loader file. If you need an 
updated loader file, select the updated file instead of the included loader file. The 
application code file should be in the folder you selected in Step 1.

Figure 3.6 Code Download screen 

6 Click the Start button to begin code downloading. Click Start again if a failure occurs. 
Writing may require 20 minutes or more. With the early 53xx, repeat for DSP code if 
applicable.

Note After downloading is complete, perform Read Parameters from Radio and then Write 
Parameters to Radio to ensure the file format is correct.

Read Version Info from Radio - Transfers version information on the software the radio 
contains and then displays it as shown below.
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Figure 3.7 Version Information screen 

Read Options from Radio - Displays information about the options enabled in the radio 
as shown in Figure 3.8. The check boxes indicate which options are enabled. They are for 
informational purposes only and cannot be edited.

Figure 3.8 Transfer > Read Options Screen (5300 Shown) 

Use the Update Options button to add additional options that were purchased for the 
radio. An encrypted data file keyed to the radio serial number unlocks these options. This 
file has an .opt extension. When you click this button, PC Configure displays a screen that 
lets you select and download this data file.

Read/Write IP Address - (5300) This function is not used because an Ethernet link to the 
radio is currently not supported. It displays the preceding “IP Address” screen which 
reads/edits the IP address stored in the radio.
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Figure 3.9 IP Address screen

3.4 Tools Menu
Figure 3.10 shows the Tools menu.

Figure 3.10 Tools Menu

Toolbar Options - Displays the following dialog box from which you select the icons that 
the toolbar displays. Refer to Section 3.6. When you check and highlight the Custom box, 
the additional window is displayed to allow you to select which icons to display. PC 
Configure saves the last selected configuration, then automatically reselects that 
configuration when you restart the program.

Figure 3.11 Toolbar options screen

Organization Identity - Displays the following screen in which you can designate a 
unique company title and logo to display on the programmer screen. 
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Figure 3.12 Organization Identity screen 

To display a unique company name, enter the desired name in the Organization’s Name 
box in this screen. It then displays after Radio Configuration - at the top of the screen. 
Refer to Figure 1.5.

A logo displays on the right end of the toolbar. When the radio performs a read or write 
operation, this logo changes. To display the default logo, check the Use Default box. To 
display a custom logo, create a bitmap file of the desired graphic that meets the following 
requirements. You can use a photo editing program to create the bitmap.

• 53 W x 22 H pixels 
• .bmp file format
• 256 colors or higher recommended
• You can create a maximum of 30 files. You can name them Logo1.bmp, Logo2. bmp, 

and so on up to Logo30.bmp. These graphics are then displayed in rapid succession 
during a radio read or write operation.

Password Management - Displays the following screen in which you can enable, disable, 
and change radio passwords. You must connect a radio to the computer to display this 
screen. Actual passwords never display in this screen. PC Configure always represents 
passwords as eight asterisks (********), no matter how long the passwords really are.

Figure 3.13 Radio Password Management screen 

Note This is a new feature available only with later 51xx and 53xx radios with updated 
firmware. The power-up password previously programmable on the Global screen with 
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earlier models can be programmed in those models only with PC Configure, Version 
1.21.6 or earlier. Refer to Section 10 for more password information.

User - This drop down list selects the particular password that you want to change as 
follows:

User 1, User 2, User 3, User 4 - You can program up to four different power-on 
passwords. The same user features are available with each.
Upload, Download - The radio user must enter these passwords to Upload (read) or 
Download (write) programming parameters. The radio user does not need a User 
passwordto upload or download parameters.
Master - This password overrides all the other passwords. A system administrator 
can use it if any of the preceding passwords are lost.

Selected User - This box indicates status of the selected password (Enabled or Disabled). 
The Password box always indicates eight asterisks, and you cannot edit it.

Proceed as follows to set up or change a password. Passwords must be 1-8 characters long 
and consist of numbers 0-9. Zeros are valid characters in any location, even as leading 
characters.

Changing a Password

Note To enter a password, click the first asterisk or select all eight asterisks. If you enter an 
incorrect password, a red “!” exclamation point displays to the right of the box, as shown 
in the preceding screen. You must then reenter the password.

1 Select the password in the pull-down menu.

2 If the password was previously set up, enter the current password in the Original/
Master Password box. If this is the first time the password is used, it initially consists 
of null (deleted) characters. In this case, do not enter anything in this box.

3 If you are enabling or disabling the password, click the appropriate Enable or Disable 
button. Proceed to Step 6.

4 If you are changing or initially setting-up the password, enter the new password in the 
New Password box, then reenter it in the Re-enter New Password box to confirm it. 
Click the Change button.

5 Repeat for other passwords as required.

6 To exit without sending the change to the radio, click the Cancel button. To exit and 
send the change to the radio, click the OK button.

View Key Device - This field is used to view the system key (dongle) file. (For 5100x and 
5300x radios only.) Refer to Figure 3.14

Edit Key Device - This field is used to edit the system key (dongle) file. (For 5100x and 
5300x radios only.)
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Figure 3.14 Key Device screen 

Preferences - Displays the following screens from which you can set several program 
preferences.

Figure 3.15 Preferences: PC Configure screen

On New - When you check Always, PC Configure automatically creates a 
programming file with the radio series and band selected by the pull-down menus. 
This happens when you select File > New or click the  button. However, the you 
cannot change the band of the file, so you can only create files with the selected 
band. If you do not check this, you select the band in a separate step before you 
create the file as described below.
On Exit - When you check one of the parameters in this box, PC Configure restores 
that parameter to the current condition when you restart the program. Otherwise, the 
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default is selected. Note that if you check On New > Always, it overrides the first 
two parameters.

Remember series - When you create a new file by selecting File > New or 
clicking the  button, PC Configure automatically selects the current radio 
series. If you do not select this, “5300” is the default.
Remember band - When you create a new file by selecting File > New or 
clicking the  button, PC Configure highlights the current frequency band when 
the band select screen displays. You can also change the frequency band if you 
wish. If you do not select this, “VHF” is the default.
Remember baud rate - PC Configure automatically reselects the current baud 
rate. Refer to Section 3.3. If you do not select this, “19200” is the default.
Remember keys directory - PC Configure automatically reselects the current key 
directory. If you do not select this, the “Keys” folder is the default. Refer to “Load 
System Keys” in Section 3.2.

General
Use Hex input (applicable parameters only) - When selected, you must enter all 
applicable numbers in hexadecimal format instead of decimal format. All 
hexadecimal numbers are indicated by an ivory-colored background. Refer to 
Section 1.9.4 for more information.

Figure 3.16 Preferences: Other Screen 

Serial Communication
Send/Get Delay - Allows you to program a serial port delay of 0-18 (x 56 ms). 
You may need to program this delay may need if you use computers that are slow 
to respond to serial port signals. If the software times-out during read/write 
operations, try increasing this delay. Usually, select the default level of “0” (no 
delay).

3.5 Help Menu
Section 3.17 shows the Help menu.

Figure 3.17 Help Menu
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Contents - Displays the help system table of contents.

About Configuration Software - Displays the PC Configure version number and 
company information.

3.6 Toolbar
The tools in the toolbar provide quick access to many menu functions. To display the 
tools, select the Tools > Toolbar Options menu described in Section 3.4. You can use this 
menu to turn on and turn off the Standard, Transfer, Help, and Custom tools. 

3.6.1 Standard Tools

Refer to Section 3.1 for more information on these functions.

 New - Opens a new programming file containing default parameters.

 Open - Loads a file from disk. Clicking the down arrow displays a drop-down list 

of recently loaded files.

 Save - Saves the current file to disk.

3.6.2 Transfer Tools

Refer to Section 3.3 for more information on these functions.

 COM Port - Selects the serial port used to connect the radio to the computer.

 Read Parameters From Radio - Transfers data from the radio to a new 

programming file. 

 Write Parameters To Radio - Programs the radio with the data in the current 

programming file.

 Stop Data Transfer - Cancels the data transfer in progress.
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3.6.3 Help Tools

 Help - Displays help information.

 Manual - Reserved for future use.

Status Bar

3.6.4 Custom Tools

 Add System - Adds a new system. Clicking the down arrow displays a drop-down 
list of the system types that can be added.

 Delete System - When the Per System screen displays, clicking this button deletes 
the selected system.

 Edit Zones and Channels - Displays the Edit Zones and Channels screen.

 Edit Radio Wide Scan List - Displays the Radio Wide Scan List edit screen.

 Read Version From Radio - Reads version information from the radio for the 
software it contains and then displays that information.

 Read Options From Radio - Reads option information from the radio and then 
displays it.

 Write DSP Code To Radio - Programs early 53xx models with new DSP software.

 Write Application Code To Radio - Programs the radio with new Application/
ARM software.

3.7 Status Bar
Section 3.18 shows the status bar.

Figure 3.18 Status Bar

Band - The frequency band of the file. You select this when you create a new file with the 
File > New function.

Series - The radio series of the file selected by the Radio > Series function.

InformationDecimal/Hexadecimal Indicator
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File - The file name of the current programming file. You specify this name the first time 
you save the file with the File > Save function, or you can change it with the File > Save 
As function.

Size - Indicates the percent of the available memory that would use if you programmed the 
radio with the current file. Refer to Section 1.9.3.

D/H Box - Indicates whether the decimal or hexadecimal number format is selected. Refer 
to Section 1.9.4.

Information - Displays a short description of tools in the toolbar when they are selected 
by the cursor.

3.8 Organizer
Figure 3.19 shows an example of the organizer screen.

Figure 3.19 Organizer Screen Example

Clicking the organizer button  on the right end of the toolbar toggles the preceding 
screen that you can use to organize many programming files into groups and subgroups. 
This should make it easier for you to organize files if you administer a large organization. 

Note This organizer does not add, delete, or move programming files on the hard drive. It 
simply organizes those files into logical folders and subfolders.

The folder symbol  represents groups. The  symbol represents programming files. 
A  symbol next to an item indicates that the branch is expanded, and clicking it 
collapses the branch. Likewise, a  symbol indicates that the branch is collapsed, and 
clicking it expands the branch. If a file in the organizer was deleted from the hard drive, it 
is indicated by a red “X” through the icon .

1 To add the current programming file to the Organizer, select the desired group in the 
organizer and then select the File > Send to Selected Organizer Group menu item. 
Refer to Section 3.1. To add other files, see Step 3.
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2 To open a file listed in the organizer, simply double click it, drag it to the main 
programmer screen, or select Open as described in the next step.

3 To add, edit, delete, or move a group or file, right click the applicable group or file. The 
following window is displayed. 

Open - Opens the selected file. If you have not saved the current file, PC Configure asks 
you if you would like to save it first.

Add Group - Adds a new group below the selected location.

Add File(s) - Displays a screen that you can use to select a file on the hard drive to add to 
the selected location.

Delete Group - Deletes the selected group from the organizer only. If you select Delete 
Group, it does not delete the actual files on the hard drive.

Delete File - Deletes the selected file from the organizer only. If you select Delete File, it 
does not delete the actual files on the hard drive.

Show Full Path - Displays the entire path name of the file on the hard drive.

Cut - Moves the selected group or file to the clipboard.

Copy - Copies the selected group or file to the clipboard.

Paste - Copies the current clipboard file to the selected location

Rename - Renames the selected group.

Note You cannot rename files from the organizer.
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Chapter 4Global Screen

PC Configure global parameters are the parameters that are the same for all systems, 
channels, and zones. Two screens contain the interface at which you program these 
parameters. This section contains descriptions of the parameters that you find on these 
screens.

Some parameters described in this section apply only to certain revision levels. Index 
numbers in superscript appear next to the names of such features (for example, “Example 
Feature9”). Table 1.1 shows the relationship between these numbers and the revision 
levels they represent.

4.1 Global Parameters: Initial Screen
Figure 4.1 shows the initial Global parameters programming screen. The screen displays 
as active parameters only those parameters that apply to the selected radio series. The 
other parameters are grayed out.
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Figure 4.1 Initial Global Parameter Programming screen (5100)

The parameters in this screen are as follows:

Systems - Displays the number of systems that have been created as described in Section 
1.10. 

Zones - A zone is a programmed collection of up 16 channels of any type.

Number of Zones - The total number of zones currently set up. The maximum number 
allowed is 16. Zones are created in the Zone > Edit Zones screen by clicking the  
button. Refer to Section 6.1.1.
Home Zone - Selects the zone set for the Home Zone option function button (if 
programmed).
Home 2 - Selects the secondary Home Zone function button.
Power Up In - Selects whether the radio powers up on the Home or Last Selected zone. 
Power Up Zone - When data is uploaded from a radio, this number indicates the 
power-up zone in the radio. It does not change until the current data is downloaded and 
then uploaded again.

Favorites  - Provides users the ability to setup their “Favorite Channels” in 
one dynamic zone, allowing the user to change channels at will, without impacting any of 
the zones / channels that are already programmed. When the Favorites button is selected, 
the following screen is displayed. 
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Figure 4.2 Favorite screen 

Once enabled, you can change the name of the Favorites Zone and the channel 
assignments. The default name is set to “FAVORITES”. You may set the 16 Favorite 
channels via drop down menus that show all of the zones and channels programmed in 
the radio (Refer to Section 2.5). If no Zone/Channels are selected, the channel is 
unprogrammed.
Combined Zone/Channel Display - Can combine channel amd zone alias on radio 
display. May enter up to nine characters to identify the channel and zone.

Figure 4.3 Combined Zone/Channel screen 

Channels

Home - Selects the channel set for the Home Zone function button (if programmed) 
when the radio powers up on the Home zone. With the 51xx, the radio user can select 
this only if the channel selector switch is disabled. Refer to “Channel Selector Enabled” 
parameter on Page 4-7.
Home 2 - Selects the channel set for a secondary Home Zone function button (if 
programmed) when the radio powers up on the Home zone.
Power Up In1 - Selects if the Home or Last Selected channel is selected on power up. 
With the “Last Zone”/“Home Channel” power-up configuration, you select the 
programmed home channel number of the last active zone. If that channel number is not 
programmed in the active zone, “Unprogrammd” displays. With the 51xx or Ascend 
portable, only “Home Channel” is available if the channel selector switch is enabled.
Power Up Channel - Indicates the power-up channel in the radio similar to Zones > 
Power Up Zone. 
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Global Emergency Channel - Selects the zone and channel on which you transmit all 
emergency calls and alarms, regardless of the channel type currently selected. For 
example, if the global emergency channel is a conventional channel and a trunked channel 
is selected when the emergency is initiated, it transmits on the conventional global 
emergency channel.

Power

Battery Saver (portables only) - If this is checked, 51xx and Ascend automatically 
switch to the low transmit power mode when the RSSI signal indicates the site is 
probably nearby. This occurs only when the radio operates in the SMARTNET/
SmartZone or Project 25 trunked modes.
Low Battery Indicators (portables only)

Low Battery Beep - When checked, a short tone sounds periodically in the standby 
mode while the radio detects a low battery condition.
Tx Chirp - When checked, a chirp sounds each time the radio user presses the PTT 
switch while the radio detects a low battery condition.
LED Indicator - When checked, the LED on the top panel indicates a low battery 
condition. For example, the 51xx indicator flashes red in the receive mode. 
Low TX Power - When checked, the radio operates on low transmit power when it 
detects a low battery condition.

Ignition Power Down (mobiles only) - When the ignition switch controls radio power, 
this sets the delay that occurs between when the radio user turns the ignition switch off and 
when the radio power actually turns off. You can select times of 0-254 minutes or an 
infinite time (no turn-off).

Soft Power Down (51xx and Ascend portable only) - The soft power down feature 
prevents the radio user from turning off the radio power accidentally turning the top 
panel on-off/volume control. You can program any side option button for this function 
(in addition to the button’s normal function). Then, to turn the power off, the radio user 
must press the programmed option button during or just after power is turned off by the 
on-off/volume control.

Sound

Tone ON - If you check this, all supervisory tones sound. If you do not check this, no 
tones sound.
Horn Cadence (53xx and Ascend mobiles only) - Programs the following styles when 
the horn alert option switch enables the horn alert. Repeating does not occur with either 
style.

Style 1 - The horn is on for 1 second and off for 0.5 second for three cycles.
Style 2 - The horn sounds continuously for the programmed time (2-255 seconds).

Minimum Volume (mobiles, 51xx, and Ascend portable) - Sets the minimum volume 
level the volume control can select. You can use this to prevent missed messages caused 
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by unintentionally turning the volume down too far. Relative levels of 0-255 can be set 
in steps of 1 (“0” sets the lowest minimum volume).
Alert Tone Volume - This adjusts the alert tone volume level relative to the volume 
control setting. The radio user can also do this by a Tone Volume Edit option button if 
one is programmed. Changes made by this button permanently override this setting. 
You can set relative levels of –170 to +170 in steps of 1. “0” is the standard default 
setting. 
Keypad Tone Volume - Adjusts keypad button press tone levels. 
Mic Levels  - Displays the following screen which sets the microphone 
sensitivity for various types of calls. You can set relative levels of 0 (least sensitive) to 
4 (most sensitive) for analog, digital, and SecureNet® (encrypted) calls, with “4” the 
default. You can only set this with 51xx models that have Version 1.6.0 or later Flash 
code, and 53xx models that have Version 1.38.0 or higher DSP code (or any 2.x/3.x 
code with both models). 

Figure 4.4 MIC Levels screen 

Cursor (53xx and Ascend mobile only) 

Cursor Time-Out - Programs the time delay that occurs before the cursor (zone or 
channel select indicator) returns to the default position programmed in the next 
parameter. You can program times of 0-255 seconds. “0” selects no return.
Cursor Position - Selects whether the Zone or Channel select mode is enabled when 
the radio user turns the power on and after the preceding time-out period expires.

Keypad (Portables Only)

Keypad Type - Selects if the portable radio has a full DTMF Keypad or a limited 
keypad (without the 0-9, *, # DTMF keys).
Permanent Keypad Lockout2 - If you check this, you permanently disable the front 
and side panel keys. You cannot enable them again. If you select the Front Only 
Keypad Lockout parameter that follows, you permanently disable only the front panel 
keys. The radio user can still use the side panel keys.
Lock Channel Selector2 - When checked, the Keypad Lockout function also 
temporarily locks the top panel channel selector switch. When not checked, it remains 
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functional when the keypad is locked. To totally disable this control, do not select 
Channel Selector Enabled which follows.
Lock Volume Knob2 - When checked, the top panel volume control function (but not 
on-off) is also temporarily locked by the Keypad Lockout function. When not selected, 
it remains functional when the keypad is locked. To totally disable this control, program 
an Up/Down volume button. Refer to the following section on the Volume Ticks 
parameter.
Front Only Keypad Lockout2 - This controls the keys that are disabled by the 
preceding Permanent Keypad Lockout function and the Keypad Lockout option 
button if programmed. If neither of these functions is used, checking this parameter has 
no effect. If this box is checked, the front panel keys are disabled but the side panel keys 
remain active. If this box is not checked, both the front and side panel keys are disabled.
Backlight During Keypad Lockout2 - If you check this box, the backlight turns on 
normally when the user presses a key with the keypad locked (if Backlight on 
Keypress which follows is enabled). If you do not check this box, the backlight is also 
disabled when the keypad is disabled.

Other

Hangup Box Monitor (mobiles only) - When checked, enables microphone off-hook 
detection. Taking the microphone off-hook then enables the monitor mode 
(conventional only) and disables scanning. When not checked, taking the microphone 
off-hook has no effect on these functions.
Backlight on Key Press (portables only) - If checked, the backlight turns on for the 
Backlight ON Time whenever the radio user presses a key.
Programmed Channels Only on Display (53xx only) - If you check this box, the radio 
user can select only programmed channels. If you do not check this box, the radio 
displays all channels. When the radio user selects an unprogrammed channel, 
“UNPROGRAMD” displays and a tone sounds.
Backlight ON Time (portables only) - Programs the period of time in seconds the 
backlight stays on after it is enabled by pressing a key. Refer to the preceding section on 
Backlight on Key Press. You can program times of 0-7.5 seconds in 0.5-second steps. 
When the radio user turns on the backlight by the option switch or menu parameter, the 
backlight stays on.
Backlight Level (mobiles only) - Selects the backlight brightness as “Off,” “Mid,” or 
“High” whenever power is on. The backlight option switch can override this setting if 
that switch is programmed.
Controller Type (53xx only) - Selects the type of control head being used. Select 
“Normal” for the standard front or remote mount control head. Select “Handheld” for 
the Handheld Control Unit.
Volume Ticks (51xx only)3 - When you program a Volume Up/Down button on the 
Radio Wide screen for a particular system type, the volume control is disabled when 
the radio user selects a channel programmed for that system type. This then selects the 
number of button presses (“ticks”) required to change from minimum to maximum 
volume. You can program from 1 to 50 steps. Refer to the preceding section on the 
Lock Volume Knob parameter. 
Menu Enabled (51xx only) - Enables the menu mode with 51xx portables. The <F1> 
and <F2> keys then become menu exit and select keys instead of programmable option 
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keys. If you do not select this parameter, the menu mode is not available and <F1> and 
<F2> remain as programmable option keys.
Channel Selector Enabled (51xx only) - Enables the channel select knob in the top 
panel. If you do not check this, you permanently disable the channel select knob and the 
radio user can only select channels by the Channel Select option button or menu 
parameter. Refer to the preceding section on the Lock Channel Selector parameter.
Ignore Clear/Secure Switch when Strapped4 - When you select this, the mode 
selected by the switch (or menu parameter with the 51xx) is ignored and the 
transmission always occurs in the strapped mode. In addition, the error tone and “Sec 
Only” or “Clear Only” do not display when the switch selects a different mode than the 
one that is strapped.

Note If all channels and talk groups are strapped Clear or Secure and no Clear or Secure 
option switch or menu parameter is used, you must always select this parameter. Refer 
to the following.
Without the Clear/Secure switch or menu parameter, the radio is always in the last 
known state (usually Clear) and there is no way to change it. For example, if the last 
known state is Clear and you do not select this parameter, the radio user can never 
transmit a Secure message on a channel strapped Secure. When the user tries to do this, 
the following occurs:

• Transmitting is disabled

• An error tone sounds

• “Sec Only” displays

LED Disabled w/ Backlight OFF (5300 Only)5 - When you select this, the front panel 
transmit indicator is disabled whenever the display backlight is off. If you do not select 
it, this indicator operates normally regardless of the backlight state (except when you 
select the surveillance mode).
Channel 1 Audio Alert (5300 Only) - When rolling from channel 16 to channel one, 
an audio tone sounds to alert the user that you have rolled over to the beginning of the 
zone.
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4.2 Global Parameters: Second Screen
You open and close a second Global screen when you click the  buttons in the 
upper right corner of the screen. Figure 4.6 shows this second screen

Figure 4.5 Second Global Parameter Programming Screen (for 5100 series)
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Figure 4.6 Second Global Parameter Programming Screen (for 5300 series)

The second Global screen displays the following parameters:

PA (5300 only) 

Rx Audio to External PA - Microphone audio always connects to the Ext PA line of 
the accessory cable. If you select this parameter, the receive audio signal also connects 
to this line. 
External PA Display Indication - If you select this, “Ext PA On” displays 
continuously when the Ext PA option button enables the external PA function. If you 
do not select it, “Ext PA On/Off” flashes in the display when the radio user presses a 
button.

OTAR (Over-the-Air Rekeying)

Unit RSI - This sets the individual Radio Set Identifier of the OTAR radio. You 
typically set this number to the Digital Unit ID, but you can also program other 
numbers if you wish to do so. The allowed range is 1 - 9,999,999.
Key Management - Your key management mode determines the method you use to 
load and manage encryption keys. The Motorola keyloader has ASN and Astro 25 
modes. You can use the ASN mode to load analog channel keys (DES or DES-XL) 
only. You can use the Astro 25 mode to load both analog and digital (DES-OFB or 
AES) channel keys.

Mode - Select the PID/ASN or SLN/CKR mode as follows. The keyloader function 
of the EFJohnson Subscriber Management Assistant (SMA) supports the SLN mode 
only. The Motorola keyloader operates only in the ASN mode when you select “PID/
ASN”, and in either the ASN or Astro 25 mode when the you select “SLN/CKR”.
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PID/ASN Mode - Select this mode to load analog channel keys directly into a 
Key PID (Physical ID) from 0-15. The following restrictions are true of this mode:

ΟYou can load digital channel keys in this mode
ΟOTAR is not available
ΟYou cannot use the keys table 

SLN/CKR Mode - Select this mode to load keys into an SLN/CKR location from 
1-4095 instead of a Key PID location from 1-16.

Note You must select this mode to program the radio for OTAR.
You can specify a maximum of 16 SLNs. The following key (alias) table links 
each SLN to a Key PID. Storage Location Number (SLN) and Common Key 
Reference (CKR) are equivalent terms.

 - Clicking this button displays the OTAR keys table screen shown in 
Figure 4.7. In this screen, you associate Key PIDs 1-16 with the SLN/CKRs from 
1-4095 specified when you load the key. You must program this table if you 
selected the SLN/CKR mode described above. The SLN/CKR number points to a 
specific key slot (of both keysets is using OTAR). The radio briefly displays the 
10-character key alias when transmitting, changing channels, and switching 
between the clear and secure modes.

Figure 4.7 OTAR Keys Table Screen

Infinite Key Retention6 - If you select “On”, the radio stores keys in its memory and 
does not lose them when power is removed. If you select “Off”, the radio maintains 
the keys with power removed only until the storage capacitance discharges 
(approximately eight hours with a 53xx mobile and 30 seconds with a 51xx 
portable).
Erase Keys on Keyset Change (OTAR only) - If this is selected, the keys in the 
original keyset are erased when the OTAR Changeover command or the Keyset 
option switch are used to select the other keyset. If this not selected, the keys in the 
original keyset are not erased when this occurs.
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GPS (5300 Only) -The GPS feature can be used with other equipment to determine the 
geographical location of the subscriber unit. 

Auto Transmit - Check if you wish the location of the unit to be transmitted.
Interval - If Auto Transmit selected, enter the time intervals for transmittal in one-
second intervals.
Time Zone - Select your time zone or Greenwich time.

External Serial Connector - Select GPS if using external device and Other if using P25 
data over IP applications.

External Emergency Switch (5100 Only)7 - Selects the emergency mode if the radio 
remains in a horizontal position for the programmed time. The emergency mode selected 
by this feature functions the same as if the radio user pressed the emergency button. To 
use this feature, you must select it from the screen. You must also attach a man-down 
device to the accessory port of the radio. You can program the timer for 0-63 seconds. The 
feature resets if the radio user moves the radio back to a horizontal position. The radio user 
can cancel the emergency mode by pressing the emergency button.

Network Settings - The radio IP address may be set one of two ways: Using the Transfer 
> Read/Write IP address or setting the network settings on this screen. This is used for 
5300 gateway for OTARing to other manufacturings infrastructure and it also makes use 
of the P25 data over IP, which you can send text or files via OTA using the P25 data over 
the air protocol using the application P25dataOverIP. Set static IP addresses for the 
following.

Subscriber IP Address 
Subnet Mask 
Default Gateway 
Host IP Address 

Data Gateway - Enables two 5300 radios to be networked for OTAR operations.

Mode - Set accordingly if radio can transmit or Receive OTAR operations.
Surveillance - Disables the transmit/receive LED indicator, display and keypad backlight, 
and all alert tones. This provides a quick way to disable these functions in all operating 
modes. It overrides any other programming of these functions such as a Tone or Backlight 
option switch. A transmit icon in the display indicates the transmit mode when the LED 
indicator is disabled by this mode (51xx, code version 1.16/2.6/3.6/4.2 or later only). This 
icon displays only in the Surveillance mode.

Program surveillance mode on the Radio Wide screen to allow the following to take 
effect.

Disable Lights - Check this box if you want the lights to be disabled.
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Disable Tones - Check this box if you want the tones to be disabled.
Disable Internal Speaker Audio - Check this box if you want the audio to be disabled.

Other (53xx Only) 

Auxiliary B Output - Determines the function controlled by Pin 4 output of the 
accessory connector: 

Backlight - When you program the Siren option, the control head backlight also 
controls the Siren Controller backlight.
Horn - Controls an external horn alert.
Site Trunking - Controls an external site trunking indication of some type with 
SmartZone and Project 25 trunked operation. This feature is available only with code 
Version 1.26.0/2.4.0/3.4.0 or later.
Disabled - The output is nonfunctional.

Auxiliary B Input - Determines the function controlled by Pin 8 input of the accessory 
connector:

PA Broadcast - Selected with the Transit Bus PA option only to allow the radio user 
to select the public address function using an external switch.
Ext Emergency - Selected if the radio user can use an external emergency switch, 
such as a foot-activated type, to activate an emergency condition (later model 
firmware only).
Disabled - The input is nonfunctional.

Button Press/Hold Duration - Programs how long you need to press the button to 
enable it. This is so the user does not accidently push a button, but has to press it for the 
duration programmed to activation for use.
Zone Selector Locked (5100 only) - When the radio is turned on, the zone that comes 
up is the only one that can be used. Checking this box disables the user from changing 
zones and the radio stays in the Home Zone selected on the Primary Global page.
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Chapter 5Radio Wide Screen

The Radio Wide screen programs parameters that are the same for all Conventional, 
Project 25 Trunked, and SMARTNET/SmartZone systems. A different screen displays for 
each system type. Figure 5.5 shows the Conventional screen, Figure 5.6 shows the 
SMARTNET/SmartZone screen, and Figure 5.7 shows the Project 25 Trunked screen.

The Radio Wide screen contains four areas that appear regardless of which type of system 
you program.

Figure 5.1 Radio Wide Screen Common fields 

When you click any of the buttons, PC Configure opens a screen that enables you to 
program a corresponding set of parameters. This section contains the instructions to 
program these parameters.

Radio Wide Scan List

System Specific

Menu Items

Function Buttons
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In the System Specific area, select the system that you wish to program. This section also 
contains the instructions to program the separate parameters that are unique to the 
Conventional, Project 25 Trunked, and SMARTNET/SmartZone systems.

5.1 Radio Wide Scan List Programming

Note For more information on how to set up radio wide and priority (standard) scanning, refer 
to Section 1.11.

Scan Hold Time - When the radio performs Radio Wide scanning, this programs the 
delay that occurs after the radio stops receiving and transmitting messages. You can 
program times of 0 - 7.5 seconds.

You cannot program the radio wide scan list until you have set up all channels to be 
included in it in the Zone screens, as described in Section 6.2. The Radio Wide Scan List 
is the same for all system types and can include up to sixteen channels from any system. 
You program this scan list by clicking the  button on this screen or  in 
the toolbar. When you click either of these buttons, PC Configure displays the screens 
shown in Figure 5.2. To select the channels that are in the radio wide scan list, click the 

 button to display the Select Scan Channels screen. Select the desired zones 
from the drop-down list and then check the channels that you want to include from each 
zone in the list.

Figure 5.2 Radio Wide Scan List screens 

5.2 Menu Items Programming (51xx Only)
You can only assign menu items when you program 5100 portable radios. To allow the 
radio user to use the menu mode, you must select the Menu Enabled box on the Global 
screen. Clicking the  button on the Radio Wide screen displays the Radio 
Wide Menu Items shown in Figure 5.3. In this screen, you choose the functions the radio 

Select Scan Channels screen

Radio Wide Scan List screen
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user can select in the menu mode. To move any item from the Available Items: list to the 
Programmed Items: list--or vice versa--double-click the item or select it and click one of 
the single arrow buttons. Clicking a double arrow button moves all items in one list to the 
other list. 

Figure 5.3 Radio Wide Menu Items screen

You can program a separate set of menu parameters for each system type using a process 
similar to the one described for function buttons in Section 5.3. Select the system type that 
you want to program in the Radio Wide screen’s System Specific box. The radio user can 
control functions by both the menu and a function button. Table 5.1 shows the available 
51xx menu functions.

5.3 Function Button Programming
Clicking  in the Radio Wide screen displays a screen similar to the one 
shown in Figure 5.4. This is the screen in which you program the function buttons for the 
radio series you chose in Radio > Series.
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Figure 5.4 Radio Wide Function Buttons Screen (5300 Series shown)

You can program each button with a maximum of four different functions. You can 
program one function for Conventional mode, a second for SMARTNET/SmartZone 
mode, a third for Project 25 Trunked mode, and a fourth for Multi-Net mode. You select 
the system type in the Radio Wide screen’s System Specific box. Table 5.1 shows the 
available 5100 and 5300 option button functions.

Note To view the functions programmed for each button in the various modes, select Radio > 
View Programmed Radio Wide Functions. Refer to Section 3.2.

Click Button
Here to 

Program
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Table 5.1 51xx/53xx Programmable Option Button and 51xx Menu Mode Functions 

Function
X = Available in Mode: 5100 Menu 

DisplayConventional Project 25 Trk SMARTNET SmartZone
Alert tones On-Off X X X X Tones
Backlight On-Off (51xx),  
Hi/Med/Off (53xx)

X X X X Backlight

Call Alert Select (Paging) X X X X Call Alert
Call Response Select X X X Call Rsp
Cancel Dynamic Regroup X X X Cancel DR
Change Keyset (OTAR) X X X X Chg Keyset
Channel Select X X X X Chan Selct
Clear/Secure Encryption 
Select

X X X X Security

Clone Programming Select  
(51xx menu only)

X X X X Clone

Configure (51xx menu only, 
not curr used)

X X X X Config

Digital (Project 25) Talk 
Group Select

X Select TG

Display GPS (53xx only) X -
Display Information Select 
(frequency or channel 
display)

X Display

Emergency Mode Select X X X X Emergency
Erase Keys, OTAR  
(menu only with 51xx)

X X X X Erase Keys

External Public Address  
(53xx only)

X X X X -

High/Low Power Select X X X X Tx Power
Home Zone Select X X X X Home Zone
Home 2 X X X X
Horn Honk Select  
(53xx only)

X X X X -

Key Select, OTAR X X Key Select
Keypad Lock Select (51xx 
only)

X X X X (Opt sw only)

Keypad Programming Select X Keypad Prg
Messaging Select X X X Message
Monitor Mode Select X Monitor
Mute/Unmute X X X X
Normal/Selective Squelch 
Select

X Squelch

P25 Packet Data X X Data Modes
Phone Call Select X X X X Phone
Priority Channel Select X Priority
Private Call Select X X Priv Call
Radio Wide Scan Select X X X X RW Scan
Rekey Request X X Rekey Request
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Program the function buttons as follows:

1 Click the white <Fx> button that you want to program in the photo. A pull-down menu 
displays that shows the functions you can assign.

Tip You can program almost all the 51xx portable’s buttons.

2 To select a function, double click it in the drop-down list. The functions assigned to 
each button appear in the bottom part of the screen.

3 Repeat Steps 1 and 2 for all function buttons that you want to program. Next, click OK 
to exit and save the changes or Cancel to exit without saving the changes.

4 You may want the function buttons to perform different functions when the radio 
operates in other modes. To accomplish this, do the following:
a Select one of the other modes in the Radio Wide > System Specific box. 

Remote Access (Pyramid 
Repeater) (53xx only)

X X X X -

Repeater Talk-Around Select X Talk Arnd
Request to Talk X
RWS List Edit X X X X RWS Edit
Scan Mode Select X X X X Scan
Scan List Edit Select X X X X Scan Edit
Scan List Select X (5100 only) X X X Scan Selct
Set User Password X X X X Set Paswd
Squelch (Code) Select List X Sqlch Code
Single Tone Encoder  
(51xx only)

X Tone Encdr

Site Lock Select X X Site Lock
Site Search Select X X Site Srch
Status Select X X X X Status
Surveillance Mode Select X X X X Surv Mode
Tone Volume Edit - Alert X X X X numbers that can 

be adjusted
Tone Volume Edit - Keypad X X X X numbers that can 

be adjusted
Unit Call Select X X Unit Call
Unprogrammed  
(Note The button is not 
used.)

X X X X -

Volume Down (51xx only) X X X X (Opt sw only)
Volume Up (51xx only) X X X X (Opt sw only)
Zone Select X X X X

Tones

Table 5.1 51xx/53xx Programmable Option Button and 51xx Menu Mode Functions (continued)

Function
X = Available in Mode: 5100 Menu 

DisplayConventional Project 25 Trk SMARTNET SmartZone
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b Click  in the Radio Wide screen to display a screen similar to the one 
shown in Figure 5.4.

c Repeat Steps 1 through 3 for each mode that you want to assign unique function 
buttons to.

5.4 Radio Wide Conventional Parameters
Select “Conventional” in the System Specific box to display the screen shown in Figure 
5.5. This screen programs the functions for Conventional systems.

Figure 5.5 Radio Wide Conventional screen 

Clear Alert Tone - If checked, a short beep sounds to indicate that the radio user selected 
the clear (non-encrypted) mode. This tone sounds with SecureNet and digital OFB 
encryption only.

Clear Mode Alert on Secure Rx - If radio is in secure mode, a tone is sounded if user 
receives clear call.

Display Options - Select whether anything displays alternately with the selected channel 
alias or frequency when the radio receives Project 25 group calls.

None - Only the selected channel alias or frequency is displayed.

Both - Both of the following are displayed:
PTT ID - The ID of the mobile placing the call displays. You can program this ID to 
display for 0.5-7.0 seconds or “infinite”. When you select “infinite”, this ID displays 
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for the entire call and none of the other parameters display. Available only in 5100 
models with Flash code Version 1.9.0 or later and 5300 models with ARM code 
1.22.0 or later.
P25 TG on Rx - The radio displays the alias of the talk group on which the call is 
being received. You can program this to display for 0.5-7.0 seconds* or “infinite” as 
just described. Available only in 5100 models with Flash code Version 1.9.0 or later 
and 5300 models with ARM code 1.22.0 or later.

User Group ID - If the ID of the call being received is included in a User Group ID list 
as described in Page 7-16, the alias of that group displays. You can program this to 
display for 0.5-7.0 seconds or “infinite” as just described. Available only in 5100 
models with code 1.12.1/2.2.1/3.2.1 or later and 5300 models with code 1.24.1/2.2.1/
3.2.1 or later.

Show MON Icon When in Normal Mode* - If checked, the monitor indication in the 
display (  with 51xx, MON with 53xx) turns on when you select the “Normal” mode by 
the Normal/Selective option button or menu parameter (51xx only). If you do not check 
this, there is no continuous indication when the radio user selects this mode. Available 
only with 51xx firmware 1.14.0/2.4.0/3.4.0 or later and 53xx firmware 1.26.0/2.4.0/3.4.0 
or later.

Clear Mode Alert on Secure Rx** - When you select this, a beep sounds whenever the 
radio receives a Secure (encrypted) call in the Clear mode on a conventional channel. If 
you do not select this, no beep sounds when this occurs. Available only with 51xx firmware 
1.16/2.6/3.6/4.2 or later and 53xx firmware 1.28/2.6/3.6/4.2 or later.

5.5 Radio Wide SMARTNET/SmartZone Parameters
Select “SMARTNET/SmartZone” in the System Specific box to display the screen shown 
in Figure 5.6. This screen programs the functions that are the same for all SMARTNET 
and SmartZone systems.
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Figure 5.6 Radio Wide SMARTNET/SmartZone Screen 

Full Spectrum CC Scan - After the radio searches all potential control channel 
frequencies, the radio enters a channel-by-channel search across the full spectrum the 
radio covers. The timer sets the period of time the radio performs this scan before 
checking the expected frequencies again. After the radio checks these frequencies, full 
spectrum scanning resumes. This cycle repeats until the radio finds a control channel. 
Checking the box enables full spectrum scan.

Scan Time - Sets the time that full spectrum scanning occurs as just described. The 
selectable range is 5-31 seconds. The default is five seconds.

Display Options - Select whether anything displays alternately with the selected channel 
alias or frequency when the radio receives Project 25 group calls.

None - Only the selected channel alias or frequency is displayed.
Both - Both of the following are displayed:

PTT ID - The ID of the mobile placing the call displays. You can program this ID to 
display for 0.5-7.0 seconds or “infinite”. When you select “infinite”, this ID displays 
for the entire call and none of the other parameters display. Available only in 5100 
models with Flash code Version 1.9.0 or later and 5300 models with ARM code 
1.22.0 or later.
P25 TG on Rx - The radio displays the alias of the talk group on which the call is 
being received. You can program this to display for 0.5-7.0 seconds* or “infinite” as 
just described. Available only in 5100 models with Flash code Version 1.9.0 or later 
and 5300 models with ARM code 1.22.0 or later.

User Group ID - If the ID of the call being received is included in a User Group ID list 
as described in Page 7-16, the alias of that group displays. You can program this to 
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display for 0.5-7.0 seconds or “infinite” as just described. Available only in 5100 
models with code 1.12.1/2.2.1/3.2.1 or later and 5300 models with code 1.24.1/2.2.1/
3.2.1 or later.

Trunking 

Display Site Trunking - If you select this, “Site Trunking” displays if the affiliated site 
loses communication with the zone controller and operates in the site trunking mode. 
This message displays until the zone controller returns to normal operation.
Alert Site Trunking - If you select this, an alert tone sounds when entering the site 
trunking mode previously described.

Failsoft Inactivity - Programs failsoft operation. If the radio remains inactive (no receive 
or transmit activity on the channel) while it operates in the failsoft mode for the 
programmed time, the radio momentarily leaves the failsoft mode and attempts to find a 
control channel. If you program “0”, the radio does not leave the failsoft mode.

Affiliation Hold Off - With SmartZone operation, this is the delay time that occurs after 
acquiring the control channel before it sends an affiliation inbound signaling word (ISW). 
This prevents all radios on the system from sending affiliation ISWs at the same time.

Talkback Scan - When the radio receives a call while it is scanning, this setting 
determines the talk group of the radio’s response. You can program the radio to respond 
on the Selected talk group or the received talk group (Active) group if they are not the 
same. You program Scan Hold Time on the Per System screen.

Out-of-Range Indication - Selects if the periodic tone sounds, “Out of Rng” (or “NO 
SYS”) displays, or if both or neither of these indications occur when an out-of-range 
condition exists.

Clear Mode Alert on Secure Rx - When you select this, a beep sounds when the radio 
receives a Secure (encrypted) call in the Clear mode on a SMARTNET/SmartZone 
channel. If you do not select it, no beep sounds when this occurs. Available only with 5100 
firmware 1.16/2.6/3.6/4.2 or later and 5300 firmware 1.28/2.6/3.6/4.2 or later.

5.6 Radio Wide Project 25 Trunked System Parameters
Select “Project 25 Trunked” in the System Specific box to display the screen shown in 
Figure 5.7. This screen programs the functions that are the same for all Project 25 trunked 
systems.
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Figure 5.7 Radio Wide Project 25 Trunking Screen 

RSSI - This sets the Receive Signal Strength Indicator (RSSI) levels that determine when 
the radio tries to search for and switch to another site. Click the Default button to restore 
these levels to the default settings. If you check the Hex box, the RSSI levels display in as 
hexadecimal numbers instead of decimal numbers.

Note Do not change the default RSSI levels unless you know how these levels affect radio 
operation.

Full Spectrum CC Scan - Checking the box enables full spectrum scan.After the radio 
searches all potential control channel frequencies, it enters a channel-by-channel search 
across the full spectrum the radio covers. The timer sets the period of time the radio 
performs this scan before it checks the expected frequencies again. After it checks these 
frequencies, full spectrum scanning resumes. This cycle repeats until the radio finds a 
control channel.

Scan Time - Sets the time that full spectrum scanning occurs. You can select time 
periods between 5 and 31 seconds. The default is 5 seconds.

Failsoft - These parameters program failsoft operation that occurs when there is a 
controller or other major system failure.

Inactivity Duration - Sets the time the radio must remain inactive (no receive or 
transmit activity on channel) in the failsoft mode before it tries to leave the failsoft 
mode and attempt to find a control channel. If you program “0”, the radio does not 
leave the failsoft mode.
Emergency Blocked - If you check this, the radio user cannot make emergency calls 
when the radio is in the failsoft mode.
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Ring Time

Individual Call Maximum Target Ring - Sets the maximum ring time of the target 
radio when it receives phone and unit-to-unit calls. When this time expires, the call 
automatically discontinues. You can program time periods between 61 and 120 
seconds. The default is 61 seconds.
Private Call Max Int - Sets the maximum time the initiating radio rings when it places 
a unit call. This does not include phone calls. Ringing stops if the target radio answers 
before this timer expires. You can program time periods between 1 and 255 seconds. 
The default is 30 seconds. If you program “infinite”, ringing continues until the target 
mobile answers.

Hold Off Time

Int Radio Random Hold Off - When a failure occurs on a site, this sets the delay that 
occurs before a radio leaves that site and registers on another. It also sets the delay that 
occurs before a radio returns to a site that has returned to normal operation. A random 
time is calculated between 0 and the selected time. This timer starts only when the 
following Hold Off Delay expires. You can program time periods between 0 and 60 
minutes. The default is ten minutes.
Hold Off Delay - Sets the delay in registration or affiliation that occurs before starting 
the preceding random hold off time. During this delay, the radio monitors for over-the-
air packets. You can program time periods between 5 and 60 seconds. The default is 5 
seconds.

Trunking

Display Site Trunking - If you select this, “Site Trunking” displays if the affiliated site 
loses communication with the zone controller and begins to operate in the site trunking 
mode. This message displays until the zone controller returns to normal operation.
Alert Site Trunking - If you select this, an alert tone sounds when the radio enters the 
site trunking mode just described. 

Other

Display Options - Select whether anything displays alternately with the selected 
channel alias or frequency when the radio receives Project 25 group calls.

None - Only the selected channel alias or frequency is displayed.
Both - Both of the following are displayed:

PTT ID - The ID of the mobile placing the call displays. You can program this ID 
to display for 0.5-7.0 seconds or “infinite”. When you select “infinite”, this ID 
displays for the entire call and none of the other parameters display. Available 
only in 5100 models with Flash code Version 1.9.0 or later and 5300 models with 
ARM code 1.22.0 or later.
P25 TG on Rx - The radio displays the alias of the talk group on which the call is 
being received. You can program this to display for 0.5-7.0 seconds* or “infinite” 
as just described. Available only in 5100 models with Flash code Version 1.9.0 or 
later and 5300 models with ARM code 1.22.0 or later.

User Group ID - If the ID of the call being received is included in a User Group ID list 
as described in Page 7-16, the alias of that group displays. You can program this to 
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display for 0.5-7.0 seconds or “infinite” as just described. Available only in 5100 
models with code 1.12.1/2.2.1/3.2.1 or later and 5300 models with code 1.24.1/2.2.1/
3.2.1 or later.

Talkback Scan - When the radio receives a call while it is scanning, this setting 
determines the talk group of the radio’s response. You can program the radio to respond 
on the Selected talk group or the received talk group (Active) group if they are not the 
same. You program Scan Hold Time on the Per System screen.

Out Of Range Indication - Selects which of the following occur when an out-of-range 
condition exists:

1 The periodic tone sounds.
2 “Out of Rng” (or “NO SYS”) displays.
3 Both A and B above.
4 Neither A nor B above.

Clear Mode Alert on Secure Rx 2 - When you select this, a beep sounds when the radio 
receives a Secure (encrypted) call in the Clear mode on a Project 25 trunked channel. If 
you do not select it, no beep sounds when this occurs.
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Chapter 6Setting-Up Zones and Channels

This section describes how to set-up zones and assign channels to each zone. A zone can 
include up to 16 channels of any type (conventional analog, Project 25 conventional, 
SMARTNET/SmartZone, or Project 25 Trunked). 

With the 51xx portable/53xx mobile, you can program a maximum of 32 zones for up to 
512 channels if you enable the “512 Talkgroups/Channels” option. Refer to Page 3-7. 
Otherwise, you can program a maximum of 16 zones.

6.1 Setting-Up Zones
This section contains the following information about setting-up zones:

• Setup procedure
• Linking conventional scan lists to zones

6.1.1 Setup Procedure

1 Select the Zone tab to display th Zone screen (This screen varies according to the type 
of system.) Then click  in the upper left corner of the screen to display the 
Zones and Channels screen shown in Figure 6.1. Another way to do this is to click 

 in the toolbar.
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Figure 6.1 Zones and Channels Screen

Figure 6.2 Distribute Channel Data 

2 To add a new blank zone, select “None” in the Zone drop-down list and then click the 
 button. To make a copy of a current zone, select the desired zone in the Zone drop-

down list instead. To delete the current zone, click the  button. 

3 To display the first zone, click , the last zone ; the previous zone ; and the next 
zone, . 

4 Program the alias (identification) that is displays briefly when you select the zone. To 
do this, enter a maximum of 10 characters in the Alias box.

5 You can program a zone password that you must enter to perform keypad programming 
of the zone. Refer to Section 11. To program this password, enter any eight numbers 

Double Click Here
To Display the
Distribute Channel Data
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from 0-9. If you do not wish to program this password for the zone, simply leave this 
field all zeros.

6.1.2 Linking Conventional Scan Lists to Zones

You program conventional systems on the Per System screen with a default scan list that 
all channels in a given system can normally select. Refer to Section 7.1. However, you can 
select this parameter to link a particular conventional scan list to the zone. This then 
becomes the default list for all conventional channels in that zone. It overrides the system 
default list programming. This feature is available only with radio firmware Versions 
1.16/2.6/3.6/4.2 (51xx) and 1.28/2.6/3.6/4.2 (53xx) or later.

6.2 Setting Up Channels

Note When you assign a channel to a zone, the you also select the system of the channel. 
Therefore, before assigning you assign a channel to a zone, set up all necessary systems as 
described in Section 1.10.

Set up channels by assigning them to a zone in the Zones and Channels screen shown in 
Figure 6.1. Proceed as follows to set up any type of channel (Conventional Analog, 
Conventional Digital, Project 25 Trunked, SMARTNET/SmartZone). 

1 Select the Zone screen (see Figure 6.3) and then click  to display the 
Zones and Channels screen shown in Figure 6.1. Another way to do this is to click 

 in the toolbar.

2 Select the desired zone as described in the preceding section. 

3 To add a channel to the displayed zone, check the applicable box in the Channel 
column. To select or deselect all channels in the box, check or uncheck the All box. 

4 To assign the channel to a system (if applicable), select the drop-down list in the 
System/Type column and select the desired system.

5 For Conventional channels, also select the channel type of each channel by clicking 
Analog or Digital (Project 25) in the Conventional System Specific box.

6 To copy an enabled channel to unprogrammed channels of the current zone or other 
zones, double click the shaded area of the channel as shown in Figure 6.1. The 
Distribute Channel Data screen then appears.Select the desired channels from this 
screen.

7 Repeat the preceding steps until the you have set up desired channels in each zone.

8 To program individual system and channel information, refer to Section 7 
(Conventional), Section 8 (SMARTNET/SmartZone), or Section 9 (Project 25 
Trunked).
Draft: June 29, 2006 PC Configure Programming Guide 6-3



Setting-Up Zones and Channels 
6.3 Conventional Channel Parameters
After the desired channels have been set up as described in Section 6.2, you can program 
individual channel parameters. Select the Zone screen shown in Figure 6.3 and then select 
the desired Zone using the drop-down list in the “Zones” box. Screens which program 
individual channel parameters are selected by clicking the channel in the “Channels” box. 
See Figure 6.3 to set parameters for a Conventional Analog channel and Figure 6.4 to set 
parameters for a Conventional Digital channel.

6.3.1 Conventional Analog Channel Parameters

The following screen is used to set channel parameters for a Conventional Analog system.

Figure 6.3 Conventional Analog Channel Screen 

The parameters displayed when a Conventional Analog channel is selected are as follows. 
Refer to Section 6.3.2 for information on Conventional Digital (Project 25) channels. 
SMARTNET/SmartZone and Project 25 Trunked channels are described in Sections 8 and 
9.

Channel Type - Indicates the type of channel (Conventional Analog or Conventional 
Digital) that is currently selected in the “Channels” box.

Channel Alias - Programs the alias (identification) that is displayed when the channel is 
selected. 
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Transmit

Power - Fixes the transmit power on the channel for the high or low level or makes it 
selectable (the high/low power option switch is then required).
Time Out - Enables or disables the transmit time-out timer on the channel. The time-
out timer time is programmed on the Per System programming screen (see Section 
7.1).
Modulation Level - This selects if the channel modulation is wideband (5 kHz), 
narrowband (2.5 kHz), or NPSPAC (4 kHz). NPSPAC (public safety) modulation 
applies to 800 MHz models only.
Frequency - Programs the transmit frequency of the channel.
Disabled - Checking this box disables transmitting on the channel so that it is receive 
only.

CTCSS/DCS - Checking this box enables Call Guard (CTCSS/DCS) squelch control 
transmission on the channel. If this box is not checked, no code is transmitted and squelch 
is carrier controlled.

CTCSS - If this box is checked, tone Call Guard (CTCSS) squelch control is used and 
the desired tone is selected by the drop-down list. NOTE: A CTCSS/DCS code table is 
shown on Page 17-1.
DCS - If this box is checked, digital Call Guard (DCS) squelch control is used and the 
desired code is selected by the drop-down list.

Receive

Frequency - Programs the receive frequency of the channel.
CTCSS/DCS - Checking this box enables Call Guard (CTCSS/DCS) squelch control 
on the channel. If this box is not checked, no squelch control coding is used, and 
squelch is carrier controlled. 
CTCSS - If this box is checked, tone Call Guard (CTCSS) squelch control is used and 
the desired tone is selected by the drop-down list. 
DCS - If this box is checked, digital Call Guard (DCS) squelch control is used and the 
desired code is selected by the drop-down list.

Security

Note Voice encryption is an optional feature that requires factory programming and possibly 
special hardware.

Strapping Mode 
Strapped Clear - All transmissions on the channel occur in the clear (unscrambled) 
mode.
Strapped Secure - All transmissions occur in the secure (scrambled) mode selected 
by Security Type. 
Switched - The clear or secure status of the channel is selected by the Clear/Secure 
function switch.

Security Type
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Securenet - Selects Motorola SecureNet™ DES type secure communication when 
either the Strapped Secure or Switched strapping modes are selected.
Scrambling - Selects Transcrypt 460 scrambling when either the Strapped Secure or 
Switched strapping modes are selected (not available with 5100 and later 5300 
models).

Scrambling Type - When the Transcrypt 460 scrambling type is selected, 460 
scrambling is always enabled.
Tx DES/DES-XL - When the Motorola SecureNet secure communication is selected, 
enables either the DES or DES-XL type (with the 51xx, DES-XL is available only in 
later models equipped with the UCM module).
Key PID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/CKR mode) 
of the key used for secure calls on the channel if applicable. 

Rx Auto Detect

With the SecureNet protocol, select “Secure” to enable automatic detection of 
encrypted receive signals (not available with 5100 models). This may increase the 
response time of the radio to an incoming signal. Select “Proper Key” to cause the radio 
to search the available SecureNet keys until it finds a match for the current 
transmission.

Other

Busy Channel Lockout
Off - Disables this feature.
Noise - Transmitting is disabled if a carrier is detected.
Tone - Transmitting is disabled if an incorrect Call Guard (CTCSS/DCS) tone or 
code is detected (one not programmed for current channel). 

Keypad DTMF - If this box is checked, manual dialing of numbers using the DTMF 
keypad is allowed.
Pre TX ANI - If “Pre Tx” is selected, a DTMF-coded ID is sent at the beginning of 
each transmission.
Post TX ANI - If “Post Tx” is selected, a DTMF coded ID is sent at the end of each 
transmission.
Ignore Keypad CTCSS - Ignore Keypad CTCSS - If this is checked and a CTCSS/
DCS code has been selected from the preprogrammed CTCSS/DCS table by the 
Selective Squelch Code Select feature, it is ignored and the programmed code for the 
channel is selected instead.
Talkaround Disabled - Set on a per-channel basis: the user has to use the infrastructure 
if disabled.

6.3.2 Conventional Digital (Project 25) Channel Parameters

After the desired channels have been set up as described in Section 6.2, individual channel 
parameters can be programmed. Select the Zone screen shown in Figure 6.4 and then 
select the desired Zone using the drop-down list in the “Zones” box. Screens which 
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program individual channel parameters are selected by clicking the channel in the 
“Channels” box.

Figure 6.4 Conventional Digital (Project 25) Channel Screen

The parameters displayed when a Conventional Digital channel is selected are as follows. 
Refer to Section 6.3.1 for information on Conventional Analog channels. SMARTNET/
SmartZone and Project 25 Trunked channels are described in Sections 8 and 9.

Channel Type - Indicates the type of channel (Conventional Analog or Conventional 
Digital) that is currently selected in the “Channels” box.

Channel Alias - Programs the alias (identification) that is displayed when the channel is 
selected. Up to ten characters can be programmed.

Mixed Mode Enable - Checking this box selects both analog and digital operation on the 
current channel.

Mixed analog and digital (Project 25) operation can be programmed on a channel. With 
mixed mode operation, both types of calls can be received, and the Tx Type determines 
if NAC or CTCSS/DCS is transmitted. With analog operation, channel modulation, 
coded squelch, and ANI signaling may require programming similar to that described in 
Section 6.3.1.
Tx Type - When “Analog” is selected, CTCSS/DCS is transmitted, and when “Digital” 
is selected, NAC is transmitted. 
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Transmit

Power - Fixes the transmit power on the channel for the high or low level or makes it 
selectable (the high/low power function switch is then required).
Time Out - Enables or disables the transmit time-out timer on the channel. The time-
out timer time is programmed on the Per System programming screen (see Section 
7.1).
Modulation Level - If the Mixed Mode and Tx Type = Analog is selected, the 
modulation level is programmed. This selects if the channel modulation is wideband (5 
kHz), narrowband (2.5 kHz), or NPSPAC (4 kHz).
Frequency - Programs the transmit frequency of the channel.
Disabled - Checking this box disables transmitting on the channel so that it is receive 
only.
NAC - Programs the transmit NAC (Network Access Code). These codes can be 0-
4095, and either decimal or hexadecimal numbers can be entered.
CTCSS/DCS - If the Mixed Mode and Tx Type = Analog is selected, the transmit Call 
Guard (CTCSS/DCS) squelch coding can be programmed (see Section 6.3.1).

CTCSS - Select the desired tone from the drop-down list. NOTE: A CTCSS/DCS 
code table is shown on Page 17-1.
DCS - Select the desired code from the drop-down list.

Phone Access Code - Selects the Phone Access Code if telephone calls are placed on the 
channel. The access codes are programmed by the Phone Access Code system list on the 
Per System screen.

Receive

Frequency - Programs the receive frequency of the channel.
NAC - Programs the receive NAC (Network Access Code). These codes can be 0-4095, 
and either decimal or hexadecimal numbers can be entered. NAC F7E (hex) is 
interpreted as a standard code.
Digital Squelch - When checked, carrier squelch is enabled which results in all digital 
traffic, regardless of NAC or talk group ID, being received. This does not program 
NAC F7E which is used the same as other NAC codes. 
CTCSS/DCS - If the Mixed Mode is selected, the receive Call Guard (CTCSS/DCS) 
squelch coding can be programmed (see Section 6.3.1). Both analog and digital (Project 
25) calls can be received in the mixed mode.

CTCSS - Select the desired tone from the drop-down list. NOTE: A CTCSS/DCS 
code table is shown on Page 17-1.
DCS - Select the desired code from the drop-down list.

Talk Group

Group ID - This selects the Project 25 talk group that is assigned to the channel. The 
talk group includes the Talk Group ID, talk group alias, secure strapping mode, and 
encryption key address. Talk Groups are programmed in the Per System screen 
(Section 7.1).
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List Select/Keypad Program
Strapped To Selected Group - The talk group on the channel is always the 
programmed talk group and cannot be changed.
List Selectable - The talk group may be changed using the Digital TG Select 
function button.

Other

Busy Channel Lockout 
Off - Disables this feature.
Noise - Transmitting is disabled if a carrier is detected.
NAC - Transmitting is disabled if an incorrect NAC code is detected (or CTCSS/
DCS if mixed mode is enabled). An incorrect code is any code not programmed for 
the current channel.

Keypad DTMF
If this box is checked, manual dialing of numbers using the DTMF keypad is 
allowed. This is available in the mixed mode only.

Pre TX ANI - If “Pre Tx” is selected, a DTMF-coded ID is sent at the beginning of 
each transmission.
Post TX ANI - If “Post Tx” is selected, a DTMF coded ID is sent at the end of each 
transmission.
Override Talkgroup Security Settings6 - This allows the encryption strapping mode 
and key location to be set on a per channel basis instead of just on a per talk group 
basis. If “Yes” is selected in the drop down menu, the selected strapping mode and key 
location overrides the talk group programming if applicable (conventional digital 
channels only).

Strapping Mode 
Strapped Clear - All transmissions on the channel occur in the clear 
(unscrambled) mode.
Strapped Secure - All transmissions occur in the secure (scrambled) mode 
selected by Security Type. 
Switched - The clear or secure status of the channel is selected by the Clear/
Secure function switch.

Key PID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/CKR 
mode) of the key used for secure calls on the channel if applicable. 

Ignore Keypad CTCSS - If this is checked and a CTCSS/DCS code has been selected 
from the preprogrammed CTCSS/DCS table by the Selective Squelch Code Select 
feature, it is ignored and the programmed code for the channel is selected instead.
Talkaround Disabled - Set on a per-channel basis: the user has to use the 
infrastructure if disabled.
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6.4 SMARTNET/SmartZone Channel Parameters
After the desired channels have been set up as described in Section 6.2, you may program 
individual channel parameters. Select the Zone screen shown in Figure 6.5 and then select 
the desired Zone using the drop-down list in the “Zones” box. Select screens to program 
individual channel parameters by clicking the channel in the “Channels” box.

Figure 6.5 SMARTNET/SmartZone Zone screen 

The parameters displayed when a SMARTNET/SmartZone channel is selected are as 
follows. Conventional and Project 25 Trunked channels are described in Sections 6.

Channel Type - Indicates the type of channel that is currently selected in the “Channels” 
box.

Channel Alias - Programs the alias (identification) that is displayed when the channel is 
selected. Up to ten characters can be programmed.

Scan List - Selects the priority (standard) scan list selected by the channel. If “No List” is 
selected, scanning is not selectable on that channel.

Auto Scan - When this is checked, the radio automatically begins scanning the scan list 
associated with the channel whenever the channel is selected. When it is not checked, 
scanning must be started manually by the Scan option switch.
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IDs

Operation with the various combinations of Talk Groups (TGs) and Announcement 
Groups (AGs) is as follows: 

Talk Group Only - Transmit on TG, receive on TG.
Announcement Group ID - Transmit on AG, receive on all TGs in AG.
Talk and Announcement Groups - Transmit on TG and receive on TG plus AG but 
not the TGs assigned to the AG.

Tip You can enter these IDs in either decimal or hexadecimal format as described in Section 
1.9.4.

Talk Group ID - Selects the talk group selected by that channel. Program Talk Groups by 
selecting “Talk Group List” on the Per System screen (see Section 8.2.6 or Section 9.3.6).

Announcement Group ID - Selects the receive-only announcement group selected by 
that channel. Program Announcement Groups by selecting “Announcement Group List” 
on the Per System screen (see Section 8.2.7 or Section 9.3.7).

Emergency Group ID - Selects the talk group used for emergency calls on the channel. If 
no Emergency Group is selected, the emergency is transmitted on the selected (tactical) 
talk group.

Other

Talk Permit Tone - When this feature is checked, a short tone sounds after a request 
for a group call has been approved by the main controller. This indicates that speaking 
can begin. When not checked, no audio feedback is used to indicate when speaking can 
begin.
Make Dynamic Regrouping Channel - Checking this box designates the channel as 
the dynamic regrouping channel. The talk group is then programmed over the air, so the 
Talk Group ID and Announcement Group ID are not programmable.

Dynamic Regrouping must be enabled on the System screen to program a dynamic 
regrouping channel. The dynamic talk group does not need to be a programmed 
group.
A Cancel Dynamic Regrouping2 option button or menu parameter (51xx only) can 
now be programmed (see Sections 5.2 and 5.3). This allows the user to reselect the 
previous talk group if desired.

Transmit Disabled1 - When this feature is checked, transmitting is disabled on the 
channel, and it can be used for monitoring only.

6.5 Project 25 Trunked Channel Parameters
After you set-up your desired channels as described in Section 6.2, you can program 
individual channel parameters. Select the Zone screen shown in Figure 6.6, then select the 
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desired zone using the pull-down menu in the Zones box. Select screens that program 
individual channel parameters by clicking the desired channels in the Channels box.

Figure 6.6 Project 25 Trunked Channel Zone Screen

The parameters you display when you select a Project 25 Trunking channel are as follows.

Channel Parameters

Channel Type - Indicates the type of channel (Conventional Analog, Conventional 
Digital, SMARTNET/SmartZone, Project 25 Trunked) that is currently selected in the 
“Channels” box.
Channel Alias - Programs the alias (identification) that displays when the radio user 
selects the channel. You can program a maximum of ten characters. 
Scan List - Selects the priority (standard) scan list selected by the channel. If you select 
“No List”, the radio user cannot select scanning on that channel. 

Auto Scan - When you check this, the radio automatically begins scanning the scan 
list associated with the channel whenever the radio user selects the channel. When it 
you do not check this, the radio user must start scanning manually with the Scan 
option switch.

ID’s - The possible combinations of Talk Groups (TGs) and Announcement Groups 
(AGs) provide the following operation:

• Talk Group Only - Transmit on TG, receive on TG.

• Announcement Group Only - Transmit on AG, receive on all TGs in AG.
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• Talk and Announcement Groups - Transmit on TG and receive on TG plus AG but 
not the TGs assigned to the AG.

Note You can enter these IDs in either the decimal or hexadecimal format as described in 
Section 1.9.4.

Talk Group ID - Selects the talk group selected by that channel. Program talk 
groups selecting “Talk Group List” on the Per System screen. Refer to Section 
9.3.6.
Announcement Group ID - Selects the announcement group selected by that 
channel. Program announcement groups by selecting “Announcement Group List” 
on the Per System screen. Refer to Section 9.3.7.
Emergency Group ID - Selects the talk group used for emergency calls on the 
channel. If you do not select an emergency group, the emergency signal transmits on 
the selected (tactical) talk group.

Other
Make a Dynamic Regrouping Channel - When you check this box, you designate 
the channel as the dynamic regrouping channel. The system then programs the talk 
group over the air, so the talk group ID and announcement group ID are not 
programmable.
You must enable Dynamic Regrouping on the Per System screen to program a 
dynamic regrouping channel. The dynamic talk group does not need to be a 
programmed group.
Tx Disabled1 - When you check this box, you disable transmitting on the channel. 
You can then use the channel for monitoring only.
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S E C T I O N

Chapter 7Conventional Systems

Two screens contain the interface to program conventional system and channel 
parameters. This section contains descriptions of the parameters found on these screens. 
Figures 7.1 show the Per System tab discussed in this section.

Some parameters described in this section apply only to certain revision levels. In this 
section, index numbers in superscript appear next to the names of such features (for 
example, “Example Feature9”). Table 1.1 shows the relationship between these numbers 
and the revision levels they represent.

7.1 Individual Conventional System Parameters
You can program Individual system parameters using the Per System screen shown in 
Figure 7.1. These parameters can be programmed after the desired systems have been set 
up as described in Section 1.10.
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Figure 7.1 Conventional System screen 

There are also radio wide parameters that are programmed by the Radio Wide screen as 
described in Section 5.4. For information on programming individual SMARTNET/
SmartZone and Project 25 Trunked system parameters, refer to Sections 8.1 and 9.1. The 
parameters in the individual Conventional System screen are as follows:

IDs

Digital Unit ID - This number identifies the radio when it operates on a Project 25 
(digital) channel. Each radio must have a different ID, and it must be between 1 and 
16,777,216.
Five Tone ID - Program for a RTT signaling or a pre and post ANI. Consisting of four 
digits from 0-9. Radio does not decode the five tone ID, only consoles will be able to 
decode the RTT or ANI signaling.
DTMF PTT ID - Channels programmed for pre- or post-transmit ANI use the PTT ID 
if the system is programmed for the DTMF analog signaling type. Refer to Section 7.1. 
This ID consists of eight digits from 0-9. Program the ANI function on the channel 
screen as described in Sections 7.3 and 7.4.
DTMF Emergency ID - This sets the ANI number that transmits if you selected the 
“Emergency ANI Call” or “Emergency Alarm” analog emergency features on the 
conventional Per System screen. Refer to Section 7.1.
MDC ID - 51xx portable models that have Version 4.x firmware support the ANI and 
Emergency Alert features of the Motorola MDC1200 data protocol. This ID, with 
values from 0 to 65535, transmits if you select the MDC Analog Signal Type on the 
Conventional Per System screen, and if you program ANI or Emergency Alert. You 
program Emergency Alert and ANI parameters on the Per System screen, and you 
enable ANI on the channel screen.
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Alias - Programs the alias that is displayed for the system in the left pane after the system 
type. This alias is not displayed by the radio.

Per System Scan List Settings - These parameters set various timers that control priority 
scanning when a channel assigned to the system is selected. 

Scan Hold Time - Sets the delay that occurs before scanning resumes after a signal is 
no longer received. Times of 0 -7.5 seconds can be programmed.
Priority Lookback Time A - This time determines how often the priority channel is 
checked for activity. Times of 0.25-4.00 seconds in 0.25-second steps can be 
programmed.
Priority Lookback Time B - This time determines how often the priority channel is 
checked once an incorrect Call Guard (CTCSS/DCS) or NAC code is detected. Since it 
takes much longer to detect an incorrect Call Guard signal than a carrier, this time 
should be relatively long to prevent the interruptions from making a message difficult 
to understand. Times of 0.5-8.0 seconds can be programmed in  
0.5-second steps.
Default User Selected Scan List - Selects the scan list that is normally always selected 
on power up. A different scan list can be temporarily selected using the Scan List 
option switch or menu parameter (if applicable). This setting is overridden if a scan list 
is slaved to a particular zone on the Zone setup screen (see Section 6).

System Lists - Refer to Page 7-10 for information on these lists.

Conventional Signaling 

Select the Settings Button  to display the Conventional Signaling screen, 
Figure 7.2. This screen provides parameters and settings for Conventional digital (P25) 
and analog signaling.
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Figure 7.2 Conventional Signaling screen 

Two parameters (upper right area of the screen may be set. The remainder are for 
information only.

RTT Message Number - This message identiier will to be selected by the user to 
represent an RTT which is defineable in the portable and mobile radio as well as the 
dispatch console system.
System Target Address - This address indicates that the message is not sent to a 
particular unit, but to the system infrastructure.

The other information provided on this screen includes:
P25

Retry Attempts - In the event that an RTT is not received by the system, the radio 
shall retransmit the RTT message until a successful ACK_RSP_FNE message is 
received or the maximum number of retransmisions is reached.
Retry Response Timer - If the radio does not receive the ACK_RSP_FNE message, 
this is the delay between the retry attempts.
Emergency Retry Attempts - In the event that an emergency alarm is not received 
by the system, the radio shall retransmit the emergency alarm message until a 
successful ACK_RSP_FNE message is received or the maximum number of 
retransmisions is reached.
Emergency Response Timer - If the radio does not receive the emergency alarm 
message, this is the delay between the retry attempts.

Analog Signaling
Single Tone Encoder

Initial Delay - This the delay before the actual signal is sent.
Frequency - The frequency of the tone being sent.
Duration - The amount of time the frequency is transmitted.
Modulation - An adjustable modulation value. Minimum is .5 and maximum is 
.8.
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Side tone - Enables a side tone when transmitting a single tone encoder.
Five Tone Encoder

Initial Delay - The delay before the actual signal is sent.
Inter Delay - The delay between each of the five tones being sent.
Tone Duration - The transmitted time duration of each tone.
Modulation - An adjustable modulation value. Minimum is .5 and maximum is 
.8.

DTMF
Initial Delay - The delay before the actual signal is sent.
Digit Duration - The duration of each of the tones being sent
Inter Digit Delay - The delay between each of the tones being sent.

MDC
Initial Delay - The delay before the actual signal is sent.
Emergency Retry Attempts - In the event that an emergency alarm is not 
received by the system, the radio shall retransmit the emergency alarm message 
until a successful ACK_RSP_FNE message is received or the maximum number 
of retransmisions is reached.

Emergency (Conventional)13

Analog Signaling Type - Selects the signaling type (DTMF or MDC) used for 
emergency calls and ANI on analog channels on the system. MDC selects the 
MDC1200 Motorola signaling protocol. The DTMF and MDC IDs are programmed on 
the Radio Wide Conventional screen (see Section 5.4), emergency and some ANI 
information is programmed on this screen, and ANI is enabled on the analog channel 
screen (see Section 6.3.1). 

Note MDC is available only with 51xx portable models that have Version 4.x firmware.

Emergency Alarm - If this box is checked, emergency alarms are sent by pressing the 
Emergency option switch. In the Project 25 mode, an emergency alarm is a special 
Project 25 data transmission. In the analog mode, it is a DTMF or MDC Emergency ID 
that is sent (see preceding Analog Signaling Type). This ID is programmed on the 
Conventional Radio Wide screen described in Section 5.4.

Normal/Silent - When “Normal” is selected and an emergency alarm is sent, the red 
transmit indicator lights, an emergency tone sounds, and EMERGNCY flashes in the 
display. EMERGNCY continues to flash until power is cycled, the channel is 
changed, or the Emergency switch is pressed and held. If “Silent” is programmed, 
none of these indications occur. 
Acknowledge Alert Tone - If selected, an alert tone sounds when the emergency 
alarm is acknowledged by the dispatcher (DTMF only). 

Emergency Call - Digital - Enables Emergency Calls on conventional Project 25 
channels. When the Emergency button and then the PTT switch are pressed, an 
emergency call is transmitted. To exit the emergency mode, cycle power or press and 
hold11 the Emergency switch.
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Emergency ANI Call - Analog - Enables Emergency Calls on conventional analog 
channels. When the Emergency button and then the PTT switch are pressed, the 
Emergency DTMF code is sent every transmission (in place of the DTMF PTT ID if 
applicable). To exit the emergency mode, cycle power or press and hold11 the 
Emergency switch.
Emergency Hot Mic - When this box is checked and an emergency call is sent by 
pressing the Emergency switch, automatic transmitting occurs with the microphone 
audio unmuted (without user intervention) for the time specified by the following 
Emergency Hot Mic Time. If it is not checked or if an emergency call is not selected, 
automatic transmissions do not occur. This feature is initiated only by the first press of 
the Emergency switch. Subsequent presses do not trigger automatic transmissions. To 
reset this function, power must be cycled.
Emergency Hot Mic Time - Defines the period during which automatic transmissions 
occur. Times of 10-120 seconds in ten-second steps can be selected.
No Rx Activity During Emergency12 - When this box is checked, the following 
receive indications are disabled in the emergency mode: receive audio, receive LED, 
receive icons.

ANI

Analog Signaling Type - Selects the signaling type (DTMF or MDC) used for 
emergency calls and ANI on analog channels on the system. MDC selects the 
MDC1200 Motorola signaling protocol. The DTMF and MDC IDs are programmed on 
the Radio Wide Conventional screen (see Section 5.4), emergency and some ANI 
information is programmed on this screen, and ANI is enabled on the analog channel 
screen (see Section 6.3.1).

Note MDC is available only with 51xx portable models that have Version 4.x firmware.

Note The type of ANI (DTMF or MDC) is selected by the preceding Analog Signaling Type. 
DTMF PTT and MDC IDs are programmed on the Radio Wide Conventional screen, and 
pre and post ANI is enabled on the analog channel screen.

Individual (Unit) Call List Settings (Project 25 Only)
Encryption Key ID - Selects the location from 0-15 (PID/ASN mode) or 1-16 
(SLN/CKR mode) of the key used for secure individual calls on the system if 
applicable. 
Call Timer - Used with 5300, Rev 4, logic board only to set the maximum time 
the radio remains in the individual call mode after an individual call is received. A 
response must be made before this timer expires. With Rev 6 and later boards and 
other radios, the call is ended by pressing the Call button.

An additional conventional system screen is opened/closed by clicking the  buttons 
in the upper right corner of the screen. The following additional parameters are then 
displayed:
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Figure 7.3 Conventional System Page 2 screen description 

Call Alert (Project 25 Only)13

Call Alert Decode - If selected, enables call alert messages (pages) to be received.
Call Alert Encode - If selected, enables call alert messages (pages) to be sent.

OTAR and Data Settings

Tip You must select the SLN (CKR) key management mode on Page 2 of the Global screen to 
select the OTAR and Data parameters which follow.

Clicking the  button displays the following screen which programs various 
OTAR and Project 25 data parameters:
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Figure 7.4 OTAR and Data Settings screen 

OTAR
OTAR Enabled - Select “On” to enable OTAR (Over-the-Air Rekeying) of 
encryption keys. Select “Off” to disable this feature.
Rekey Request Time Out11 - When rekeying is initiated by the radio (OTAR Rekey 
Request message sent), this setting determines how long the radio waits for a 
response from the Key Management Facility (KMF). Times of 20-180 seconds can 
be programmed.
Rx Security Level12 - When Enhanced is selected, only encrypted and authenticated 
Key Management Messages (KMMs) from the KMF are accepted (except for warm-
start, which is authenticated only). If Basic is selected, any KMM is accepted that is 
in a format allowed by the OTAR standard. 
Tx Security Level12 - When Enhanced is selected, all OTAR procedures originating 
from the radio are encrypted and authenticated. If they cannot be encrypted and 
authenticated, the KMM will not be sent. When Basic is selected, the radio always 
sends KMMs in the clear (if the OTAR standard allows them to be unencrypted and 
unauthenticated). 
Originating Response Kind12 - Selects if a response is required from the KMF to 
outgoing messages. If “Kind 1-Unconfirmed” is selected, no response is requested, 
and if “Kind 3-Confirmed” is selected, and immediate response is requested.

Data/SNDCP (Simple Network Data Control Protocol)
Data Registration Enabled - Select “On” if OTAR is used. The radio then registers 
with the data system on a channel change (Project 25 channels only)
CAI Data Max Tx Attempts12 - Selects the maximum number of times the radio 
attempts to send a Common Air Interface (CAI) data packet transmission. Retrys 
continue until it receives an acknowledgement confirming the successful receipt of 
transmission, or until the selected amount of transmit attempts is reached.
Response Timer12 - Selects the amount of time the radio waits for an 
acknowledgement that a CAI transmission is successful before resending.
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Phone Interconnect (Project 25 Only)10

Note Project 25 phone calling is available on conventional channels only with 5100 portables 
with firmware 1.16/2.6/3.6/4.2 or later and 5300 mobiles with firmware 1.28/2.6/3.6/4.2 
or later.

Usage
Disabled - Phone calls cannot be placed or received.
Answer Only - Phone calls can be received but not placed.
List Only - Phone calls can be placed and received, and numbers can be recalled 
from a preprogrammed list only.
Unlimited - Private calls can be placed and received, and numbers can be recalled 
from a preprogrammed list or dialed using a keypad. With 53xx radios (firmware 
Version 1.28/2.6/3.6/4.2 or later only), this mode is supported only when the HHC 
control unit is used. Standard 53xx front and remote models do not support number 
dialing.

Note To enter this mode, press the Phone key and hold until a tone sounds.

RTT Signaling - Request to Talk (RTT) is used to alert the OCC operator that a unit is 
requesting to speak with the operator. In some cases Automatic Number Identification 
(ANI) is utilized to permit OCC operator identification of unit calling. Each base, mobile 
and portable radio transmits an encoded signal which is decoded into a unit identification 
and is displayed at the operator’s console position. Priority capabilities permit a member 
to signal an emergency condition to the commenter by pushing one button.

Press and Hold - The time it takes to activate RTT Signaling.
Analog 

Enabled - Enabled if a conventional analog channel.
Signaling Type - DTMF, MDC 1200, Single Tone Encoder, Five Tone Encoder.

P25 Digital

Enabled - Enabled if a digital channel.
Vote Scan - This option must be purchased.

RSSI Threshold - Sets the Receive Signal Strength Indicator (RSSI) levels that 
determine when searching for and switching to another site occurs.
Delay Timer - A delay that starts once a valid RF signal is received. After the delay 
timer has elapsed, an RSSI measurement is made.
Fast Vote Scan - A feature that is selected and if the signal strength level for the 
current repeater is above the RSSI Threshold setting, no additonal voting will occur and 
the current repeater will be used.
Vote Without Squelch Code - If enabled, the CTSS/DCS setting will be ignored when 
determing which repeater to used.

Talk Permit Tone - An audible tone alerting the user that it is OK to talk.
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Duration - The amount of time that the tone sounds.
Timers

Tx Time-Out - This timer limits the length of individual transmissions. Times up to 
3 minutes, 45 seconds can be programmed in 15-second steps.
Penalty - This timer disables transmitting after the time-out timer disables the 
transmitter. Times up to 3 minutes, 45 seconds can be programmed in 15-second 
steps.
Conversation - This timer limits the total length of a conversation. Times up to 7.5 
minutes can be programmed in 0.5-minute steps.

Other
System Modulation - Reserved for future use.
Busy Channel Override - If selected, the busy channel lockout feature can be 
overridden by quickly releasing and then pressing the PTT switch.
Keypad CTCSS/DCS (51xx Only) - If selected, a code for the selected channel can 
be directly selected from the programmed CTCSS/DCS/NAC list using the keypad. 
For example, pressing the “3” key selects code number 3 from the table. No other 
functions can then be assigned to the keys. If this is not selected, these codes can be 
selected only by the option button or menu parameter for that function.
Radio Inhibit (Project 25 only)13 - If selected, the dispatcher can send a command 
which disables the radio.
Radio Check (Project 25 only)13 - If selected, the dispatcher can send a message 
requesting a response from the radio (to check if it is in operation, for example).

7.2 Conventional System Lists
The various conventional system lists are programmed by selecting them in the System 
Lists drop-down list on the Conventional Per System screen shown Figure 7.1 and then 
clicking the Edit List button. Descriptions of the various lists and the information they 
program follow. Figure 7.5 shows the drop-down Systems List

Figure 7.5 System Lists drop-down list 

The following system lists may be selected:

• Status Alias List (Project 25 Only)

• Message Alias List (Project 25 Only)

• Call List (Project 25 Only)

• Talk Group List (Project 25 Only) 

• Priority Scan List
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• CTCSS/DCS/NAC List

• User Group ID List* (Project 25 Only)

• Phone Access Code List (Project 25 Only)

• Phone List (Project 25 Only)

7.2.1 Status Alias List (Project 25 Only)13

The Status Alias List screen which follows programs the alias for each of up to eight status 
conditions that can be sent. The meaning of each status number is defined by the system 
manager.

Figure 7.6 Status Alias List screen 

To display this screen, on the Conventional Per System screen, select Status Alias List in 
the drop-down list and then click the  button (see Figure 8.1).

To add an alias, click the  button, and to delete an alias, simply select it and click 
the Delete button. To edit an alias, select it and change it as desired. Up to ten characters 
can be entered that identify the status. This identification is displayed when the user 
selects a status condition.

7.2.2 Message Alias List (Project 25 Only)13

The Message Alias List screen shown in Figure 7.7 associates an alias (name) with each 
message number. The meaning of each message number is defined by the system 
manager.
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Figure 7.7 Message Alias List screen 

To display this screen, on the Conventional Per System screen, select Message Alias 
List in the drop-down list and then click the  button (see Figure 8.1). 
To add an alias, click the  button, and to delete an alias, simply select it and 
click the Delete button. To edit an alias, select it and change it as desired. Up to ten 
characters can be entered that identify the status. This identification is displayed when 
the user selects a message.

7.2.3 Call List (Project 25 Only)

This Call List screen which follows sets up the IDs used to place individual calls on 
conventional digital (Project 25) channels. This list is not used with conventional 
analog channels.

Figure 7.8 Call List screen 

To display this screen, on the Conventional Per System screen, select Call List in the 
drop-down list and click the  button (see Figure 8.1). 
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To add a call, click the  button, and to delete an call, simply select it and click 
the Delete button. To edit an Alias or ID, select it and enter the desired information as 
follows:

Alias - Up to ten characters can be entered to identify the user being called. This 
identification and the ID are alternately displayed when the call is selected by the 
user. Only uppercase letters can be entered, so lowercase letters are automatically 
converted to uppercase by the program.
ID - This is the ID of the radio being called. Valid entries are 0 - 16,777,216. When 
receiving a call from a unit with an ID entered on the list, the alias is displayed on the 
radio instead of the numeric ID.

7.2.4 Talk Group List (Project 25 Only) 

The Talk Group screen shown in Figure 7.9sets up the Talk Groups used to place group 
calls on conventional digital (Project 25) channels. Talk groups are not used with 
conventional analog channels. Talk groups are assigned to channels on the channel 
programming screen described in Section 6.5.

Figure 7.9 Talk Group screen 

To display this screen, on the Conventional Per System screen, select Talk Group List 
in the drop-down list and then click the  button (see Figure 8.1). 
To add a talk group, click the  button, and to delete an talk group, simply select 
it and click the Delete button. To edit an ID or Alias, select it and enter the desired 
information as follows:

ID - Group IDs can be any number from 0-65535. Group IDs can be entered as 
decimal or hexadecimal numbers depending on which mode is selected. 
Alias - The alias is the identification that is displayed when the Talk Group is 
selected, and up to 10 characters can be entered. This drop-down list selects the Talk 
Group to be edited if applicable.
Security Parameters

Clear - All transmissions on the group occur in the clear (unscrambled) mode.
Secure - All transmissions occur in the secure (scrambled) mode. 
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Switched - The clear or secure status of the group is selected by the Clear/Secure 
option switch.

Encryption Key ID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/
CKR mode) of the key used for secure calls on the group if applicable.

Add Mode - To add an entire block of talk group IDs or a specific ID, click the arrow 
button  in the lower right corner of the screen and the Talk Group screen is expanded 
and the following panel is displayed: 

Figure 7.10 Add Mode screen 

Add Mode Drop Down List - “Single” adds the next available ID similar to the 
preceding “Add” button. “Multiple” adds a block of IDs as follows. To initiate the 
selected add operation, click the preceding “Add” button. If the specified ID range 
results in duplicate IDs, an error message is displayed and no IDs are added.
Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be added.

ID Step - Specifies if consecutive IDs are added or some other step rate is used.
For example, if Start ID =10, ID Count = 5, and ID Step = 10, the IDs added are 10, 20, 
30, 40 and 50.
Use Selected Group’s Security - When selected, the added groups are automatically 
programmed with the Strapping Mode and Encryption Key ID of the selected group.

7.2.5 Priority Scan List

Note It may be necessary to define specific channel parameters before programming the 
conventional scan lists as follows (see Section 6.3.1).
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Figure 7.11 Priority (Standard) Scan List Programming Screens 

This displays the Priority (Standard) Scan List screen shown in Figure 7.11. This screen 
programs the priority scan lists that are selected on the system.

List Number - This drop-down list selects which of the scan lists to program. Click the 
“Add” button to add a scan list and “Delete” to delete a scan list.
User Editable - If this box is checked, user editing of the scan list is allowed. The Scan 
Edit function switch is then required. User editing can be enabled or disabled on each 
scan list.

Note With the 51xx and 53xx, Priority 1 and 2 channels can be programmed. The Priority 1 
channel is sampled while listening to a call on the Priority 2 channel but not vice versa.

Scan Mode - Sets the channel on which transmissions occur when the PTT switch is 
pressed while scanning. A different mode can be programmed for each scan list. In 
addition, it selects if priority sampling is used and also the type of priority channel. The 
following modes are available:

No Priority - Priority sampling does not occur (all channels are scanned in 
sequence). The radio transmits on the selected channel.
Priority/Tx Selected - Priority sampling occurs and the priority channel(s) are those 
programmed in the selected scan list. The radio transmits on the selected channel.
Priority/Tx Priority (1) - Priority sampling occurs and the priority channel(s) are 
programmed in the selected scan list. The radio transmits on the priority (1) channel.
Priority (1) on Sel Chan - The priority (1) channel is always the selected channel. 
The radio transmits on the selected channel. 
Talkback - No priority sampling occurs. The radio transmits on the channel of a call 
while scanning is halted. Then when scanning resumes, it transmits on the selected 
channel.

If the “Priority/Tx Priority” or “Priority/Tx Selected” mode is programmed, you must 
choose the priority channel for the scan list. To do this, click the box next to the desired 

Edit Scan List Screen

Modify Scan List Screen
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channel. Select the Priority 1 channel in the Priority 1 column and if a Priority 2 channel is 
also used, select it in the Priority 2 column.

 (Modify) - To add or delete channels from a list, click this button to display 
the Modify Scan List screen shown in the preceding illustration. Select the channels 
from each zone that are to be included in the selected list (up to 16 channels maximum).

 - (OK) - Clicking this button closes the screen and saves the changes.
 (Cancel) - Clicking this button closes the screen without saving any changes.

7.2.6 CTCSS/DCS/NAC List

Use Figure 7.12 to program the list of CTCSS/DCS (Call Guard) and NAC (Project 25) 
codes that can be selected if the Selective Squelch option switch is programmed or the 
Keypad CTCSS/DCS function which follows is programmed. 

Figure 7.12 CTCSS/DCS/NAC List

To add a code to the list, click the Add button and an additional screen like the one shown 
above is displayed. Different codes can be programmed for the transmit and receive modes 
by selecting the mode in the drop down list. In addition, carrier squelch can be 
programmed instead of a CTCSS/DCS code by unchecking the CTCSS/DCS box. To 
change a code, select it and then click the Modify button. Up to 64 different codes can be 
programmed. A CTCSS/DCS code table is shown on Page 17-1.

7.2.7 User Group ID List13 (Project 25 Only)

Use the User Group ID List screen shown in Figure 7.13 to program aliases that can be 
displayed if a call is received on a talk group ID within the programmed block. For 
example, with the following screen, if a group call is received on group IDs 234-264, the 
alias “Fire” can be displayed. The display of this alias is controlled by the “User Group 
ID” parameter on the Radio Wide screen.
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Figure 7.13 User Group ID List screen 

7.2.8 Phone Access Code List (Project 25 Only)10

Use the Phone Access Code List screen shown in Figure 7.14 to program sets of 
predefined DTMF access and de-access codes needed to make interconnect telephone 
calls on Project 25 channels. The code must be entered before the actual telephone 
number. They can be up to four digits in length, and the default code is *1P#. The access 
code is selected from this list on the conventional digital channel screen (see Section 
6.3.2).

Figure 7.14 Phone Access Code List screen

7.2.9 Phone List (Project 25 Only)10 

Use the Phone List screen shown in Figure 7.15 to program the telephone number list used 
for placing telephone calls if applicable. A maximum of 16 numbers can be programmed. 
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To display this screen, on the Conventional Per System screen, select Phone List in the 
drop-down list and then click the  button (see Figure 8.1). 

Figure 7.15 Phone List screen 

To add a number, click the  button, and to delete a number, simply select it and 
click the Delete button. To edit an alias or number, select it and enter the desired 
information as follows:

Alias - Up to ten characters can be entered to identify the number being called. This 
identification is displayed when the number to be called is selected by the user from 
the list. Only uppercase letters can be entered, so lowercase letters are automatically 
converted to uppercase by the program.
ID - This is the telephone number dialed when the location is selected. Numbers up 
to sixteen digits can be entered. A pause is entered by “p” or “P” and counts as one 
digit.
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Chapter 8SMARTNET and SmartZone 
Systems

Two screens contain the interface where you program individual SMARTNET and 
SmartZone system parameters. This section contains descriptions of the parameters that 
you find on these screens. You can program these parameters after you set-up the desired 
systems as described in Section 1.10. 

There are also SMARTNET and SmartZone radio wide system parameters that you 
program at the Radio Wide screen described in Section 5.6.

Note You can edit some SMARTNET and SmartZone parameters only if PC Configure detects 
the proper system key. PC Configure detects a key if a yellow key icon is indicated as 
shown in Figure 8.1. If there is a red “X” through this icon, PC Configure does not detect 
a key. Refer to Section 13 for more information.

Some parameters described in this section apply only to certain revision levels. In this 
section, index numbers in superscript appear next to the names of such features (for 
example, “Example Feature9”). Table 1.1 shows the relationship between these numbers 
and the revision levels they represent.

8.1 SMARTNET and SmartZone System Parameters: 
Initial Screen

Figure 8.1 shows the initial SMARTNET and SmartZone system programming screen.
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Figure 8.1 SMARTNET and SmartZone System Screen

IDs

Note You can enter these IDs in either decimal or hexadecimal format as described in Section 
1.9.4.

System - After you have loaded the system key from the Keys folder, select the key 
from the pull-down box. (Refer to the related Note at beginning of this section.) System 
ID numbers can be 1 through 65535 or 0001 through FFFF hex. If PC Configure does 
not detect a valid system key, you can only select the default ID of “1” 
Indiv - Uniquely identifies the radio on a particular system. Each radio must have a 
different Unit ID. Valid Unit IDs are 1 through 65535. If you checked the Hex box, you 
can enter Indiv as a hexadecimal number instead of a decimal number.

Keys - Programs the following encryption key ID (hardware location) that is used for all 
except group calls.

System Wide - Key used for system-wide calls (typically originated by the dispatcher). 
The dispatcher usually originates these calls.
Failsoft - Key used in failsoft conditions.
Patch - Key used in patch calls.
Unit To Unit - Key used for unit-to-unit (private) calls.

Interconnect - Key used for telephone interconnect calls.
Dynamic TG - The talkgroup used when the radio has been dynamicallly regrouped. 
Defaulted value.

System Key
Indicator
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Dynamic AG - The announcement group used when the radio has been dynamically 
regrouped. Defaulted value.

System Lists - Refer to Section 8.2 for information on these lists.

Emergency

Emergency Alarm
Disabled - The radio sends no emergency signal when the user presses the 
Emergency option switch.
Normal - The radio sends an emergency alarm when the user presses the Emergency 
switch. If you disabled emergency calls, the alarm always occurs on the selected 
group. If you enabled emergency calls, it occurs—in order of preference—on the 
emergency group, selected group, and announcement group. When radio sends an 
emergency signal, the red transmit indicator lights, an emergency tone sounds, and 
“EMERGNCY” flashes in the display. “EMERGNCY” and the initiating ID 
continue to flash alternately until power is cycled, the channel is changed, or the 
radio user presses and holds the Emergency switch.11 
Silent - Same as Normal except none of the preceding audio or visual indications 
occurs.

Emergency Call
Enable - When you check this box, if the radio user presses the Emergency option 
switch and then the PTT switch, an emergency group call transmits on the 
emergency group. The radio user cancels the emergency mode by cycling power or 
pressing and holding11 the emergency switch.
Disable - When you do not check this box, no emergency group call is authorized.

Emergency Hot Mic
Enable - When you check this box and the radio user sends an emergency alarm by 
pressing the Emergency switch, automatic transmitting occurs. The microphone 
audio is unmuted (without user intervention) for the time specified by the following 
Emergency Hot Mic Time. If you do not check this or if you do not select either 
emergency call, automatic transmissions do not occur. This feature initiates only by 
the first press of the Emergency switch. Subsequent presses do not trigger automatic 
transmissions. This function resets if the radio user changes the channel. 
Disable - If you do not check this box, automatic transmissions do not occur.

Emergency Hot Mic Time - Specifies the time period during which transmissions 
occur. You can select time periods of 10 through 120 seconds in ten-second increments.

Increment by 1 - If the ten-second increment is not desired, check this box to 
increment by one second.
Emergency Retry Counter - If you check Inf (infinite), the radio system repeats 
emergency calls until they are acknowledged or canceled. If you do not check it, the 
radio system repeats these calls only the specified number of times.
No Rx Activity During Emergency12 - When you check this box, the following radio 
receive indications do not display in the emergency mode: Receive audio, receive LED, 
and receive icons.
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Time/Timers

Time-Out Timer - This timer determines the maximum time period of a continuous 
transmission. You can program it for 15 through 225 seconds in 15-second intervals, or 
you can disable it (0).

ISW Delay Time - Increasing or decreasing this value changes the transmission timing 
of inbound signaling words (ISWs) relative to the reception of outbound signaling words 
(OSWs).

Scan Hold Time - Specifies the delay that occurs after the radio no longer receives a 
message before scanning resumes. You can program times of 2 through 10 seconds. 
The default is three seconds.
Time until Error Tone - Defaulted value.
Quick Fade Protect - Specifies the time the radio will stay on the control channel when 
synchronization is lost before resynchronizing. This allows recovery without 
performing a full resynchronization of the channel.

Phone DTMF Timing (Analog Only)

Initial Delay - Delay from 10 through 500 milliseconds from the time the radio system 
grants a traffic channel for phone interconnect to the start of the dialing of the phone 
number.
Digit Duration - Duration from 10 through 500 milliseconds of each phone number 
digit.
Inter Digit Delay - Delay from 10 through 500 milliseconds between each digit of a 
phone number.

Other

PTT ID Enable - When selected, the radio can key during the programmed hang time 
and continue the conversation on the active channel, similar to message trunking. If a 
user keys during the hang time, reaffiliation with the system occurs before the radio 
uses the voice channel. The radio then holds the voice channel while this reaffiliation 
occurs. The call connects to the open voice channel. This results in all traffic being 
logged, even the traffic of the radios that transmit during the hang time.
If you do not select either PTT ID Enable or Transmission Trunking, operation is 
similar to that described above. However, reaffiliation does not occur during the hang 
time. Therefore, radios that key up during the hang time do not affiliate and are not 
logged. The radio system logs only the call of the radio that initiates the call.
Splinter Channels - When you check this, the receive and transmit frequencies are 
12.5 kHz lower than the normal frequencies. Splinter channels are used only as required 
in the U. S.-Mexico and U. S.-Canada border areas for frequencies between 806 and 
820.975 MHz.
Dynamic Regrouping - When you check this, you can program a dynamic regrouping 
channel. This is a SMARTNET/SmartZone channel that the dispatcher dynamically sets 
the talk group for. You select it on the channel screen. Refer to Section 6.4.
Transmission Trunking - The radio does not use hang time. The radio affiliates and 
receives a new channel grant on every PTT. When a radio unkeys, the radio system 
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makes the channel available for other users immediately, and the system logs all traffic. 
If you do not check this, refer to the PTT ID Enable description above.
Connect Tone - The tone expected by the controller on the traffic channel to confirm 
the presence of a subscriber transmission. Set this tone the same as it is in the controller.
Private Call Usage 

Disabled - The radio user cannot place private calls or receive them.
Response Only - The radio user can receive private calls but cannot place them.
List Only - The radio user can place private calls and receive them. The user can 
recall numbers from a programmed list only.

Note To enter the following mode, the radio user must press the phone key and hold it until a 
tone sounds.

Unlimited - The radio user can place private calls and receive them. The user can 
recall numbers from a programmed list or dial them from the keypad. 53xx radios 
support this mode only when they use the HHC control unit (firmware Version 1.28/
2.6/3.6/4.2 or later only). Standard 53xx front and remote models do not support 
number dialing. 

Private Call 2
Standard - Selects the standard Private Conversation mode in which the user does 
not receive any feedback when the called radio is not active in the system. The radio 
user receives only a “No Answer” if the called radio does not answer.
Enhanced - Selects the Enhanced Private Conversation™ mode. When the radio 
users places a call with this mode, the system tells the user if the called radio is 
currently active in the system and within range. The calling radio displays “No Ack” 
if the called radio is not active in the system and “No Answer” if it is active but does 
not answer.

Phone Inter. Usage - Programs operation of telephone calls same as “Private Call 
Usage” above.
Affiliation Type (SMARNET Only)

Automatic - The radio immediately affiliates with the central controller as soon as 
the radio operator turns it on. The radio automatically re-affiliates each time the talk 
group changes.
On PTT - The radio affiliates with the central controller each time the radio user 
presses the PTT switch, even when pressed during the hang time. Also, when the 
radio user keys the radio during the hang time, the radio holds the active channel 
during the re-affiliation. The re-affiliated radio continues traffic on this channel.

Channel Bandwidth - Selects the channel bandwidth as 25, 20, or 12.5 kHz.
25 kHz - Tx Modulation Limiting is 4 kHz for NPSPAC (821 or 806) channels, 5 
kHz otherwise.
20 kHz - Tx Modulation Limiting is 4 kHz for all frequencies.
12.5 kHz - Tx Modulation Limiting is 2.5 kHz for all frequencies.

Transmit Power - Fixes the system’s transmit power at the high or low level, or makes 
it selectable. If it is selectable, the radio must have a high/low power function switch.
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RSSI Threshold (SmartZone Only) - Sets the Receive Signal Strength Indicator (RSSI) 
levels that determine when searching for and switching to another site occurs.

Tip Do not change the RSSI Threshold default levels unless you know how these settings 
affect operation.
Hot DTMF - When you check this, the radio sends DTMF digits when the radio user 
presses buttons while transmitting in the SMARTNET/SmartZone analog mode.
STAR Trunking (SmartZone Only) - Selects this feature which is available with 
SmartZone systems. The system selected in the System: pull-down menu then becomes 
the “home” system. The radio system then requires no other system information to use 
this feature. You must enter the talk groups as with non-Omnilink systems. All other 
programming occurs on the infrastructure side. All required roaming information is 
received through adjacent site control channel data.

8.1.1 SMARTNET and SmartZone Additional Parameters

You open and close a second SMARTNET and SmartZone system programming screen 
when you click the  buttons in the upper right corner of the screen. The following 
additional parameters are then displayed. Section 8.2 shows the parameters displayed on 
this second screen.

Figure 8.2 SMARTNET and SmartZone System Page 2 screen

Analog Transmit DES/DES-XL3 - Allows you to specify the type of encryption 
individually for Unit and Interconnect calls made in the analog mode. You can only use 
DES-XL if the radio has the Motorola UCM encryption module. Refer to Section 16.
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Remote Monitor - Used to remotely key up the radio for emergency situations. System 
sends a trace talkgroup to the radio. The radio receives the command and performs a 
hotmic on that talkgroup for period of time programmed (15, 30, 45, 60 seconds).

Transmit Base Time - Time programed for Remote Monitor. From 15 to 60 seconds in 
15-second intervals.

Customized Roaming Properties (SmartZone Only) - You can change SmartZone and 
Project 25 Trunked roaming properties by clicking the  button. The screen shown 
in Figure 8.3 is displayed. Information programmed in this screen is described in the 
Roaming Properties Notes window that is displayed. The RSSI Filter slider bar controls 
how quickly the radio reacts to dropouts in the RSSI level. The more aggressive the 
setting, the quicker site switching occurs.

Figure 8.3 SmartZone Customized Roaming Properties Screen (SmartZone/Project 25 Trunked 
Only)

Other - Disable Site Trunking Operation10 - When you check this, you disable site 
trunking on the system.

8.2 SMARTNET and SmartZone System Lists
Select the various SMARTNET and SmartZone lists by the “System Lists” pull-down 
menu on the SMARTNET and SmartZone Per System screen. Refer to Figure 8.1. After 
you select the desired list, you can edit it by clicking the  button. 

This section contains descriptions of the following lists:
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• Control channels list
• Status alias list
• Message alias list
• Call alias / ID list
• System alias / phone list
• SmartZone talk groups list
• SmartZone announcement groups list
• Priority scan list
• System alias / ID list (SmartZone systems only)
• System wide preferred site list (SmartZone systems only)
• Other band trunking list (VHF/UHF only)
• User group ID list
Descriptions of the various lists and the information they program follow.

8.2.1 Control Channels List

The Control Channels list screen shown in Figure 8.4 allows the system manager to view 
and edit the control channels. Each SMARTNET system can have a maximum of four 
control channels. Each SmartZone system can have a maximum of 48 control channels. 
5300 logic boards through Rev 4 allow a maximum of 32 SmartZone entries. Only one 
control channel is active at a time.

To display this screen, on the SMARTNET/SmartZone Per System screen, select 
“Control Channel List” in the pull-down menu, then click the  button. Refer to 
Figure 8.1.

Figure 8.4 Control Channels List Screen
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To add a channel, click the Add button. To delete a channel, simply select it and click the 
Delete button. To edit a channel, select the digits that you want to change and edit them as 
desired. For the 800 MHz band, you can change only the receive channel frequency. PC 
Configure automatically calculates the transmit frequency (45 MHz below the receive 
frequency). These are the mobile frequencies, not the repeater frequencies. Only multiples 
of 5 kHz and 6.25 kHz are valid.

8.2.2 Status Alias List

The Status Alias list screen shown in Figure 8.5 is the interface where you program the 
alias for each of a maximum of eight status conditions. The system manager defines 
meaning of each status number.

To display this screen, on the SMARTNET and SmartZone Per System screen, select 
“Status Alias List” in the pull-down menu, then click the  button. Refer to 
Figure 8.1. 

Figure 8.5 Status Alias List Screen

To add an alias, click the Add button. To delete an alias, simply select it and click the 
Delete button. To edit an alias, select it and change it as desired. You can enter a 
maximum of 10 characters. This identification displays when the user selects a status 
condition.

8.2.3 Message Alias List

The Message Alias list screen shown in Figure 8.6 associates an alias (name) with each 
message number. The system manager defines the meaning of each message number. 

To display this screen, on the SMARTNET/SmartZone Per System screen, select 
“Message Alias List” in the pull-down menu, then click the  button. Refer to 
Figure 8.1.
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Figure 8.6 Message Alias List Screen 

To add an alias, click the Add button. To delete an alias, simply select it and click the 
Delete button. To edit an alias, select it and change it as desired. You can enter a 
maximum of ten characters. This identification displays when the user selects a status 
condition.

8.2.4 Call List

The Call List screen shown in Figure 8.7 programs the list of IDs used for private calls. 
You can program a maximum of 255 IDs. To display this screen, on the SMARTNET/
SmartZone Per System screen, select “Call List” in the pull-down menu, then click the 

 button. Refer to Figure 8.1.

Figure 8.7 Call List screen

To add a call, click the Add button. To delete a call, simply select it and click the Delete 
button. To edit an alias or ID, select it and and enter the desired information as follows:
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Alias - You can enter a maximum of ten characters to identify the user being called. 
This identification displays when the user selects the mobile radio to be called from the 
list. When the user receives a call from a unit in this list, the alias of the unit displays for 
the user instead of the calling unit’s ID number. You can enter only capital letters, so 
PC Configure automatically converts any lowercase letters that you enter to capital 
letters.
ID - This is the ID of the radio that the user is calling. Valid entries are 0 through 
65535. PC Configure detects zero (“0”) as no entry. 

8.2.5 Phone List

The Phone list screen shown in Figure 8.8 programs the telephone number list that the 
radio user may place telephone calls from (if you program the system to use this feature). 
You can program a maximum of 255 numbers. To display this screen, on the SMARTNET 
and SmartZone Per System screen, select “Phone List” in the pull-down menu, then click 
the  button. Refer to Figure 8.1. 

Figure 8.8 Phone List Screen

To add a call, click the Add button. To delete a call, simply select it and click the Delete 
button. To edit an alias or number, select it and enter the desired information as follows

Alias - You can enter a maximum of ten characters to identify the number being called. 
This identification displays when the user selects the number to be called from the list. 
You can enter only capital letters, so PC Configure automatically converts any 
lowercase letters that you enter to capital letters.
ID - This is the telephone number that the radio dials when the radio user selects the 
location. Enter the three-digit area code and seven-digit telephone number using the 
numbers 0 through 9. 
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8.2.6 Talk Groups List

The SmartZone Talk Groups List screen shown in Figure 8.10 sets up SMARTNET and 
SmartZone talk groups and programs unique talk group information. To display this 
screen, on the SMARTNET and SmartZone Per System screen, select “Talk Group List” 
in the pull-down menu, then click the  button. Refer to Figure 8.1. 

Figure 8.9 SMARTNET Talk Groups List screen 
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Figure 8.10 SmartZone Talk Groups List screen

The parameters programmed in this screen are as follows: 

ID - This list displays the talk group IDs contained in the Talk Group list. To edit a talk 
group ID in this list, select it and then change it in the Selected Group box. This is the 
actual ID of the talk group. You assign talk groups to channels in the Zone screen. Refer 
to Page 6-10.

Note You can enter this ID in either the decimal or hexadecimal format as described in Section 
1.9.4.

Add - Click this button to add the next available talk group ID to the list. You can program 
each SMARTNET and SmartZone system with up to 255 talk groups.

Add Mode - To add an entire block of talk group IDs or a specific ID, click the arrow 
button  in the lower right corner of the screen. The Talk Groups screen is expanded 
and the Add Mode panel shown in Figure 8.11 is displayed:
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Figure 8.11 Add Mode Screen

Add Mode Pull-Down 
Single - Adds the next available ID similar to the Add button. 
Multiple - Adds a block of IDs as follows: To initiate the selected add operation, 
click the Add button. If the specified ID range results in duplicate IDs, an error 
message displays and PC Configure adds no IDs.

Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be added.
ID Step - Specifies if consecutive IDs are added or some other step rate is used. 
For example, if Start ID =10, ID Count = 5, and ID Step = 10, the IDs added are 
10, 20, 30, 40 and 50. 

Use Selected Group’s Security - When selected, PC Configure automatically 
programs the added groups with the Strapping Mode and Encryption Key ID of the 
selected group.

 - Clicking this button deletes the selected talk group.

Group Type - Select either “Analog” or “Digital” signaling on the talk group.

Use System Preferred Site List (SmartZone Only) - Selects one of the preferred site 
lists for the talk group. Refer to the “Preferred Sites” description which follows for more 
information.

Security

Strapping Mode 
Strapped Clear - All transmissions on the talk group occur in the clear 
(unencrypted) mode. 
Strapped Secure - All transmissions on the talk group occur in the secure 
(encrypted) mode selected as follows.
Switched - The clear or secure status of the talk group is selected by the Clear/Secure 
option switch.

Security Type - Select SecureNet or Scrambling (if programmed)

Note Voice encryption is an optional feature that requires factory programming and possibly 
special hardware.
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SecureNet - Selects the Motorola SecureNet DES type of secure communication 
when you select either the coded or switched strapping mode. 

Tx DES/DES-XL
With analog channels, when you select “Securenet” secure communication, you 
select either the DES or DES-XL type. DES-XL is available only in later models 
equipped with the UCM module. 
On digital channels, you cannot select the type. Digital channels support both DES-
OFB and AES encryption. The encryption key that the talk group selects determines 
the encryption type. 

Note AES encryption is not available with the 51SL or 53SL.

Key PID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/CKR mode) 
of the key used for secure calls on the group if applicable.

Rx Auto Detect

Secure - If this option is checked, an encrypted signal is automatically detected and 
received. This option may increase the response time to incoming signals. If it is not 
checked, those signals are detected only if they are coded like the transmit signals.
Proper Key - If this option is checked, the radio will search the available encryption 
keys until it finds a match for the current transmission.

Failsoft Frequencies

Enabled - If you check this box, you enable a failsoft channel on the talk group if a 
controller or other major failure occurs. If you do not check this box, the radio does not 
enter failsoft mode if a failure occurs.
Tx (MHz) - Programs the failsoft transmit frequency if you checked Enabled.
Rx (MHz) - Programs the failsoft receive frequency if you checked Enabled.

Talk Group Specific Preferred Sites (SmartZone Only) - With SmartZone systems, you 
can associate a maximum of four preferred sites and/or a preferred site list13 with each talk 
group. Check the box of a preferred site to associate it with a talk group. This forces a call 
on the talk group to access the specified sites. The system manager can then keep mobiles 
on specific sites even if you do not enable the Site Search feature. You program the 
preference for each site as “Least”, “None”, “Preferred”, or “Always” as follows.

Program the preferred site lists at the System Preferred Site Lists screen described on 
Page 8-19. You can program a maximum of 16 lists. Each site can include up to 16 
sites.
If both a preferred site list and one or more preferred sites (selected at bottom of 
screen) are associated with a talk group, the preferred sites at the bottom are searched 
first. The first entry found for a given site is used. If the same site is in both lists, the 
entry in the list at the bottom of the screen is used first. 

Selected Site
RFSS ID- Designates a zone controller that the talk group can roam to.
Site ID - Designates a site that the talk group can roam to.
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Preference - “Least”, “None” (no preference), “Preferred”, or “Always (preferred) is 
a weighting for steering to different sites.

Wide Area System Scan Preference - The feature is exclusive to the talkgroup site 
preference settings. You can use talkgroup site preferences or you can use Wide Area 
System Scan. (You can also use the System Site Preference lists with Wide Area System 
Scan.) Once you enable the feature, PCConfigure blocks the talkgroup site preference 
boxes on the form.

8.2.7 SmartZone Announcement Groups List

The Announcement Group List screen shown in Figure 8.12 sets up SMARTNET/
SmartZone announcement groups that are used to communicate with several talk groups 
simultaneously. Each announcement group can have up to 15 talk groups.

Figure 8.12 Announcement Group List screen

To display this screen, on the SMARTNET or SmartZone Per System screen, select the 
Announcement Group List in the drop-down list and then click the  button (see 
Figure 8.1). The parameters programmed in this screen are as follows: 

Group ID - This list displays the Announcement group IDs currently contained in the 
Announcement Group list. To edit an ID in this list, select and change it in the Selected 
Group box. This is the actual ID of the announcement group. Announcement groups are 
assigned to channels in the Zone screen (see Page 6-10).

Note You can enter this ID in either decimal or hexadecimal format as described in Section 
1.9.4.
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 - Click this button to add the next available announcement group ID to the 
list. You can program each SMARTNET/SmartZone system with up to 255 
announcement groups.
To add an entire block of announcement group IDs or a specific ID, click the arrow 
button  in the lower right corner of the screen. The Annuncement Group List 
screen is expanded and the Add Mode panel is displayed. Refer to the preceding 
“Talk Group List” description for more information on this screen.

Figure 8.13 Add Mode screen 

 - Click this button to delete the announcement group that is currently selected in 
the list.

Group Type - Select either Analog or Digital signaling on the announcement group.

Use System Preferred Site List (SmartZone Only) - Select one of the preferred sites for 
the announcement group. Refer to the preceding Talk Group List description for more 
information.

Security

Strapping Mode 
Strapped Clear - All transmissions on the talk group occur in the clear 
(unencrypted) mode. 
Strapped Secure - All transmissions on the talk group occur in the secure 
(encrypted) mode selected as follows.
Switched - The clear or secure status of the talk group is selected by the Clear/
Secure option switch.

Security Type - Select SecureNet or Scrambling (if programmed).

Note Voice encryption is an optional feature that requires factory programming and possibly 
special hardware.

SecureNet - Selects the Motorola SecureNet DES type of secure communication 
when you select either the coded or switched strapping mode. 
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Tx DES/DES-XL
With analog channels, when you select “Securenet” secure communication, you 
select either the DES or DES-XL type. DES-XL is available only in later models 
equipped with the UCM module. 
On digital channels, you cannot select the type. Digital channels support both DES-
OFB and AES encryption. The encryption key that the talk group selects determines 
the encryption type. 

Note AES encryption is not available with the 51SL or 53SL.

Key PID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/CKR mode) 
of the key used for secure calls on the group if applicable.

Rx Auto Detect

Secure - If this option is checked, an encrypted signal is automatically detected and 
received. This option may increase the response time to incoming signals. If it is not 
checked, those signals are detected only if they are coded like the transmit signals.
Proper Key - If this option is checked, the radio will search the available encryption 
keys until it finds a match for the current transmission.

Talk Group List - Select the talk groups that are included in each announcement group. 
You can enter this ID in either decimal or hexadecimal format as described in Section 
1.9.4.

Announcement Group Specific Preferred Sites (SmartZone Only) - Program the 
preferred site information similar to talk groups described in the preceding “Talk Group 
List” description. You can associate up to four Preferred Sites and/or a Preferred Site List 
with each announcement group.

8.2.8 Priority Scan List

Note Before the priority monitor scan lists can be programmed as follows, you must set up the 
channels to be included in these lists in the Zone screen as described in Section 6.4 on 
Page 6-10.

The Priority Scan List screen shown in Figure 8.14 sets up the Priority (Standard) Scan 
lists that can be programmed on each SMARTNET or SmartZone system. Each scan list 
can include up to 16 channels, one of which may be a priority channel. These channels 
must be from the same SMARTNET or SmartZone system: Channels from other systems 
are not allowed. 
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Figure 8.14 Priority Scan List screen

To display this screen, on the SMARTNET/SmartZone Per System screen, select Priority 
Scan List in the drop-down list and click the  button (see Figure 8.1). 

List Number - This drop-down list allows you to select the scan list to edit. Click the 
“Add” button to add a scan list and “Delete” to delete a scan list. 

 - Click this button to display the screen shown on the right above which is 
used to edit the selected scan list. Check the channels in each zone to be included in the 
selected scan list. Repeat for the other scan lists if applicable. 
Scan Mode - If priority scan is used on a list, select “Priority on Selected” (51xx/53xx 
only) or “Priority on Programmed” from the drop down list. If priority scanning is not 
used, select “Non Priority Scan”. If “Priority on Programmed” is selected, check the 
priority box of the desired priority channel. 

Note Priority talk group scanning must also be supported at the system level for it to occur as 
programmed. Talk Groups programmed as “Priority” in PC Configure must also be 
designated as Priority Monitor Groups by the System Control software.

8.2.9 System Alias / ID List (SmartZone Systems Only)

Sites in a SmartZone system are designated by a number. The Site List screen shown 
below allows you to program an alias for each site number that is displayed when using 
the Site Search feature.
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Figure 8.15 System Alias / ID screen 

To display this screen, from the SmartZone Per System screen, select Site List in the drop-
down list and then click the  button (see Figure 8.1). To add an alias, click the 

 button. To delete an alias, select it and click the Delete button. To edit an alias or 
ID, select it and make the desired changes.

Alias - Programs up to ten alphanumeric characters that identify the site.
ID - Site ID from 0-48. Up to 255 entries are supported with the 5300 Rev 6 logic 
board.

8.2.10 System Wide Preferred Site List (SmartZone Systems 
Only)13

You can program up to 16 Preferred Site Lists using the System Wide Preferred Site List 
screen shown in Figure 8.16. These lists can be associated with individual talk groups on 
the Talk Group List screen described starting on Page 8-12. This forces calls on a talk 
group to access specific sites. The preference for each site in a list can be set for Least, 
None, Preferred, or Always as follows.
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Figure 8.16 System Wide Preferred Site List 

Each list can be programmed with up to 16 sites. Therefore, the use of Preferred Site Lists 
allows up to 16 sites to be associated with a group instead of just 4 available on the Talk 
Group List screen. In addition, if several talk groups are associated with the same sites, a 
list can simply be selected instead of separate sites.

Site Lists - This drop down list selects the list to be edited. To add a new list, click the 
“Add” button. To delete the selected list, click the “Delete” button.
Sites In List - To add/delete a site from the list, click the checkbox.
Site ID - Enter the site ID from 0-255. Thirty-two (32) lists are available.
Preference - Select the site preference in the drop down list. A default weighting is 
usually assigned to these preference levels which results in the most preference given to 
“Always” and the least preference to “Least” as follows:
1 Always (preferred)
2 Preferred
3 None (no preference)
4 Least (preferred)

8.2.11 STAR List (Smart Zone Only)

The STAR List is used to create a list of control channels for each separate zone. This 
function is not used at this time.

8.2.12 Other Band Trunking List (VHF/UHF Only)

The Other Band Trunking screen shown above is displayed only when programming 
channels in the VHF and UHF frequency bands. It is used to define the relationship 
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between transmit and receive channel frequencies in these bands. With 800 MHz systems, 
this is not required because the difference between transmit and receive frequency is 
always 45 MHz.

Figure 8.17 Other Band Trunking screen 

To display this screen, on the SMARTNET/SmartZone Per System screen, select the 
Other Band Trunking in the drop-down list and click the  button (see Figure 
8.1).

This screen organizes the available frequency band into three sub-bands, called splits. 
Each split is defined by a start frequency, stop frequency, and channel spacing as follows. 
Frequencies outside the defined split cannot be accessed by the radio. These frequency 
splits must be defined the same way they are defined for the trunking controller.

Tx and Rx Spacing - Spacing in kHz between each potential transmit and receive 
frequency.
Tx and Rx Start Frequency - Start in MHz of the band split for transmit and receive 
frequencies.

Tx and Rx Stop Frequency - Stop in MHz of the band split for transmit and receive 
frequencies.

8.2.13 User Group ID List11

This User Group ID List screen shown in Figure 8.18 allows you to program aliases that 
can be displayed if a call is received on a talk group ID within the programmed block. For 
example, with the preceding screen, if a group call is received on group IDs 234-264, the 
alias “Fire” can be displayed. The display of this alias is controlled by the “User Group 
ID” parameter on the Radio Wide screen.
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Figure 8.18 User Group ID List screen

8.2.14 Rebanded CC List

This Control Channels list is the control channels for sites that have been rebanded.

Figure 8.19 Control Channels (rebanded system list) screen 
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S E C T I O N 7

Chapter 9Project 25 Trunked Systems

Two screens contain the interface where you program individual Project 25 trunked 
system parameters. This section contains descriptions of the parameters that you find on 
these screens. You can program these parameters after you set-up the desired systems as 
described in Section 1.10. 

There are also Project 25 radio wide system parameters that you program at the Radio 
Wide screen described in Section 5.6. 

Note You can edit some Project 25 trunking parameters only if PC Configure detects the proper 
system key. PC Configure detects a key if a yellow key icon is indicated as shown in 
Figure 8.1. If there is a red “X” through this icon, PC Configure does not detect a key. 
Refer to Section 13 for more information.

Some parameters described in this section apply only to certain revision levels. In this 
section, index numbers in superscript appear next to the names of such features (for 
example, “Example Feature9”). Table 1.1 shows the relationship between these numbers 
and the revision levels they represent.

9.1 Project 25 Trunked System Parameters: Initial Screen
Figure 9.1 shows the initial Project 25 trunked system programming screen.
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Figure 9.1 Initial Project 25 Trunked System Screen

The parameters in the initial Project 25 trunked system programming screen are as 
follows:

IDs

Note You can enter these IDs in either decimal or hexadecimal format as described in Section 
1.9.4.

System ID - This pull-down menu allows you to select the radio’s home system ID. 
This must be a unique ID within a Wide Area Communications Network (WACN). This 
ID comes from the system key in the Keys folder. (Refer to the related Note at beginning 
of this section.) System ID numbers can be 1 through 4094 (001 through FFE hex). If 
PC Configure does not detect a valid system key, you can only select the default ID of 
“1”. 
WACN - This ID determines the home Wide Area Communications Network the radio 
is assigned to. One or more systems make up a WACN. Valid WACN IDs are 1 through 
1048574 (00001 through FFFFE hex).
Site - Specifies the home site of the radio. If the Zone Fail Site Lock feature is enabled, 
this also determines the site the radio is restricted to if the zone controller goes down. 
(Zone Fail Site Lock is disabled by default in the subscriber units. It is enabled by 
setting the Zone Fail Site Lock option in PCIssue.)

RFSS - Specifies the default RF subsystem [RFSS (zone controller)], or the RFSS that 
the radio is restricted to if you enabled the SmartZone coverage option. One or more RF 
Subsystems make up a system. Valid IDs are 0 through 254.
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Unit - Provides a unique identification of the radio on a system. Therefore, each radio 
must have a different Unit ID. Valid Unit IDs are 1 through 16,777,215 (000001 
through FFFFFF hex). The decimal version of this ID is the private call ID of the radio.

Keys - Programs the following encryption key ID (hardware location) that the radio uses 
for all calls except group calls.

Failsoft - Key used in failsoft conditions.
Patch - Key used in patch calls.
Private Call - Key used for unit-to-unit (private) calls.
Interconnect - Key used for telephone calls.
Dynamic Talk Group - Key used for dynamic talk groups.

System Lists - Refer to Section 9.3 for more information.

Emergency

Emergency Alarm
Disabled - The radio sends no emergency signal when the user presses the 
Emergency option switch.
Normal - The radio sends an emergency alarm when the user presses the Emergency 
switch. If you disabled emergency calls, the alarm always occurs on the selected 
group. If you enabled emergency calls, it occurs—in order of preference—on the 
emergency group, selected group, and announcement group. When radio sends an 
emergency signal, the red transmit indicator lights, an emergency tone sounds, and 
“EMERGNCY” flashes in the display. “EMERGNCY” and the initiating ID 
continue to flash alternately until power is cycled, or the radio user presses and holds 
the Emergency switch.1

Silent - Same as Normal except none of the preceding audio or visual indications 
occurs. 

Emergency Call
Enable - When you check this box, if the radio user presses the Emergency option 
switch and then the PTT switch, an emergency group call transmits on the 
emergency group. The radio user cancels the emergency mode by cycling power or 
pressing and holding1 the emergency switch.
Disable - When you do not check this box, no emergency group call is authorized.

Emergency Hot Mic

Enable - When you check this box and the radio user sends an emergency alarm by 
pressing the Emergency switch, automatic transmitting occurs. The microphone 
audio is unmuted (without user intervention) for the time specified by the following 
Emergency Hot Mic Time. If you do not check this or if you do not select either 
emergency call, automatic transmissions do not occur. This feature initiates only by 
the first press of the Emergency switch. Subsequent presses do not trigger automatic 
transmissions. This function resets if the radio user changes the channel. 
Disable - If you do not check this box, automatic transmissions do not occur.

Emergency Hot Mic Time - Specifies the time period during which transmissions 
occur. You can select time periods of 10 through 120 seconds in ten-second increments.
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Emergency Retry Counter - If you check Inf (infinite), the radio system repeats 
emergency calls until they are acknowledged or canceled. If you do not check it, the 
radio system repeats these calls only the specified number of times.
No Rx Activity During Emergency12 - When you check this box, the following radio 
receive indications do not display in the emergency mode: Receive audio, receive LED, 
and receive icons. 

Time/Timers

Time-Out Timer - This timer determines the maximum time period of a continuous 
transmission. You can program it for 15 through 225 seconds in 15-second intervals, or 
you can disable it (0).
RFSS Response Time - Specifies the time between attempts to affiliate on RFSS sites. 
You can program times of 625 through 7000 ms. The default is 625 ms.
Force Unmute Time - Specifies the maximum time the radio remains muted after 
transmitting because of probable system delay. If the radio determines that the 
incoming audio signal is from some other radio, the radio disregards this delay. You can 
program times of 25 to 6375 ms. The default is 1200 ms.
PTT Warning Time - Specifies the time the radio waits before sounding the PTT 
Prohibit tone. This tone warns the user that the PTT request is being processed and the 
user should release the PTT switch. You can program times of 25 through 6375 ms. The 
default is 4000 ms.
Busy Update Timer - Specifies the time the radio waits in a busy state for a reject, 
grant, or another busy update from the radio system. When this timer expires, the radio 
no longer expects a response from the system and the ratio tries the transmission again. 
You can program times of 15 through 945 seconds. The default is 30 seconds.
Resp. Pending Timer - Specifies the time the radio waits when it expects a further 
response from the radio system to a request. This occurs when the system sends a 
response that indicates the request is being processed and a response is coming. When 
this timer expires, the radio no longer expects a response and the radio returns to the 
idle state. You can program times of 1 through 255 seconds or infinity. The default is 6 
seconds.
ISP Sequence Length - Specifies the time the radio system allows each site for an ISP 
retry request. The radio retries until this timer expires. The radio makes at least five 
retries, regardless of this timer setting. You can program times of 1 through 255 
seconds or infinity. The default is 5 seconds.
Quick Fade Protect - Specifies the time the radio will stay on the control channel when 
it loses synchronization before the radio tries to synchronize again. This allows 
recovery without completely synchronizing the channel again. You can program times 
of 200 through 6575 ms. The default is 2000 ms.
Scan Hold Time - Specifies the delay that occurs after the radio no longer receives a 
message before scanning resumes. You can program times of 2 through 10 seconds. 
The default is 3 seconds.

Other

Talk Permit Tone - If you check this, a short tone sounds after the main controller 
approves a request for a group call. This indicates that speaking can begin. If you do not 
check this, the radio user hears no audio signal to indicate when speaking can begin.
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Radio Inhibit - If you check this, the dispatcher can disable or enable the radio. When 
the radio receives this command, the radio sends an acknowledgment to the dispatcher. 
Then, the radio is disabled as follows. 

• Receive audio is muted and transmit audio is disabled.

• All radio controls are inoperative.

• Scanning is disabled on the selected mode (Project 25 trunking).

• The transmit indicator is disabled and the display is blanked.

The dispatcher can then enable the radio again. As an alternative, you can enable the 
radio again by reading and then rewriting the programming data using PC Configure.

Radio Check - If you check this, the radio will respond to a remote check command. 
The dispatcher can send this command to confirm that the radio is active and 
operational on the system. If you do not check this, this command is ignored.
SmartZone Coverage Type - If you check this, roaming can occur only within the 
selected RFSS controller. If you do not check this, roaming can occur across all 
available RFSS controllers in the WACN system.
Conversation Type

Message Trunking - Not available with Project 25 trunking.
PTT - ID - Always select this mode with Project 25 trunking. The radio can key 
during the programmed hang time and continue the conversation on the active 
channel. If a user keys during the hang time, reaffiliation with the system occurs 
before using the voice channel. The radio holds the voice channel while this 
reaffiliation occurs. The call then connects to the open voice channel. This results in 
all traffic being logged, even from the radios which transmit during the hang time.
Transmission Trunking - Not available with Project 25 trunking.

Status Aliasing - Enables and disables status aliasing for the system. This function 
allows you to customize status numbers and allows you to assign an alias name to each 
number. 
Dynamic Regrouping - If you check this, you can program a dynamic regrouping 
channel. This is a Project 25 trunked channel that has the talk group dynamically set by 
the dispatcher. Select it on the zone screen. Refer to Section 6.5.
Default RCM Address - Specifies the Radio Control Manager used as the target 
address of Inbound Signaling Packet (ISP) transmissions such as status and message 
transmissions. You can program hexadecimal addresses from 000000 to FFFFFF. The 
default is FFFFFC.

Private Call Usage 
Disabled - The radio user cannot place private calls or receive them.
Response Only - The radio user can receive private calls but cannot place them.
List Only - The radio user can place private calls and receive them. The user can 
recall numbers from a programmed list only.

Note To enter the following mode, the radio user must press the phone key and hold it until a 
tone sounds.
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Unlimited - The radio user can place private calls and receive them. The user can 
recall numbers from a programmed list or dial them from the keypad. 53xx radios 
support this mode only when they use the HHC control unit (firmware Version 1.28/
2.6/3.6/4.2 or later only). Standard 53xx front and remote models do not support 
number dialing. 

Phone Interconnect Usage12 - Programs operation of telephone calls same as the 
preceding Private Call Usage.
Call Alert Usage - Programs operation of call alert calls (pages) the same as the 
preceding Private Call Usage.
Transmit Power - Fixes the system’s transmit power at the high or low level, or makes 
it selectable. If it is selectable, the radio must have a high/low power function switch.

RSSI Threshold (SmartZone Only) - Sets the Receive Signal Strength Indicator 
(RSSI) levels that determine when searching for and switching to another site occurs.
System Modulation - Reserved for future use. 

Disable Site Trunking Operation - The radio will go “Out of Range” if the site is in 
“Site Trunking”.
Inactivity Auto-Reaffiliation - If you check this, the radio attempts reaffiliation on the 
system if the radio has had no activity for the time period programmed by the Auto-
Reaffiliation Timer.
Auto-Reaffiliation Timer - This parameter specifies the time the radio waits with no 
activity to attempt reaffiliation on the system.

9.2 Project 25 Trunked System Parameters: Second Screen
You open and close a second Project 25 trunked system programming screen when you 
click the  buttons in the upper right corner of the screen. Figure 9.2 shows the 
parameters that display on this second screen.
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Figure 9.2 Second Project 25 Trunked System Screen

Note To select OTAR and the data parameters that follow, you must select SLN/CKR Mode key 
management on the second Global screen. Refer to Section 4.2.

Clicking the  button displays the screen shown in Figure 9.3. This screen is 
the interface where you program various OTAR and Project 25 data parameters.

Figure 9.3 OTAR and Data Settings screen.

OTAR

OTAR Enabled - Select “On” to enable OTAR. Select “Off” to disable this feature.
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Rekey Request Time Out - When the radio initiates rekeying (that is, when it sends an 
OTAR rekey request message), this setting determines how long the radio waits for a 
response from the Key Management Facility (KMF). You can program times of 20 
through 180 seconds.
Rx Security Level

Enhanced - The radio accepts only encrypted and authenticated KMMs from the 
KMF (except for warm-start, which is authenticated only).
Basic - The radio accepts any KMM that is in a format allowed by the OTAR 
standard. 

Tx Security Level
Enhanced - All OTAR procedures originating from the radio are encrypted and 
authenticated. If they cannot be encrypted and authenticated, the radio does not send 
the KMM. 
Basic - The radio always sends unencrypted KMMs if the OTAR standard allows 
them to be unencrypted and unauthenticated. 

Registration Inactivity Timer - If the radio has not registered any OTAR activity 
within the time period set by this timer (in hours), the radio attempts to re-register with 
the KMF.
Originating Response Kind - Selects if a response is required from the KMF to 
outgoing messages. 

Kind 1-Unconfirmed - Requests no response. 
Kind 3-Confirmed - Requests immediate response.

Registration Number of Attempts - Specifies the maximum number of times that the 
radio tries to complete a successful OTAR registration.
Registration Time Between Attempts - Specifies the time in seconds that the radio 
waits after an unsuccessful OTAR registration attempt before it tries to register again. 
This time period should be greater than the Data/SNDCP > Response Timer below.
KMF IP Address - The KMF’s IP address.
KMF UDP Port - The UDP port that the radio uses when it sends Key Management 
Messages (KMMs) to the KMF. The default value is 64414.
Subscriber OTAR UDP Port - The UDP port that the radio uses for OTAR. The 
default value is 64414.

Data/SNDCP (Simple Network Data Control Protocol)

CAI Data Max Tx Attempts - Selects the maximum number of times the radio 
attempts to send a CAI data packet. Attempts to send the data packet continue until the 
radio receives an acknowledgment confirming the successful receipt of the packet, or 
until the radio exceeds the selected amount of transmit attempts.
Response Timer - Selects the period of time the radio waits for an acknowledgment 
that a CAI transmission is successful before it tries the transmission again.
SNDCP Activation Wait Timer - Controls the time that a radio waits for the KMF to 
respond to a SNDCP context activation request.
SNDCP Dwell Timer - Controls the dwell time.
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Rx Voice Interrupts Data - When checked, a voice call can interrupt data. 
Subscriber IP Address - Not used.
Mobile Computer IP Address - Not used.

Customized Roaming Properties (P25 Only) - You can customize SmartZone and 
Project 25 Trunked roaming properties by clicking the  button. The screen shown 
in Figure 9.4 is displayed. Information programmed in this screen is described in the 
Roaming Properties Notes window. The RSSI Filter slider bar controls how quickly the 
radio reacts to dropouts in the RSSI level. The more aggressive the setting, the quicker site 
switching occurs. 

Figure 9.4 SmartZone Customized Roaming Properties screen (SmartZone/Project 25 Trunked 
Only)

9.3 Project 25 Trunked System Lists
Select the various Project 25 trunking lists by the “System Lists” pull-down menu on the 
Project 25 Trunking Per System screen. Refer to Figure 9.1. After you select the desired 
list, you can edit it by clicking the  button. 

This section contains descriptions of the following lists:

• Channel identifiers list
• Control channels list
• Status alias list
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• Call list
• Phone list
• P25 Trunking talk groups list
• P25 Trunking announcement groups list
• Site list
• Priority scan list
• System wide preferred site list
• User group ID list
• Rebanded CC list
Descriptions of the various lists and the information they program follow.

9.3.1 Channel Identifiers List

The Channel Identifiers list screen shown in Figure 9.5 displays only when programming 
channels in the VHF, UHF, and 700/800 MHz frequency bands (Other Band Trunking). 
Both Explicit1 and Implicit addressing is available. 

Note The system manager provides Channel ID and Control Channel information. This 
information must match the programming assigned to other subscriber units for it to 
function properly on the system. 

Figure 9.5 Channel Identifiers List Screen

With Implicit Addressing, the control channel sends only the receive frequency. 
Information in this table determines the transmit frequency. With Explicit Addressing, the 
control channel sends both the receive and transmit frequencies. Both types reference 
information in this table. 800 MHz systems do not require this table because the difference 
between transmit and receive frequency is always 45 MHz. 
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9.3.2 Control Channels List

The Control Channels list screen shown in Figure 9.6 allows the system manager to view 
and edit the control channels. Each Project 25 trunking system can have a maximum of 
255 control channels. Only one control channel is active at a time. 

To display this screen, on the Project 25 Trunking System screen, select “Control Channel 
List” in the pull-down menu, then click the  button. Refer to Figure 9.1. 

Figure 9.6 Control Channels List Screen

To add a channel, click the Add button. To delete a channel, simply select it and click the 
Delete button. To edit a channel, select the digits that you want to change and edit them as 
desired. For the 800 MHz band, you can change only the receive channel frequency. PC 
Configure automatically calculates the transmit frequency (45 MHz below the receive 
frequency). These are the mobile frequencies, not the repeater frequencies. Only multiples 
of 5 kHz and 6.25 kHz are valid.

9.3.3 Status Alias List

The Status Alias list screen shown in Figure 9.7 is the interface where you program the 
alias for each of a maximum of eight status conditions. The system manager defines 
meaning of each status number.
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Figure 9.7 Status Alias List screen

To display this screen, on the Project 25 Trunking Per System screen, select  
“Status Alias List” in the pull-down menu, then click the  button. Refer to 
Figure 9.1. 

To add an alias, click the Add button. To delete an alias, simply select it and click the 
Delete button. To edit an alias, select it and change it as desired. You can enter a 
maximum of 10 characters. This identification displays when the user selects a status 
condition.

9.3.4 Phone List

The Phone list screen shown in Figure 9.8 programs the telephone number list that the 
radio user may place telephone calls from (if you program the system to use this feature). 
You can program a maximum of 255 numbers. To display this screen, on the SMARTNET 
and SmartZone Per System screen, select “Phone List” in the pull-down menu, then click 
the  button. Refer to Figure 9.1. 
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Figure 9.8 Phone List screen

To add a call, click the Add button. To delete a call, simply select it and click the Delete 
button. To edit an alias or number, select it and enter the desired information as follows

Alias - You can enter a maximum of ten characters to identify the number being called. 
This identification displays when the user selects the number to be called from the list. 
You can enter only capital letters, so PC Configure automatically converts any 
lowercase letters that you enter to capital letters.
ID - This is the telephone number that the radio dials when the radio user selects the 
location. Enter the 3-digit area code and 7-digit telephone number using the numbers 0 
through 9. 

9.3.5 Call Alias / ID List

The Call Alias / ID list screen shown in Figure 9.9 is the interface where you program the 
list of IDs used for unit calls. You can program a maximum of 255 IDs. To display this 
screen, on the Project 25 Trunking Per System screen, select “Call List” in the pull-down 
menu, then click the  button. Refer to Figure 9.1. 
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Figure 9.9 Call Alias / ID List Screen

To add a call, click the Add button. To delete a call, simply select it and click the Delete 
button. To edit an Alias or ID, select it and enter the desired information as follows:

Alias - You can enter a maximum of ten characters to identify the user being called. 
This identification displays when the user selects the mobile radio to be called from the 
list. When the user receives a call from a unit in this list, the alias of the unit displays for 
the user instead of the calling unit’s ID number. You can enter only capital letters, so 
PC Configure automatically converts any lowercase letters that you enter to capital 
letters.
ID - This is the ID of the radio that the user is calling. Valid entries are 1 through 
16,777,215. PC Configure detects zero (“0”) as no entry. 

9.3.6 P25 Trunking Talk Groups List

The P25 Trunking Talk Groups list screen shown in Figure 9.10 sets up Project 25 
Trunking talk groups. It is the interface at which you program unique talk group 
information. To display this screen, on the Project 25 Trunking Per System screen, select 
the “Talk Group List” pull-down menu, then click the  button. Refer to Figure 
9.1.
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Figure 9.10 P25 Trunking Talk Groups screen

The parameters programmed in this screen are as follows: 

ID - This list displays the talk group IDs contained in the Talk Group list. To edit a talk 
group ID in this list, select it and then change it in the Selected Group box. This is the 
actual ID of the talk group. You assign talk groups to channels in the Zone screen. Refer 
to Figure 6.6. 

Note You can enter this ID in either the decimal or hexadecimal format as described in Section 
1.9.4.

Add - Click this button to add the next available talk group ID to the list. You can program 
each Project 25 trunking system with up to 255 talk groups.

Add Mode - To add an entire block of talk group IDs or a specific ID, click the arrow 
button  in the lower right corner of the screen. The P25 Trunking Talk Group screen is 
expanded and the Add Mode panel shown in Figure 9.11 is displayed:
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Figure 9.11 Add Mode Screen

Add Mode Pull-Down 
Single - Adds the next available ID similar to the Add button. 
Multiple - Adds a block of IDs as follows: To initiate the selected add operation, 
click the Add button. If the specified ID range results in duplicate IDs, an error 
message displays and PC Configure adds no IDs.

Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be added.
ID Step - Specifies if consecutive IDs are added or some other step rate is used. 
For example, if Start ID =10, ID Count = 5, and ID Step = 10, the IDs added are 
10, 20, 30, 40 and 50. 

Use Selected Group’s Security - When selected, PC Configure automatically 
programs the added groups with the Strapping Mode and Encryption Key ID of the 
selected group.

 - Clicking this button deletes the selected talk group.

Security Parameters

Strapping Mode 
Clear - All transmissions on the talk group occur in the clear (unencrypted) mode. 
Secure - All transmissions on the talk group occur in the secure (encrypted) mode 
selected as follows.
Selectable - The radio user select the clear or secure status of the talk group is with 
the Clear/Secure option switch.

Encryption Key ID - Selects the location from 0 to 15 (PID/ASN mode) or 1 to 16 
(SLN/CKR mode) of the key used for secure calls on the group if applicable.

Use System Preferred Site List13 - Selects one of the preferred sites for the talk group. 
Refer to the Preferred Sites description which follows for more information.

Failsoft Frequencies

Failsoft Enable - If you check this box, you enable a failsoft channel on the talk group 
if a controller or other major failure occurs. If you do not check this box, the radio does 
not enter the failsoft mode if a failure occurs.
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Tx (MHz) - Programs the failsoft transmit frequency if you checked Failsoft Enable.
Rx (MHz) - Programs the failsoft receive frequency if you checked Failsoft Enable.

Talk Group Specific Preferred Sites

With Project 25 trunked systems, you can associate a maximum of four preferred sites. 
You can also associate a preferred site list4 with each talk group. This forces a call on the 
talk group to access the specified sites. The system manager can then keep mobiles on 
specific sites even if you do not enable the Site Search feature. You can program the 
preference for each site as “Least”, “None”, “Preferred”, or “Always” as follows.

You program the preferred site lists at the System Wide Preferred Site List screen 
described on Section 9.3.10. You can program a maximum of 16 lists. Each list can 
include a maximum of 16 sites. 

If you associate a talk group with both a preferred site list and one or more preferred sites, 
the radio searches the preferred sites first. The first entry found for a given site is used. If 
the same site is in both lists, the entry in the list at the bottom of the screen is used first.

Selected Site
RFSS ID- Designates a zone controller that the talk group can roam to.
Site ID - Designates a site that the talk group can roam to.
Preference - “Least”, “None” (no preference), “Preferred”, or “Always (preferred) 
is a weighting for steering to different sites.

Wide Area System Scan Preference - If the radio does not register on the system, it 
begins scanning to the last valid preference site on which it was registered.

9.3.7 P25 Trunking Announcement Groups List

The P25 Trunking Announcement Groups list screen shown in Figure 9.12 sets up Project 
25 Trunking announcement groups that communicate with several talk groups 
simultaneously. Each announcement group can have a maximum of 15 talk groups. 
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Figure 9.12 P25 Trunking Announcement Groups screen

To display this screen, on the Project 25 Trunking Per System screen, select the 
“Announcement Group List” in the pull-down menu, then click the  button. 
Refer to Figure 9.1. 

Group ID - This list displays the announcement group IDs contained in the announcement 
group list. To edit an ID in this list, select it and then change it in the Selected Group box. 
This is the actual ID of the announcement group. You assign announcement groups to 
channels in the Zone screen. Refer to Section 6.5. 

Note You can enter these IDs in either decimal or hexadecimal format as described in Section 
1.9.4.

 - Clicking this button adds the next available announcement group ID to the list. 
You can program each Project 25 Trunked system with a maximum of 255 announcement 
groups.

To add an entire block of announcement group IDs or a specific ID, click the arrow button 
 in the lower right corner of the screen. The Add Mode screen shown in Figure 9.11 

then displays.

Figure 9.13 Add Mode Screen

Add Mode Pull-Down list
Single - Adds the next available ID similar to the Add button.
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Multiple - Adds a block of IDs as follows: To initiate the selected add operation, 
click the Add button. If the specified ID range results in duplicate IDs, an error 
message displays and PC Configure adds no IDs.

Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be added.
ID Step - Specifies if consecutive IDs are added or some other step rate is used. 
For example, if Start ID =10, ID Count = 5, and ID Step = 10, the IDs added are 
10, 20, 30, 40 and 50. 

Use Selected Group’s Security - When selected, PC Configure automatically 
programs the added groups with the Strapping Mode and Encryption Key ID of the 
selected group.

 - Clicking this button deletes the selected announcement group.

Security

Strapping Mode 
Strapped Clear - All transmissions on the talk group occur in the clear 
(unencrypted) mode. 
Strapped Secure - All transmissions on the talk group occur in the secure 
(encrypted) mode selected as follows.
Switched - The clear or secure status of the talk group is selected by the Clear/
Secure option switch.

Security Type - Select SecureNet or Scrambling (if programmed).

Note Voice encryption is an optional feature that requires factory programming and possibly 
special hardware.

SecureNet - Selects the Motorola SecureNet DES type of secure communication 
when you select either the coded or switched strapping mode. 

Tx DES/DES-XL
With analog channels, when you select “Securenet” secure communication, you 
select either the DES or DES-XL type. DES-XL is available only in later models 
equipped with the UCM module. 
On digital channels, you cannot select the type. Digital channels support both DES-
OFB and AES encryption. The encryption key that the talk group selects determines 
the encryption type. 

Note AES encryption is not available with the 51SL or 53SL.

Key PID - Selects the location from 0-15 (PID/ASN mode) or 1-16 (SLN/CKR mode) 
of the key used for secure calls on the group if applicable.

Rx Auto Detect

Secure - If this option is checked, an encrypted signal is automatically detected and 
received. This option may increase the response time to incoming signals. If it is not 
checked, those signals are detected only if they are coded like the transmit signals.
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Proper Key - If this option is checked, the radio will search the available encryption 
keys until it finds a match for the current transmission.

Talk Group List - Select the talk groups that are included in each announcement group. 
You can enter this ID in either decimal or hexadecimal format as described in Section 
1.9.4.

9.3.8 Priority Scan List

Note Before you can program the priority monitor scan lists, you must set up the channels that 
you want to include in these lists. You program them in the screen shown in Figure 6.6.

The Priority Scan List screen shown in Figure 9.14 sets up the Priority (Standard) Scan 
lists that you can program on each Project 25 Trunking system. Each scan list can include 
up to 16 channels, one of which may be a priority channel. These channels must be from 
the same Project 25 Trunking system. You cannot program channels from other systems. 
You can program as many lists as can be stored in the available memory.

Figure 9.14 Priority Scan List Screen

To display this screen, on the Project 25 Trunking Per System screen, select “Priority 
Scan List” in the pull-down menu and then click the  button (see Figure 9.1). 

List Number - This pull-down menu is the interface where you select the scan list to edit. 
Click the Add button to add a scan list. Click the Delete button to delete a scan list. 

 - Click this button to display the screen shown in Figure 9.14. This screen is the 
interface where you edit the selected scan list. Check the channels in each zone that you 
want to include in the selected scan list. Repeat for the other scan lists if applicable. 

Scan Mode - To use priority scan on a list, select “Priority on Selected” (51xx/53xx only) 
or “Priority on Programmed” from the pull-down menu. If you select “Priority on 
Programmed”, check the box of the desired priority channel. If you do not want to use 
priority scan, select “Non Priority Scan”. 
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Note To use Priority talk group scanning, your system must support it for it to occur as 
programmed. You must designate talk groups programmed as “Priority” as Priority 
Monitor Groups by the System Control software.

9.3.9 Site Alias / ID List

Sites in a Project 25 Trunking system are designated by a site number and an RF 
subsystem (RFSS) number. The Site Alias / ID list screen shown in Figure 9.15 is the 
interface where you can program an alias for each site that displays when using the Site 
Search feature. 

Figure 9.15 Site Alias / ID screen

To display the preceding screen, on the Project 25 Trunking Per System screen, select  
“Site List” in the drop-down list and then click the  button. Refer to Figure 9.1.

To add an alias, click the  button to display the Add Alias/ID screen. To delete an 
alias, simply select it and click the Delete button. To edit an alias or ID, simply select it 
and make the desired changes. 

Alias - Programs up to 10 alphanumeric characters that identify the site. 
Site ID - Values can be from 0 through 48. 

9.3.10 System Wide Preferred Site List

The System Wide Preferred Site List screen shown in Figure 9.16 is the interface where 
you program up to 16 preferred site lists. You can associate these lists with individual talk 
groups on the P25 Trunking Talk Groups list screen shown in Figure 9.10. This forces 
calls on a talk group to access specific sites. You set the preference for each site in a list as 
“Least”, “None”, “Preferred”, or “Always” as follows:
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Figure 9.16 System Wide Preferred Site List Screen

You can program each list with a maximum of 16 sites. Therefore, using preferred site lists 
allows you to associate a group with a maximum of 16 sites, rather than just 4 sites as 
available through the P25 Trunking Talk Groups list screen. Also, if you associate 
several talk groups with the same sites, you can simply select a list instead of separate 
sites. 

Site Lists - This pull-down menu is the interface where you select the list that you want to 
edit. To add a new list, click the Add button. To delete the selected list, click the Delete 
button.

Sites In List - To add or delete a site from the list, click its check box.

Site ID - Enter the site ID from 0 through 48.

Preference - Select the site preference from the pull-down menu. A default weighting is 
usually assigned to these preference levels. This results in the most preference given to 
“Always” and the least preference to “Least” as follows:

1 Always (always preferred)
2 Preferred
3 None (no preference)
4 Least (least preferred)

9.3.11 User Group ID List

This User Group ID List11 screen shown in Figure 9.17 is the interface where you 
program aliases that display if a radio user receives a call on a talk group ID within the 
programmed block. For example, in the screen shown in Figure 9.17, if a radio user 
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receives a group call from Group IDs 234 through 264, the alias “Fire” displays. The User 
Group ID parameter on the Radio Wide screen controls the display of this alias.

Figure 9.17  User Group ID List screen

9.3.12 Rebanded CC List

This Control Channels list is the control channels for sites that have been rebanded.

Figure 9.18 Control Channels (rebanded system list) screen 
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S E C T I O N

Chapter 10Password Description

This section contains the following information about passwords:

• Password enhancements
• Programming passwords
• Password description
• Zone password

10.1 Password Enhancements
5100 portables and 5300 mobiles have an enhanced password feature. You can assign 
more passwords. Also, more functions can be under password control. The following 
passwords replace the single Power-On password: 

• Four power-on (User x) passwords 
• Download and upload passwords
• Master password
These new enhanced password features require the following revised PC Configure and 
radio software:

PC Configure - Version 1.21.8 or later 

51xx Portable

Version 1.x Models - 1.12.1 or later
Version 2.x Models - 2.2.1 or later
Version 3.x Models - 3.2.1 or later

53xx Mobile

Version 1.x Models - 1.24.1 or later ARM
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Version 2.x Models - 2.2.1 or later
Version 3.x Models - 3.2.1 or later

Note Refer to Section 16 for more information on the preceding radio firmware versions. 

You can use PC Configure 1.21.2.8 or later to program the power-on password feature 
available with earlier versions of radio firmware. To program that feature in earlier radio 
models, you must use an earlier version of PC Configure. You program it using the  
Password at Power Up function on the Global screen.

Note You can use PC Configure 1.21.2.8 or later to program earlier radio models. However, 
any new features that require updated firmware will not be available.

10.2 Programming Passwords
With the latest versions of PC Configure, the Password at Power Up parameter is 
removed from the Global screen as described in Section 10.1. You program passwords 
using a password management screen displayed by the Tools > Password Management 
menu. Refer to Section 3.4. You must power-up the radio and connect the radio to the 
computer to display this screen.

PC Configure transfers password data and stores it in an encrypted format for security 
purposes. In addition, PC Configure never displays actual passwords. They are always 
indicated by eight asterisks (********). Therefore, you cannot use PC Configure to 
determine what passwords are in a radio.

Passwords must be 1-8 characters in length and consist of the numbers 0-9. Zeros are valid 
characters in any location, even as leading characters. Initially, all passwords are null 
(deleted) characters. Therefore, when you first program a password, you do not need to 
make an entry in the Original/Master Password box.

10.2.1 Lost Passwords

If you lose a password, you can change it using PC Configure by entering the master 
password, as Section 10.3.3 describes. If the master password is lost or was not used, you 
can erase all passwords using the PCTune software as follows:

1 With PCTune 1.1.1.0 or later, simply select Radio > Reset Passwords. Only password 
information is erased.

2 With earlier versions of PCTune, after starting the PCTune program, press <Shift> 
<Ctrl> <E> to toggle the following Erase EEPROM function. Otherwise, it is grayed 
and you cannot select it. Then select Radio > Erase EEPROM > Params Only. This 
erases all password and personality information, so you must then reprogram the radio. 

Do not select COMPLETE because that erases all information. Then, you must send 
the radio back to the factory to make it usable again.

CAUTION!
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10.2.2 Changing Password

A user can change an assigned password only if the Set User Password option button or 
menu parameter (51xx only) is programmed on the radio. Selecting this function displays 
prompts for entering and confirming a new password. 

Note With the 51xx portable and 53xx Handheld Control Unit (HHC), you should not use a 
number key for this function. This is because you exit the password mode if you press the 
assigned key when you enter a number.

10.2.3 Password Entry Procedure

When the radio prompts you to enter a password, perform the following procedure to enter 
it:

51xx Portable - With DTMF keypad models, enter each number using the keypad and 
press the <F2> key after you enter the last digit. With limited keypad models, enter each 
number by pressing the Up/Down switch and press the <F2> key after each digit.

53xx Mobile - Rotate and press the Select switch.

10.3 Password Description
This section contains descriptions of the following types of passwords:

• User (power-on) passwords
• Download/Upload passwords
• Master password

10.3.1 User (Power-On) Passwords

When you enable a user password, you must enter it each time you turn on the radio’s 
power. You can program a maximum of four different user passwords (User 1/User 2/User 
3/User 4). The same radio features are enabled for each. When you enter any user 
password at power up, you enable normal radio operation.
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10.3.2 Download/Upload Passwords

You can program separate download (write) and upload (read) passwords to prevent 
unauthorized downloading or uploading of radio programming parameters. Refer to 
Section 3.3. When you use either of these passwords, you must enter the proper password 
to perform the desired operation. You do not need a user password to upload or download 
parameters. 

10.3.3 Master Password

The master password overrides all the preceding passwords. The system administrator can 
use it as a “pass key” to a password-controlled function or to change a lost or 
unintentionally-changed password. Master passwords are set up and changed the same as 
the other passwords. It does not override the zone password described in Section 10.4.

10.4 Zone Password

Note The programming and use of the zone password has not changed. It is independent of the 
preceding passwords. You program it in the Zone > Edit Zones and Channels screen.

You can program a zone password for the 53xx mobile and 51xx portable. It prevents 
unauthorized reprogramming of zones by keypad programming. When you use this 
password, you must enter it before you can change system or channel parameters in that 
zone. You program the zone password in the Edit Zones and Channels screen. To display 
this screen, click the Edit Zone button on the Zone screen. Refer to Section 6.1.

You can program a different password for each zone. When you select a password-
protected zone, “PASSWORD” flashes the first time you try to select a system or channel 
parameter in that zone. You then enter each digit of the password as previously described. 
The password is always eight digits long. After you enter the eighth digit, you can program 
system and channel parameters for that zone normally.
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Chapter 1151xx Portable Keypad Programming

Note Keypad programming is permitted by United States federal government users only. It is 
not permitted by any user regulated by the United States Federal Communications 
Commission (FCC). Radios with ARM code 1.22.0 or later require that the Keypad 
Programming option be factory enabled to program this feature. Refer to Section 3.3.

Since only United States federal government users are permitted to use keypad 
programming, you can only program United States federal government models of this 
radio with this feature.

You can only use keypad programming if it has been enabled by factory programming and 
a conventional mode option switch or menu parameter is programmed for the Keypad 
Programming function. You then select it by simply pressing that switch or selecting that 
menu parameter. The keypad programming mode is indicated by “CHNG ZONE” and 

 in the display.

Keypad programming allows you to change conventional channel parameters such as the 
transmit and receive frequency, Call Guard squelch code, and encryption code. In 
addition, several conventional mode timers can be changed. You cannot use it to 
reprogram disabled channels or any Project 25 Trunked and SMARTNET/SmartZone 
information.

This section covers the following aspects of 51xx portable keypad programming:

• Menu description
• Zone change parameter
• Channel change parameter
• System parameters
• Channel parameters
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11.1 Menu Description
51xx portable keypad programming uses a menu system to let you select the parameters 
you want to change in the keypad programming mode. Figure 11.1 is a flowchart that 
shows the keypad programming mode menu structure. When you select the keypad 
programming mode by the Keypad Programming option button or menu parameter, the 
first menu parameter “CHNG ZONE” displays as just described. Press the Up/Down 
switch to scroll through the following parameters: 

• CHNG ZONE (Section 11.2)
• CHNG CHAN (Section 11.3)
• SYS PARMS (Section 11.4)
• CHAN PARMS (Section 11.5)
Press the <F2> (Select) key to select a highlighted parameter, and press the <F1> key from 
one of the main menus to exit keypad programming. When you press the <F1> key in the 
other menus, you return to the previous menu. You also use the Up/Down switch in 
several menus to scroll through available selections. The following sections describe these 
parameters.
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Figure 11.1 51xx Keypad Programming Menu Flowchart

11.2 Zone Change Parameter
The “CHNG ZONE” menu parameter selects the zone containing the conventional 
channel that you want to reprogram. It does not change the zone selected for normal 
operation. 

Press the <F2> key to select the “ZONE CHG” parameter and then scroll through the 
programmed zones by pressing the Up/Down switch. When the desired zone displays, 
select it by pressing the <F2> key.

11.3 Channel Change Parameter
The “CHNG CHAN” menu parameter selects the conventional channel to be 
reprogrammed. You cannot select disabled channels or Project 25 Trunked/SMARTNET/
SmartZone channels. This does not change the channel selected for normal operation. 
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Press the Select switch to select the “CHNG CHAN” parameter and then scroll through the 
programmed channels by pressing the Up/Down switch. When the desired channel 
appears, select it by pressing <F2> key.

11.4 System Parameters

Note If “PASSWORD” displays briefly when you try to select one of the following parameters, 
you must enter the zone password before you can make any changes. Refer to Section 10.4 
for more information.

The “SYS PARMS” menu parameter lets you select the conventional mode timer that you 
want to reprogram from among the following. Press the <F2> key to select the 
“SYS PARMS” parameter, then press the Up/Down switch to display the desired 
parameter. Press the <F2> key again to select it.

SCAN TIMER - Selects the Scan Hold timer. Press the Up/Down switch to decrement 
or increment the timer in 0.5-second steps from 0-7.5 or set it to 0 seconds to disable it. 
When the desired value appears, store it by pressing the <F2> key.
TX TIMER - Selects the transmit time-out timer. Press the Up/Down switch to 
decrement or increment the timer in 15-second steps from 0-225 or disable it by 
selecting 0 seconds. When the desired value appears, store it by pressing the <F2> key.
PEN TIMER - Selects the penalty timer. Press the Up/Down switch to decrement or 
increment the timer in 15-second steps from 0-225 or disable it by selecting 0 seconds. 
When the desired value appears, store it by pressing the <F2> key.
CONV TIMER - Selects the conversation timer. Press the Up/Down switch to 
decrement or increment the timer in 30-second steps form 0-450 or disable it by 
selecting 0 seconds. When the desired value appears, store it by pressing the <F2> key.

11.5 Channel Parameters

Note If “PASSWORD” displays briefly when you try to select one of the following parameters, 
you must enter the zone password before you can make any changes. Refer to Section 10.4 
for more information.

The “CHAN PARMS” menu parameter selects the following conventional channel 
parameters that you can reprogram. Press the <F2> key to select the “CHAN PARMS” 
parameter, then press the Up/Down switch to display the desired parameter. Next, press 
the <F2> key to select it. The squelch control parameters are unique to the type of 
conventional channel selected (analog or Project 25). 

Note If you select a mixed-mode channel, you can program both the RX CODE (analog) and 
RX NAC (Project 25) parameters that are described below. Also, if the Transmit Type is 
analog, a TX CODE is programmed. If the Transmit Type is Digital (Project 25), a TX 
NAC is programmed.
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TX FREQ - Programs the transmit channel frequency. The digits that you change begin 
to flash. Press the Up/Down switch to select the desired number for that digit. Then, 
press the <F2> key to move to the next digit. If you try to enter an invalid frequency, a 
beep sounds, “INVALID” displays briefly, and you must reenter the number. 
RX FREQ - Programs the transmit frequency the same as RX FREQ above.
SQ ADJ (analog only) - Changes the preset squelch setting on that channel. “0” is the 
default setting. You can select values from –7 to +7. Increasing this setting toward +7 
causes the squelch to open sooner so you can receive weaker signals. Decreasing it 
toward –7 causes the opposite to occur.

Note The channel spacing is not set with Project 25 channels because it is always narrow. You 
cannot change the squelch because the setting is critical for proper receiver operation.

CHAN SPC (analog only) - Selects either wide or narrow band channel spacing on 
analog channels only. Press the Up/Down switch to select “WIDE” or “NARROW”. 
When the desired setting displays, store it by pressing the <F2> key.

Note You program the next two parameters only if the radio is programmed for encryption.

Key Select* - Selects the encryption key for the channel if applicable. The key storage 
location of 0-15 (PID) or 1-16 (SLN) is selected. Refer to Section 4.2. If no keys are 
programmed, “No Keys” appears. Requires code 1.12.1/2.2.1/3.2.1 or later.
Strapping* - Selects the encryption strapping mode for the channel as Clear, Secure, or 
Switched. Requires code 1.12.1/2.2.1/3.2.1 or later.
TG ID (Project 25 Only) - Selects the talk group for the selected channel. Press the 
<F2> key to display the current talk group ID, then press the <F2> key again to enter a 
different ID from 1-65,535*. You must enter this number directly using the DTMF 
keypad. Requires code 1.12.1/2.2.1/3.2.1 or later.
Channel Alias* - Programs the alias for the channel (DTMF keypad models only). You 
can enter a maximum of ten characters. Press the <F2> key once to display the current 
alias, then press it again to program a new alias. You program alphanumeric characters 
using the 0-9 keys. Pressing a key once enters the first letter on the key, then pressing it 
successive times enters the letters and the number on the key. For example, press the 
<2> key twice to enter “B”. Press the <F2> key to move to the next position or press it 
twice to enter a space. Requires code 1.12.1/2.2.1/3.2.1 or later.
TX TIMER - Enables or disables the time-out timer on the current channel. Press the 
Up/Down switch to select the on and off mode. When the desired setting displays, store 
it by pressing the <F2> key.
TX POWER - Selects the desired power output level. Press the Up/Down switch to 
scroll through the following choices. When the desired setting displays, store it by 
pressing the <F2> key.

• Power High - High transmit power

• Power Low - Low transmit power

• Power SW - Switchable power selectable by the High/Low power switch. You cannot 
choose this if that switch is not programmed.
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CTCSS/DCS Squelch Control (analog channel)

TX CODE - Programs the transmit Call Guard (CTCSS/DCS) code. The currently 
selected code displays. Press the Up/Down switch to select the desired code type 
(CTCSS analog or DCS digital). Then press the <F2> key to select it and enter the code 
number. This process is similar to programming a channel frequency as just described.
RX CODE - Selects the receive codes the same as TX CODE above. 

NAC Squelch Control (Project 25 Channel)

TX NAC - Programs the transmit Network Access Code (NAC) which can be any 
number from 0-4095. With later models, this number appears in hexadecimal from 000-
FFF. The procedure is similar to programming a TX FREQ as just described. If you 
enter an invalid code, a beep sounds, “INVALID” appears briefly, and you must reenter 
the code.
RX NAC - Selects the receive NAC through a similar process as described for TX 
NAC above. 

Transmit Type (Project 25 mixed mode only) - If the selected channel is a mixed mode, 
analog and Project 25 channel, this selects the transmit type. You can select either analog 
or digital (Project 25). This then determines if a TX CODE or TX NAC is programmed 
above.
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Chapter 1253xx Mobile Keypad Programming

Note Keypad programming is permitted by United States federal government users only. It is 
not permitted by any user regulated by the United States Federal Communications 
Commission (FCC). Radios with ARM code 1.22.0 or later require that the Keypad 
Programming option be factory enabled to program this feature. Refer to Section 3.3.

Since only United States federal government users are permitted to use keypad 
programming, you can only program United States federal government models of this 
radio with this feature.

You can only use keypad programming if it has been enabled by factory programming and 
a conventional mode option switch or menu parameter is programmed for the Keypad 
Programming function. You then select it by simply pressing that switch. You do not 
need to enter a password to use it. The text “CHNG ZONE” and a triangle in the display 
indicate keypad programming mode as follows:

Keypad programming allows you to change conventional channel parameters such as the 
transmit and receive frequencies, Call Guard squelch code, and encryption key. Also, you 
can use it to change several conventional mode timers. You cannot use it to reprogram 
disabled channels or any Project 25 Trunked, SMARTNET, or SmartZone information.

This section covers the following aspects of 51xx portable keypad programming:

• Menu description
• Zone change parameter
• Channel change parameter

• System parameters
• Channel parameters
Draft: June 29, 2006 PC Configure Programming Guide 12-1



53xx Mobile Keypad Programming 
12.1 Menu Description
53xx mobile keypad programming uses a menu system to let you select the parameters you 
want to change in the keypad programming mode. Rotate and press the Select switch to 
scroll through and select the available parameters. The available parameters and the 
section in which each is described are as follows:

• CHNG ZONE (Section 12.2)
• CHNG CHAN (Section 12.3)
• SYS PARMS (Section 12.4)
• CHAN PARMS (Section 12.5)
Press the Select switch to select the displayed parameter. Press the Keypad 
Programming option switch from one of the main menus to exit keypad programming, or 
from other menus to exit back one level. Figure 12.1 shows the keypad programming 
mode menu structure.

Figure 12.1 53xx Keypad Programming Menu Flowchart

12.2 Zone Change Parameter
The “CHNG ZONE” menu parameter selects the zone containing the conventional 
channel that you want to reprogram. It does not change the zone selected for normal 
operation. 

Press the Select switch to select the “CHNG ZONE” parameter, then scroll through the 
programmed zones by rotating that switch. When the desired zone displays, select it by 
pressing the Select switch.
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12.3 Channel Change Parameter
The “CHNG CHAN” menu parameter selects the conventional channel that you want to 
reprogram. You cannot select disabled or Project 25 Trunked/SMARTNET/SmartZone 
channels. This does not change the channel selected for normal operation. 

Press the Select switch to display “CHNG CHAN” and then rotate that switch to scroll 
through the programmed channels. When the desired channel displays, select it by 
pressing the Select switch.

12.4 System Parameters

Note If “ENTER PSWD” displays briefly when you try to select one of the following 
parameters, you must enter the zone password before you can make any changes. Refer to 
Section 10.4 for more information.

The “SYS PARMS” menu parameter selects the conventional mode timer that you want to 
reprogram. Press the Select switch to select the “SYS PARMS” parameter and then rotate 
that switch to display the desired parameter. Then press the Select switch again to select it.

SCAN TIMER - Selects the Scan Hold timer. Rotate the Select switch to decrement or 
increment the timer in 0.5-second steps from 0-7.5 or set it to 0 seconds to disabled it. 
When the desired value displays, store it by pressing the Select switch.

TX TIMER - Selects the transmit time-out timer. Rotate the Select switch to decrement 
or increment the timer in 15-second steps from 0-225 or disable it by selecting 0 seconds. 
When the desired value displays, store it by pressing the Select switch.

PEN TIMER - Selects the penalty timer. Rotate the Select switch to decrement or 
increment the timer in 15-second steps from 0-225 or disable it by selecting 0 seconds. 
When the desired value displays, store it by pressing the Select switch.

CONV TIMER - Selects the conversation timer. Rotate the Select switch to decrement or 
increment the timer in 30-second steps from 0-450 or disable it by selecting 0 seconds. 
When the desired value displays, store it by pressing the Select switch.

12.5 Channel Parameters

Note If “ENTER PSWD” displays briefly when you try to select one of the following 
parameters, you must enter the zone password before you can make any changes. Refer to 
Section 10.4 for more information.

The “CHAN PARMS” menu parameter selects the following conventional channel 
parameters that can be reprogrammed. Press Select switch to select the “CHAN PARMS” 
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parameter and then rotate that switch to display the desired parameter. Then press the 
Select switch again to select it. The squelch control parameters are unique to the type of 
conventional channel selected (analog or Project 25). 

Note If you select a mixed mode channel, you can program either the Rx Code (analog) and Rx 
NAC (Project 25) which follow. Also, if the Tx Type is Analog, a Tx Code is programmed, 
and if it is Digital (Project 25), a Tx NAC is programmed.

RX FREQ - Sets the receive channel frequency. To select the digit to change or move the 
cursor to the right, press the Select switch. Then to display the desired digit, rotate the 
Select switch. The frequency is stored after programming the last digit. If you enter an 
invalid frequency, a beep sounds, “INVALID” is displays briefly, and the frequency 
editing mode continues to be selected.

TX FREQ - Selects the transmit frequency the same as RX FREQ above.

CTCSS/DCS Squelch Control (Analog Channel)

RX CODE - Sets the receive Call Guard (CTCSS/DCS) code. The currently selected 
code is initially displayed. If required, rotate and press the Select switch to select the 
desired type (CTCSS analog or DCS digital). Then enter the desired code similar to 
programming a receive frequency as just described. If an invalid code is entered, a beep 
sounds, “INVALID” is briefly displayed, and the editing mode continues to be selected.
TX CODE - Selects the transmit codes the same as RX CODE above. 

NAC Squelch Control (Project 25 Channel)

RX NAC - Selects the receive Network Access Code (NAC) which can be any number 
from 0-4095. With later models, this number displays in hexadecimal from 000-FFF. 
Rotate and press the Select switch to enter the desired code. The displayed code is 
stored after the last digit is programmed. If you enter an invalid code, a beep sounds, 
“INVALID” is displays briefly, and the NAC editing mode continues to be selected.
TX NAC - Selects the transmit NAC the same as RX NAC above. 

TX POWER - Selects the desired power output level. Rotate the Select switch to scroll 
through the following choices. When the desired setting displays, store it by pressing the 
Select switch.

• POWER HIGH - High transmit power
• POWER LOW - Low transmit power
• POWER SW - Switchable power selectable by the High/Low power switch. This 

choice is not available if that switch is not programmed.
TX TIMER - Enables or disables the time-out timer on the current channel. Rotate the 
Select switch to toggle between the on and off mode, and when the desired setting 
displays, store it by pressing the Select switch.

Channel Alias - Programs the alias for the channel. Up to ten characters from A-Z and 0-
9 and spaces can be entered. Press Select switch once to display the current alias and then 
press it again or rotate it to program a new alias. Rotate the Select switch to display the 
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desired character and then press it to move to the next position. The number is stored after 
the Select switch is pressed with the last position selected. 

Note The next two parameters are programmed only if the radio is programmed for encryption.

Strapping - Selects the encryption strapping mode for the channel as Clear, Secure, or 
Switched. 

Key Select - Selects the encryption key for the channel if applicable. The key storage 
location of 0-15 (PID) or 1-16 (SLN) is selected. Refer to Section 4.2. If no keys are 
programmed, “No Keys” displays. 

CHAN SPACE (analog only) - Selects either wide or narrow band channel spacing on 
analog channels only. Rotate the Select switch to toggle between “WIDE” and 
“NARROW”, and when the desired setting displays, store it by pressing the Select switch.

SQ ADJUST (analog only) - Changes the preset squelch setting on that channel. The 
default setting is “0” and values of –7 to +7 can be selected. Increasing this setting toward 
+7 causes the squelch to open sooner so the radio can receive weaker signals, and 
decreasing it toward –7 causes the opposite to occur.

TG ID (Project 25 only) - Selects the talk group for the selected channel. Rotate the Select 
switch to display the alias of each preprogrammed talk group and then press it to store the 
desired talk group.

Transmit Type (Project 25 mixed mode only) - If the selected channel is a mixed mode, 
analog and Project 25 channel, this selects the transmit type. You can select either analog 
or digital (Project 25). This then determines if a Tx Code or Tx NAC is programmed 
above.
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Chapter 13System Key

To program certain SMARTNET/SmartZone and Project 25 Trunking parameters, 
PC Configure must detect the proper system key. EFJohnson provides the system key to 
authorized users. It is not the same as the encryption (hardware) key. You do not need it to 
program conventional analog and conventional Project 25 parameters.

The following sections describe the parameters that are available only with the system 
key. Other parameters associated with trunking, such as zones and channels, continue to 
be editable. If a system key has no trunking parameters enabled, a default trunking system 
of “One” is assigned and disabled parameters are unavailable for assignment to this 
system even though the radio can operate in trunking mode.

This section describes the following aspects of the PC Configure system key:

• Location
• Disabled SMARTNET/SmartZone parameters
• Disabled Project 25 trunking parameters

13.1 System Key Location
Copy the system key to the Keys folder of the PC Configure directory. This folder is 
automatically created when you install PC Configure. The default directory in which PC 
Configure is installed is as follows; some other location may also have been selected:

Program Files\EF Johnson\PCConfigure1_x.x.
You can also load the system key from other folders using the  
Radio > Load System Keys function. A dialog box appears that allows you to select the 
folder. When you restart the program, either the Keys folder or the last selected folder is 
selected, depending on the Tools > Preferences programming.Refer to Section 3.4.
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 - This icon on the system screen (Figure 8.1) indicates that a system key is 
present in this folder. If a system key is not present, this yellow key icon has a red “X” 
over it as shown above and you cannot program any of the following parameters. 

Note If the red “X” is still displayed after a key is copied to the Keys folder, you may need to 
restart the PC Configure program for it to recognize the key. In addition, be sure to select 
the new system ID contained in the key in the IDs > System drop down list on the Per 
System screen.

13.2 Disabled SMARTNET/SmartZone Parameters
You cannot add or delete the following SMARTNET/SmartZone parameters without the 
proper system key:

• System ID - You can only select the system IDs from available keys
• Individual ID
• Control channels
• Talk groups
• Announcement groups
• Emergency groups
• Connect tone
• Splinter channel option

13.3 Disabled Project 25 Trunking Parameters
The following Project 25 Trunked parameters cannot be added or deleted without the 
proper system key. You can still edit conventional analog and Project 25 parameters 

• WACN ID
• Home system ID
• Site ID
• RFSS ID
• Individual ID
• Control channels
• Talk groups
• Announcement groups
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Chapter 1451xx Cloning Procedure

After an introduction to 51xx Series cloning, this section describes PC Configure’s 
wireless cloning feature and tells how to perform cloning.

The cloning feature enables one radio to program another with identical information. You 
do not need PC Configure programming software to do this. This feature is available with 
51xx portables only. Other requirements are as follows:

• You must enable the Clone menu parameter in the master (sending) radio. The slave 
(receiving) radio does not need this parameter. 

• The master and slave radios must be identical models (same frequency range and 
options). 

• Both radios require Flash code Version 1.5.0/2.0.0/3.0.0 or later. Refer to Section 16.1. 
You need PC Configure Version 1.17 or later to program the Clone menu parameter.

You can only transfer zones with conventional analog and Project 25 channels using this 
function. This function will not transfer any SMARTNET/SmartZone or Project 25 
trunked information. Also, this function does not transfer Project 25 Unit ID, encryption 
keys, or the RSI ID or other OTAR information. The slave radio indicates cloned zones by 
an asterisk in the first character position of the zone alias. The first character is replaced by 
this asterisk.

14.1 Wireless Cloning
A wireless cloning feature is available that allows one radio to program another using an 
RF link instead of having to be connected by a cloning cable. Only 5100 radios with the 
following firmware or later have this feature. Refer to Section 16.1 for more information 
on 5100 versions.
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Version 1 Radio - 1.12.1 to 1.14.3 only
Version 2 Radios - 2.2.1 to 2.4.6 only
Version 3 Radios - Not available
Version 4 Radios - Available with all versions

The wireless cloning feature uses the Project 25 data functionality of the radio. Therefore, 
you must program a conventional Project 25 channel in both radios. You must program the 
slave radio with a Project 25 Unit ID. You must also enable Data Registration on Page 2 of 
the Per System screen Refer to Page 7-6. If it is not enabled, “Disabled” is displayed. 
Radios with wireless cloning capability have a selection in the cloning menu to select 
either Clone N (Normal) or Clone W (Wireless). If you select “Wireless,”, an additional 
menu appears. In this menu, you enter the Project 25 Unit ID of the slave radio. You then 
select the Zone/Complete mode. 

14.2 Cloning Procedure

1 With normal (non-wireless) cloning, connect the master radio to the slave radio using 
Cloning Cable, Part No. 023-5100-930.

2 On the master radio, select the Clone menu parameter and press the <F2> key. If 
applicable, select either Clone W (Wireless) or Clone N (Normal). If you select normal 
cloning or if you cannot select either, proceed to Step 4.

3 With wireless cloning, a screen appears for entering the Project 25 Unit ID of the slave 
radio. Enter this ID using the keypad (or the Up/Down keys) and the <F2> key. 

4 Select the Zone or Complete clone mode as desired. Operation in these modes is as 
follows:
Zone - This mode allows you to transfer only channel information for the selected zone. 
Information programmed on the Global, Radio Wide, and By System screens does not 
change. A list of the current conventional zones appears. Select the desired zone by 
highlighting it and pressing the <F2> key. A selected zone is indicated by an asterisk 
(*). Scroll to OK and press the <F2> key to begin the data transfer. This overwrites the 
selected zone in the slave radio. Previously, you could select multiple zones. They were 
appended to those in the slave radio.
Complete - This mode transfers all conventional programming information. This 
includes information on the Global, Radio Wide, and By System screens. Simply 
highlight Complete and press the <F2> key to begin the data transfer. This mode 
overwrites all this information currently in the slave radio. The radio does not retain any 
of the previous information except for the IDs as described in this section.
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Chapter 15Anti-Cloning Features

Note The following information refers to copying parameters from one radio to another using 
the PC Configure software. It does not refer to cloning using two radios described in 
Section 14. 

The latest releases of 5100 and 5300 radios and PC Configure software include safeguards 
to prevent unauthorized cloning of radios programmed for trunked operation using the PC 
Configure software. The trunked operating modes are SMARTNET, SmartZone, and 
Project 25 Trunking.

Many trunking parameters are restricted. You can program and edit them only with the 
correct system key as described in Section 13. These new safeguards prevent anyone from 
cloning another radio with restricted trunking information unless they have the correct 
system key.

15.1 Software Versions
The following PC Configure and radio software releases support these new cloning 
safeguards:

PC Configure - Version 1.20 or later
5100 Portable - Flash Code Version 1.9.0/2.0/3.0 or later
5300 Mobile - Flash Code Version 2.0/3.0 or later; ARM Code Version 1.22.0 or later 

(early models).

Programming 51xx and 53xx radios with the preceding software requires PC Configure 
Version 1.20 or later. You can also use PC Configure software to program radios with 
earlier software. However, 51xx/53xx radios with the earlier software do not support the 
new cloning safeguards. 
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15.2 Description of Changes
All programming files uploaded from a radio with the new version of PC Configure now 
include information on the specific radio from which it was read (uploaded). The 
Electronic Serial Number (ESN) and other information is stored in an encrypted form in 
the data file. This information is also included with the file if you save the file to disk. The 
following sections describe these other operations that have changed:

• Saving a new file
• Writing a file to radios containing new software
• Checking radios for earlier software
• Using earlier versions of PC Configure

15.2.1 Saving a New File

Note You can no longer save any type of new programming file to disk without a radio 
connected. 

If you save any file to disk, you must associate it with a specific radio. Therefore, when 
you save a new file for the first time, you must connect the radio to the computer so the 
ESN and other information can be read and stored with the file. However, you can open 
and edit a previously-saved disk file and then save it to disk again without a radio 
connected. Also, you do not need a system key to save files that contain trunking 
parameters.

15.2.2 Writing a File To Radios Containing New Software

Correct System Key Available - If you have a system key, you can edit a file with 
trunking parameters and write it to any radio. 

Correct System Key Not Available - If you do not have a system key, you cannot change 
restricted trunking parameters. Refer to Section 13. However, you can still change non-
restricted trunking and conventional parameters. You can only write the revised file to the 
radio that it originally came from. If you try to write it to a different radio, the data is 
scrambled and “Params Fail” is displayed by the radio when programming is finished. 

File Containing Only Conventional Parameters (Project 25 or Analog) - There are no 
editing restrictions. You can write data files to any radio.

15.2.3 Checking Radios for Earlier Software

When you initiate a file write operation, PC Configure checks the software version of the 
radio. If it is an earlier version than those listed in Section 15.1, the file is written 
regardless of the system key or the data file’s source radio. 
15-2 PC Configure Programming Guide Draft: June 29, 2006



Anti-Cloning Features
15.2.4 Using Earlier Versions of PC Configure

As described in Section 15.1, you must use PC Configure Version 1.20 or later to program 
radios with the new software. This applies to both conventional and trunked operation. 
Improper operation results if you use earlier versions.
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Chapter 1651xx and 53xx Firmware Versions

This section lists specifications of 51xx and 53xx firmware.

16.1 51xx Portable Firmware Versions
Beginning in November 2004, a new version of the 51xx portable is planned to begin 
shipping (Version 4 Table ). This version has new RF, Logic, and Universal Interface 
boards, and uses different firmware (application code) that is not compatible with earlier 
or other models. Table 16.1 shows the four 51xx radio versions and their associated 
firmware code bases.

Table 16.1 51xx Encryption Hardware Configurations 

Radio Version 

Application 
(Firmware)  
Code Base

Analog Channel 
Encryption

Digital Channel 
Encryption

DES DES-XL DES-OFB AES
Version 1  
(no module/software encryption) 
Uses the -110 Logic board and -410 UI Board. Not 
FIPS approved. 

1.xx Yes No Yes Yes 

Version 2  
(uses EFJ SEM module) 
Has the EFJohnson Subscriber Encryption Module 
(SEM) on the logic board. This version uses the -
150 Logic and -450 UI boards. All radios include 
the SEM. Factory programming enables the 
desired encryption options (if any). FIPS approved.

Initially same as 
above, then 2.xx

Yes No Yes Yes 

Note  
The version number is indicated by the 13th digit of the radio part number (242-51xx-xxx-xxV).
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16.1.1 Firmware Version Used

Table  shows the firmware code base used by each of the preceding four versions. This is 
the operating code of the radio that may occasionally be updated using the Transfer > 
Write Code To Radio function. Refer to Section 3.3. For example, if you load firmware 
with new features or fixes into a Version 2 radio, the radio will have a 2.xx version 
number. 

Initially, a few Version 2 radios used Version 1.11.9 code, which was the same as that 
used with the Version 1 radios. However, later code releases for Version 2 radios were not 
compatible with Version 1 radios, so Version 2.xx code must be used.

Note The code version (and therefore radio version) display briefly when you power-up the 
radio.

16.1.2 Programming Software Required

You must use PC Configure Version 1.25.0 or later to program radios with the Version 4 
boards. You can also use this software to program radios with the earlier boards.

16.2 53xx Mobile Firmware Versions
Beginning in November 2003, a revised logic board began shipping in 53xx models. This 
board uses a new control logic design similar to that used in the Version 2 and 3 51xx 

Version 3  
(uses Motorola UCM module) 
Has the Motorola Universal Crypto Module (UCM) 
on the logic board. This version uses the -160 
Logic and -460 UI boards. Order this when you 
require DES-XL encryption. FIPS approved.

3.xx Yes Yes Yes Yes 

Version 4  
(uses EFJ SEM module) 
Uses the same EFJohnson Subscriber Encryption 
Module (SEM) as Version 2 boards above. With the 
51xx, the 5500-120 Logic and 5500-420 UI boards 
are used. With the 53xx, the 5500-600 Logic board 
is used. All radios include the SEM. Factory 
programming enables the desired encryption 
options (if any). FIPS approved.

4.xx Yes No Yes Yes 

Table 16.1 51xx Encryption Hardware Configurations (continued)

Radio Version 

Application 
(Firmware)  
Code Base

Analog Channel 
Encryption

Digital Channel 
Encryption

DES DES-XL DES-OFB AES

Note  
The version number is indicated by the 13th digit of the radio part number (242-51xx-xxx-xxV).
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portable. This board is available in the following configurations. All versions are FIPS 
approved.

SEM Version - This version has the EFJohnson Security Encryption Module (SEM) 
soldered to the board. It is used whenever DES, DES-OFB, or AES encryption is required. 
It does not provide DES-XL encryption.

UCM Version - This includes a plug-in Motorola UCM encryption module. It is used 
whenever DES-XL Motorola proprietary encryption is required. It also provides DES, 
DES-OFB, or AES encryption. 

No Encryption Version - If encryption is not required, either the earlier logic board 
(described in Section 16.2.1) or the UCM version without the UCM module is used. 

16.2.1 Early Unrevised Logic Board

This logic board’s part number is 035-1800-4xx. It is being replaced by boards described 
in the preceding paragraphs. This board has an ARM processor and a jack for plugging in 
Motorola encryption modules that provide DES, DES-XL, DES-OFB, and AES 
encryption. It does not use the SEM module. 

16.2.2 Programming Software Required

You need PC Configure Version 1.21.2.5 or later to program radios with the revised 
board. You can also use this software to program radios with the unrevised board. Select 
the “5300” radio series for both boards. The software automatically detects which board is 
used when parameters are written to the radio.

16.2.3 Firmware Required

Radios with the revised and unrevised logic boards use different firmware (operating/
Flash software) as follows. When you download code using the PC Configure software 
(such as when you buy new features), you must power-up the radio when you enter the 
password so the logic board version can be detected.

Models with Revised Board - These models use a single code file similar to the 5100 
portable. SEM code has a 2.xx version number, and UCM code has a 3.xx version number. 

Models with Unrevised Board - These models use two code files. One programs DSP 
parameters. The other programs ARM processor parameters. These code sets have a 1.xx 
version number.
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16.2.4 Identifying Radios With Revised Logic Board

Refer to the radio serial number on the label on the bottom cover to determine if it is a 
version with the revised logic board. Radios with the new revised logic board have a 
revision letter (letter following 53xx0) of “G” or higher. Radios with an A-F revision letter 
have the early unrevised -4xx logic board described in Section 16.2.1. 

You can also determine the board version by noting the software version number that 
displays briefly when the radio is powered-up. The version numbers are as follows:

Software Version Displayed Board Version
Version 1.xx Early unrevised
Version 2.xx SEM version
Version 3.xx UCM version

16.2.5 Version 4 Models

Early 2005 availability is planned for 53xx models that have the Version 4 configuration 
described in Table 16.1. These models will also have new RF, logic, interface, and 
interconnect boards.
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Chapter 17Call Guard (CTCSS/DCS) 
and 800 MHz Channel Tables

Table 17.1 lists tone-based Call Guard tones and their associated frequencies. Table 17.2 
lists digital Call Guard codes.

Table 17.1 Recommended Tone Call Guard Codes
Code Freq Code Freq Code Freq Code Freq Code Freq

09 91.5 18 123.0 27 167.9 36* 233.6
01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 71.9 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39** 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40** 206.5
05 79.7 14 107.2 23 146.2 32 203.5 41** 229.1
06 82.5 15 110.9 24 151.4 33 210.7 42** 254.1
07 85.4 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35* 225.7
* These tones normally are not used because of their close proximity to the voice frequencies.
** These tones normally are not used because they may cause interference with adjacent tones.

Table 17.2 Recommended Digital Call Guard Codes
023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734
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Chapter 18Project 25 Packet Data Mode

Project 25 packet data transmissions are available with 5100 portable and 5300 mobile radios. A Project 25 
Packet Data option button or menu parameter (5100 only) toggles the data mode.

The Project 25 packet data mode allows a radio to act as a packet data modem for a remote application 
connected to the subscriber unit through an RS-232 or Serial Line Internet Protocol (SLIP) connection. 
The SLIP connection requires an Ethernet port which is available with the 5300x mobile radio.

18.1 Hardware Required
The 5100 Series portable radio connects to the external data equipment with the standard PC Configure 
programming cable through the RS-232 port (female DB9 connector).

The 5300 Series mobile radio must have a special data pigtail cable installed in it (Part No. 597-2002-282) 
to provide external access to the RS-232 lines. This cable also has a female DB9 connector for connecting 
the external equipment.

Table 18.1 lists the U. S. Federal Communications Commission’s (FCC’s) 800 MHz channels and each 
channel’s associated receive frequency (RX Freq) and transmit frequency (TX Freq).

Table 18.1 800 MHz Channels (continues on following pages)

FCC 
Channel RX Freq TX Freq
1 851.0125 806.0125
2 851.0375 806.0375
3 851.0625 806.0625
4 851.0875 806.0875
5 851.1125 806.1125
6 851.1375 806.1375
7 851.1625 806.1625
8 851.1875 806.1875
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9 851.2125 806.2125
10 851.2375 806.2375
11 851.2625 806.2625
12 851.2875 806.2875
13 851.3125 806.3125
14 851.3375 806.3375
15 851.3625 806.3625
16 851.3875 806.3875
17 851.4125 806.4125
18 851.4375 806.4375
19 851.4625 806.4625
20 851.4875 806.4875
21 851.5125 806.5125
22 851.5375 806.5375
23 851.5625 806.5625
24 851.5875 806.5875
25 851.6125 806.6125
26 851.6375 806.6375
27 851.6625 806.6625
28 851.6875 806.6875
29 851.7125 806.7125
30 851.7375 806.7375
31 851.7625 806.7625
32 851.7875 806.7875
33 851.8125 806.8125
34 851.8375 806.8375
35 851.8625 806.8625
36 851.8875 806.8875
37 851.9125 806.9125
38 851.9375 806.9375
39 851.9625 806.9625
40 851.9875 806.9875
41 852.0125 807.0125
42 852.0375 807.0375
43 852.0625 807.0625
44 852.0875 807.0875
45 852.1125 807.1125
46 852.1375 807.1375
47 852.1625 807.1625
48 852.1875 807.1875
49 852.2125 807.2125
50 852.2375 807.2375

FCC 
Channel RX Freq TX Freq

51 852.2625 807.2625
52 852.2875 807.2875
53 852.3125 807.3125
54 852.3375 807.3375
55 852.3625 807.3625
56 852.3875 807.3875
57 852.4125 807.4125
58 852.4375 807.4375
59 852.4625 807.4625
60 852.4875 807.4875
61 852.5125 807.5125
62 852.5375 807.5375
63 852.5625 807.5625
64 852.5875 807.5875
65 852.6125 807.6125
66 852.6375 807.6375
67 852.6625 807.6625
68 852.6875 807.6875
69 852.7125 807.7125
70 852.7375 807.7375
71 852.7625 807.7625
72 852.7875 807.7875
73 852.8125 807.8125
74 852.8375 807.8375
75 852.8625 807.8625
76 852.8875 807.8875
77 852.9125 807.9125
78 852.9375 807.9375
79 852.9625 807.9625
80 852.9875 807.9875
81 853.0125 808.0125
82 853.0375 808.0375
83 853.0625 808.0625
84 853.0875 808.0875
85 853.1125 808.1125
86 853.1375 808.1375
87 853.1625 808.1625
88 853.1875 808.1875
89 853.2125 808.2125
90 853.2375 808.2375
91 853.2625 808.2625
92 853.2875 808.2875

FCC 
Channel RX Freq TX Freq

93 853.3125 808.3125
94 853.3375 808.3375
95 853.3625 808.3625
96 853.3875 808.3875
97 853.4125 808.4125
98 853.4375 808.4375
99 853.4625 808.4625
100 853.4875 808.4875
101 853.5125 808.5125
102 853.5375 808.5375
103 853.5625 808.5625
104 853.5875 808.5875
105 853.6125 808.6125
106 853.6375 808.6375
107 853.6625 808.6625
108 853.6875 808.6875
109 853.7125 808.7125
110 853.7375 808.7375
111 853.7625 808.7625
112 853.7875 808.7875
113 853.8125 808.8125
114 853.8375 808.8375
115 853.8625 808.8625
116 853.8875 808.8875
117 853.9125 808.9125
118 853.9375 808.9375
119 853.9625 808.9625
120 853.9875 808.9875
121 854.0125 809.0125
122 854.0375 809.0375
123 854.0625 809.0625
124 854.0875 809.0875
125 854.1125 809.1125
126 854.1375 809.1375
127 854.1625 809.1625
128 854.1875 809.1875
129 854.2125 809.2125
130 854.2375 809.2375
131 854.2625 809.2625
132 854.2875 809.2875
133 854.3125 809.3125
134 854.3375 809.3375

FCC 
Channel RX Freq TX Freq
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135 854.3625 809.3625
136 854.3875 809.3875
137 854.4125 809.4125
138 854.4375 809.4375
139 854.4625 809.4625
140 854.4875 809.4875
141 854.5125 809.5125
142 854.5375 809.5375
143 854.5625 809.5625
144 854.5875 809.5875
145 854.6125 809.6125
146 854.6375 809.6375
147 854.6625 809.6625
148 854.6875 809.6875
149 854.7125 809.7125
150 854.7375 809.7375
151 854.7625 809.7625
152 854.7875 809.7875
153 854.8125 809.8125
154 854.8375 809.8375
155 854.8625 809.8625
156 854.8875 809.8875
157 854.9125 809.9125
158 854.9375 809.9375
159 854.9625 809.9625
160 854.9875 809.9875
161 855.0125 810.0125
162 855.0375 810.0375
163 855.0625 810.0625
164 855.0875 810.0875
165 855.1125 810.1125
166 855.1375 810.1375
167 855.1625 810.1625
168 855.1875 810.1875
169 855.2125 810.2125
170 855.2375 810.2375
171 855.2625 810.2625
172 855.2875 810.2875
173 855.3125 810.3125
174 855.3375 810.3375
175 855.3625 810.3625
176 855.3875 810.3875

FCC 
Channel RX Freq TX Freq

177 855.4125 810.4125
178 855.4375 810.4375
179 855.4625 810.4625
180 855.4875 810.4875
181 855.5125 810.5125
182 855.5375 810.5375
183 855.5625 810.5625
184 855.5875 810.5875
185 855.6125 810.6125
186 855.6375 810.6375
187 855.6625 810.6625
188 855.6875 810.6875
189 855.7125 810.7125
190 855.7375 810.7375
191 855.7625 810.7625
192 855.7875 810.7875
193 855.8125 810.8125
194 855.8375 810.8375
195 855.8625 810.8625
196 855.8875 810.8875
197 855.9125 810.9125
198 855.9375 810.9375
199 855.9625 810.9625
200 855.9875 810.9875
201 856.0125 811.0125
202 856.0375 811.0375
203 856.0625 811.0625
204 856.0875 811.0875
205 856.1125 811.1125
206 856.1375 811.1375
207 856.1625 811.1625
208 856.1875 811.1875
209 856.2125 811.2125
210 856.2375 811.2375
211 856.2625 811.2625
212 856.2875 811.2875
213 856.3125 811.3125
214 856.3375 811.3375
215 856.3625 811.3625
216 856.3875 811.3875
217 856.4125 811.4125
218 856.4375 811.4375

FCC 
Channel RX Freq TX Freq

219 856.4625 811.4625
220 856.4875 811.4875
221 856.5125 811.5125
222 856.5375 811.5375
223 856.5625 811.5625
224 856.5875 811.5875
225 856.6125 811.6125
226 856.6375 811.6375
227 856.6625 811.6625
228 856.6875 811.6875
229 856.7125 811.7125
230 856.7375 811.7375
231 856.7625 811.7625
232 856.7875 811.7875
233 856.8125 811.8125
234 856.8375 811.8375
235 856.8625 811.8625
236 856.8875 811.8875
237 856.9125 811.9125
238 856.9375 811.9375
239 856.9625 811.9625
240 856.9875 811.9875
241 857.0125 812.0125
242 857.0375 812.0375
243 857.0625 812.0625
244 857.0875 812.0875
245 857.1125 812.1125
246 857.1375 812.1375
247 857.1625 812.1625
248 857.1875 812.1875
249 857.2125 812.2125
250 857.2375 812.2375
251 857.2625 812.2625
252 857.2875 812.2875
253 857.3125 812.3125
254 857.3375 812.3375
255 857.3625 812.3625
256 857.3875 812.3875
257 857.4125 812.4125
258 857.4375 812.4375
259 857.4625 812.4625
260 857.4875 812.4875

FCC 
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261 857.5125 812.5125
262 857.5375 812.5375
263 857.5625 812.5625
264 857.5875 812.5875
265 857.6125 812.6125
266 857.6375 812.6375
267 857.6625 812.6625
268 857.6875 812.6875
269 857.7125 812.7125
270 857.7375 812.7375
271 857.7625 812.7625
272 857.7875 812.7875
273 857.8125 812.8125
274 857.8375 812.8375
275 857.8625 812.8625
276 857.8875 812.8875
277 857.9125 812.9125
278 857.9375 812.9375
279 857.9625 812.9625
280 857.9875 812.9875
281 858.0125 813.0125
282 858.0375 813.0375
283 858.0625 813.0625
284 858.0875 813.0875
285 858.1125 813.1125
286 858.1375 813.1375
287 858.1625 813.1625
288 858.1875 813.1875
289 858.2125 813.2125
290 858.2375 813.2375
291 858.2625 813.2625
292 858.2875 813.2875
293 858.3125 813.3125
294 858.3375 813.3375
295 858.3625 813.3625
296 858.3875 813.3875
297 858.4125 813.4125
298 858.4375 813.4375
299 858.4625 813.4625
300 858.4875 813.4875
301 858.5125 813.5125
302 858.5375 813.5375

FCC 
Channel RX Freq TX Freq

303 858.5625 813.5625
304 858.5875 813.5875
305 858.6125 813.6125
306 858.6375 813.6375
307 858.6625 813.6625
308 858.6875 813.6875
309 858.7125 813.7125
310 858.7375 813.7375
311 858.7625 813.7625
312 858.7875 813.7875
313 858.8125 813.8125
314 858.8375 813.8375
315 858.8625 813.8625
316 858.8875 813.8875
317 858.9125 813.9125
318 858.9375 813.9375
319 858.9625 813.9625
320 858.9875 813.9875
321 859.0125 814.0125
322 859.0375 814.0375
323 859.0625 814.0625
324 859.0875 814.0875
325 859.1125 814.1125
326 859.1375 814.1375
327 859.1625 814.1625
328 859.1875 814.1875
329 859.2125 814.2125
330 859.2375 814.2375
331 859.2625 814.2625
332 859.2875 814.2875
333 859.3125 814.3125
334 859.3375 814.3375
335 859.3625 814.3625
336 859.3875 814.3875
337 859.4125 814.4125
338 859.4375 814.4375
339 859.4625 814.4625
340 859.4875 814.4875
341 859.5125 814.5125
342 859.5375 814.5375
343 859.5625 814.5625
344 859.5875 814.5875

FCC 
Channel RX Freq TX Freq

345 859.6125 814.6125
346 859.6375 814.6375
347 859.6625 814.6625
348 859.6875 814.6875
349 859.7125 814.7125
350 859.7375 814.7375
351 859.7625 814.7625
352 859.7875 814.7875
353 859.8125 814.8125
354 859.8375 814.8375
355 859.8625 814.8625
356 859.8875 814.8875
357 859.9125 814.9125
358 859.9375 814.9375
359 859.9625 814.9625
360 859.9875 814.9875
361 860.0125 815.0125
362 860.0375 815.0375
363 860.0625 815.0625
364 860.0875 815.0875
365 860.1125 815.1125
366 860.1375 815.1375
367 860.1625 815.1625
368 860.1875 815.1875
369 860.2125 815.2125
370 860.2375 815.2375
371 860.2625 815.2625
372 860.2875 815.2875
373 860.3125 815.3125
374 860.3375 815.3375
375 860.3625 815.3625
376 860.3875 815.3875
377 860.4125 815.4125
378 860.4375 815.4375
379 860.4625 815.4625
380 860.4875 815.4875
381 860.5125 815.5125
382 860.5375 815.5375
383 860.5625 815.5625
384 860.5875 815.5875
385 860.6125 815.6125
386 860.6375 815.6375
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387 860.6625 815.6625
388 860.6875 815.6875
389 860.7125 815.7125
390 860.7375 815.7375
391 860.7625 815.7625
392 860.7875 815.7875
393 860.8125 815.8125
394 860.8375 815.8375
395 860.8625 815.8625
396 860.8875 815.8875
397 860.9125 815.9125
398 860.9375 815.9375
399 860.9625 815.9625
400 860.9875 815.9875
401 861.0125 816.0125
402 861.0375 816.0375
403 861.0625 816.0625
404 861.0875 816.0875
405 861.1125 816.1125
406 861.1375 816.1375
407 861.1625 816.1625
408 861.1875 816.1875
409 861.2125 816.2125
410 861.2375 816.2375
411 861.2625 816.2625
412 861.2875 816.2875
413 861.3125 816.3125
414 861.3375 816.3375
415 861.3625 816.3625
416 861.3875 816.3875
417 861.4125 816.4125
418 861.4375 816.4375
419 861.4625 816.4625
420 861.4875 816.4875
421 861.5125 816.5125
422 861.5375 816.5375
423 861.5625 816.5625
424 861.5875 816.5875
425 861.6125 816.6125
426 861.6375 816.6375
427 861.6625 816.6625
428 861.6875 816.6875

FCC 
Channel RX Freq TX Freq

429 861.7125 816.7125
430 861.7375 816.7375
431 861.7625 816.7625
432 861.7875 816.7875
433 861.8125 816.8125
434 861.8375 816.8375
435 861.8625 816.8625
436 861.8875 816.8875
437 861.9125 816.9125
438 861.9375 816.9375
439 861.9625 816.9625
440 861.9875 816.9875
441 862.0125 817.0125
442 862.0375 817.0375
443 862.0625 817.0625
444 862.0875 817.0875
445 862.1125 817.1125
446 862.1375 817.1375
447 862.1625 817.1625
448 862.1875 817.1875
449 862.2125 817.2125
450 862.2375 817.2375
451 862.2625 817.2625
452 862.2875 817.2875
453 862.3125 817.3125
454 862.3375 817.3375
455 862.3625 817.3625
456 862.3875 817.3875
457 862.4125 817.4125
458 862.4375 817.4375
459 862.4625 817.4625
460 862.4875 817.4875
461 862.5125 817.5125
462 862.5375 817.5375
463 862.5625 817.5625
464 862.5875 817.5875
465 862.6125 817.6125
466 862.6375 817.6375
467 862.6625 817.6625
468 862.6875 817.6875
469 862.7125 817.7125
470 862.7375 817.7375

FCC 
Channel RX Freq TX Freq

471 862.7625 817.7625
472 862.7875 817.7875
473 862.8125 817.8125
474 862.8375 817.8375
475 862.8625 817.8625
476 862.8875 817.8875
477 862.9125 817.9125
478 862.9375 817.9375
479 862.9625 817.9625
480 862.9875 817.9875
481 863.0125 818.0125
482 863.0375 818.0375
483 863.0625 818.0625
484 863.0875 818.0875
485 863.1125 818.1125
486 863.1375 818.1375
487 863.1625 818.1625
488 863.1875 818.1875
489 863.2125 818.2125
490 863.2375 818.2375
491 863.2625 818.2625
492 863.2875 818.2875
493 863.3125 818.3125
494 863.3375 818.3375
495 863.3625 818.3625
496 863.3875 818.3875
497 863.4125 818.4125
498 863.4375 818.4375
499 863.4625 818.4625
500 863.4875 818.4875
501 863.5125 818.5125
502 863.5375 818.5375
503 863.5625 818.5625
504 863.5875 818.5875
505 863.6125 818.6125
506 863.6375 818.6375
507 863.6625 818.6625
508 863.6875 818.6875
509 863.7125 818.7125
510 863.7375 818.7375
511 863.7625 818.7625
512 863.7875 818.7875

FCC 
Channel RX Freq TX Freq
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513 863.8125 818.8125
514 863.8375 818.8375
515 863.8625 818.8625
516 863.8875 818.8875
517 863.9125 818.9125
518 863.9375 818.9375
519 863.9625 818.9625
520 863.9875 818.9875
521 864.0125 819.0125
522 864.0375 819.0375
523 864.0625 819.0625
524 864.0875 819.0875
525 864.1125 819.1125
526 864.1375 819.1375
527 864.1625 819.1625
528 864.1875 819.1875
529 864.2125 819.2125
530 864.2375 819.2375
531 864.2625 819.2625
532 864.2875 819.2875
533 864.3125 819.3125
534 864.3375 819.3375
535 864.3625 819.3625
536 864.3875 819.3875
537 864.4125 819.4125
538 864.4375 819.4375
539 864.4625 819.4625
540 864.4875 819.4875
541 864.5125 819.5125
542 864.5375 819.5375
543 864.5625 819.5625
544 864.5875 819.5875
545 864.6125 819.6125
546 864.6375 819.6375
547 864.6625 819.6625
548 864.6875 819.6875
549 864.7125 819.7125
550 864.7375 819.7375
551 864.7625 819.7625
552 864.7875 819.7875
553 864.8125 819.8125
554 864.8375 819.8375

FCC 
Channel RX Freq TX Freq

555 864.8625 819.8625
556 864.8875 819.8875
557 864.9125 819.9125
558 864.9375 819.9375
559 864.9625 819.9625
560 864.9875 819.9875
561 865.0125 820.0125
562 865.0375 820.0375
563 865.0625 820.0625
564 865.0875 820.0875
565 865.1125 820.1125
566 865.1375 820.1375
567 865.1625 820.1625
568 865.1875 820.1875
569 865.2125 820.2125
570 865.2375 820.2375
571 865.2625 820.2625
572 865.2875 820.2875
573 865.3125 820.3125
574 865.3375 820.3375
575 865.3625 820.3625
576 865.3875 820.3875
577 865.4125 820.4125
578 865.4375 820.4375
579 865.4625 820.4625
580 865.4875 820.4875
581 865.5125 820.5125
582 865.5375 820.5375
583 865.5625 820.5625
584 865.5875 820.5875
585 865.6125 820.6125
586 865.6375 820.6375
587 865.6625 820.6625
588 865.6875 820.6875
589 865.7125 820.7125
590 865.7375 820.7375
591 865.7625 820.7625
592 865.7875 820.7875
593 865.8125 820.8125
594 865.8375 820.8375
595 865.8625 820.8625
596 865.8875 820.8875

FCC 
Channel RX Freq TX Freq

597 865.9125 820.9125
598 865.9375 820.9375
599 865.9625 820.9625
600 865.9875 820.9875
- 866.0000 821.0000
601 866.0125 821.0125
- 866.0250 821.0250
602 866.0375 821.0375
603 866.0500 821.0500
604 866.0625 821.0625
605 866.0750 821.0750
606 866.0875 821.0875
607 866.1000 821.1000
608 866.1125 821.1125
609 866.1250 821.1250
610 866.1375 821.1375
611 866.1500 821.1500
612 866.1625 821.1625
613 866.1750 821.1750
614 866.1875 821.1875
615 866.2000 821.2000
616 866.2125 821.2125
617 866.2250 821.2250
618 866.2375 821.2375
619 866.2500 821.2500
620 866.2625 821.2625
621 866.2750 821.2750
622 866.2875 821.2875
623 866.3000 821.3000
624 866.3125 821.3125
625 866.3250 821.3250
626 866.3375 821.3375
627 866.3500 821.3500
628 866.3625 821.3625
629 866.3750 821.3750
630 866.3875 821.3875
631 866.4000 821.4000
632 866.4125 821.4125
633 866.4250 821.4250
634 866.4375 821.4375
635 866.4500 821.4500
636 866.4625 821.4625

FCC 
Channel RX Freq TX Freq
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637 866.4750 821.4750
638 866.4875 821.4875
- 866.5000 821.5000
639 866.5125 821.5125
- 866.5250 821.5250
640 866.5375 821.5375
641 866.5500 821.5500
642 866.5625 821.5625
643 866.5750 821.5750
644 866.5875 821.5875
645 866.6000 821.6000
646 866.6125 821.6125
647 866.6250 821.6250
648 866.6375 821.6375
649 866.6500 821.6500
650 866.6625 821.6625
651 866.6750 821.6750
652 866.6875 821.6875
653 866.7000 821.7000
654 866.7125 821.7125
655 866.7250 821.7250
656 866.7375 821.7375
657 866.7500 821.7500
658 866.7625 821.7625
659 866.7750 821.7750
660 866.7875 821.7875
661 866.8000 821.8000
662 866.8125 821.8125
663 866.8250 821.8250
664 866.8375 821.8375
665 866.8500 821.8500
666 866.8625 821.8625
667 866.8750 821.8750
668 866.8875 821.8875
669 866.9000 821.9000
670 866.9125 821.9125
671 866.9250 821.9250
672 866.9375 821.9375
673 866.9500 821.9500
674 866.9625 821.9625
675 866.9750 821.9750
676 866.9875 821.9875

FCC 
Channel RX Freq TX Freq

- 867.0000 822.0000
677 867.0125 822.0125
- 867.0250 822.0250
678 867.0375 822.0375
679 867.0500 822.0500
680 867.0625 822.0625
681 867.0750 822.0750
682 867.0875 822.0875
683 867.1000 822.1000
684 867.1125 822.1125
685 867.1250 822.1250
686 867.1375 822.1375
687 867.1500 822.1500
688 867.1625 822.1625
689 867.1750 822.1750
690 867.1875 822.1875
691 867.2000 822.2000
692 867.2125 822.2125
693 867.2250 822.2250
694 867.2375 822.2375
695 867.2500 822.2500
696 867.2625 822.2625
697 867.2750 822.2750
698 867.2875 822.2875
699 867.3000 822.3000
700 867.3125 822.3125
701 867.3250 822.3250
702 867.3375 822.3375
703 867.3500 822.3500
704 867.3625 822.3625
705 867.3750 822.3750
706 867.3875 822.3875
707 867.4000 822.4000
708 867.4125 822.4125
709 867.4250 822.4250
710 867.4375 822.4375
711 867.4500 822.4500
712 867.4625 822.4625
713 867.4750 822.4750
714 867.4875 822.4875
- 867.5000 822.5000
715 867.5125 822.5125

FCC 
Channel RX Freq TX Freq

- 867.5250 822.5250
716 867.5375 822.5375
717 867.5500 822.5500
718 867.5625 822.5625
719 867.5750 822.5750
720 867.5875 822.5875
721 867.6000 822.6000
722 867.6125 822.6125
723 867.6250 822.6250
724 867.6375 822.6375
725 867.6500 822.6500
726 867.6625 822.6625
727 867.6750 822.6750
728 867.6875 822.6875
729 867.7000 822.7000
730 867.7125 822.7125
731 867.7250 822.7250
732 867.7375 822.7375
733 867.7500 822.7500
734 867.7625 822.7625
735 867.7750 822.7750
736 867.7875 822.7875
737 867.8000 822.8000
738 867.8125 822.8125
739 867.8250 822.8250
740 867.8375 822.8375
741 867.8500 822.8500
742 867.8625 822.8625
743 867.8750 822.8750
744 867.8875 822.8875
745 867.9000 822.9000
746 867.9125 822.9125
747 867.9250 822.9250
748 867.9375 822.9375
749 867.9500 822.9500
750 867.9625 822.9625
751 867.9750 822.9750
752 867.9875 822.9875
- 868.0000 823.0000
753 868.0125 823.0125
- 868.0250 823.0250
754 868.0375 823.0375

FCC 
Channel RX Freq TX Freq
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755 868.0500 823.0500
756 868.0625 823.0625
757 868.0750 823.0750
758 868.0875 823.0875
759 868.1000 823.1000
760 868.1125 823.1125
761 868.1250 823.1250
762 868.1375 823.1375
763 868.1500 823.1500
764 868.1625 823.1625
765 868.1750 823.1750
766 868.1875 823.1875
767 868.2000 823.2000
768 868.2125 823.2125
769 868.2250 823.2250
770 868.2375 823.2375
771 868.2500 823.2500
772 868.2625 823.2625
773 868.2750 823.2750
774 868.2875 823.2875
775 868.3000 823.3000
776 868.3125 823.3125
777 868.3250 823.3250
778 868.3375 823.3375
779 868.3500 823.3500
780 868.3625 823.3625
781 868.3750 823.3750
782 868.3875 823.3875
783 868.4000 823.4000
784 868.4125 823.4125
785 868.4250 823.4250
786 868.4375 823.4375
787 868.4500 823.4500
788 868.4625 823.4625
789 868.4750 823.4750
790 868.4875 823.4875
791 868.5000 823.5000
792 868.5125 823.5125
793 868.5250 823.5250
794 868.5375 823.5375
795 868.5500 823.5500
796 868.5625 823.5625

FCC 
Channel RX Freq TX Freq

797 868.5750 823.5750
798 868.5875 823.5875
799 868.6000 823.6000
800 868.6125 823.6125
801 868.6250 823.6250
802 868.6375 823.6375
803 868.6500 823.6500
804 868.6625 823.6625
805 868.6750 823.6750
806 868.6875 823.6875
807 868.7000 823.7000
808 868.7125 823.7125
809 868.7250 823.7250
810 868.7375 823.7375
811 868.7500 823.7500
812 868.7625 823.7625
813 868.7750 823.7750
814 868.7875 823.7875
815 868.8000 823.8000
816 868.8125 823.8125
817 868.8250 823.8250
818 868.8375 823.8375
819 868.8500 823.8500
820 868.8625 823.8625
821 868.8750 823.8750
822 868.8875 823.8875
823 868.9000 823.9000
824 868.9125 823.9125
825 868.9250 823.9250
826 868.9375 823.9375
827 868.9500 823.9500
828 868.9625 823.9625
829 868.9750 823.9750
830 868.9875 823.9875
- 869.0000 824.0000
- 869.0125 824.0125
- 869.0250 824.0250
- 869.0375 824.0375
- 869.0500 824.0500
- 869.0625 824.0625
- 869.0750 824.0750
- 869.0875 824.0875

FCC 
Channel RX Freq TX Freq

- 869.1000 824.1000
- 869.1125 824.1125
- 869.1250 824.1250
- 869.1375 824.1375
- 869.1500 824.1500
- 869.1625 824.1625
- 869.1750 824.1750
- 869.1875 824.1875
- 869.2000 824.2000
- 869.2125 824.2125
- 869.2250 824.2250
- 869.2375 824.2375
- 869.2500 824.2500
- 869.2625 824.2625
- 869.2750 824.2750
- 869.2875 824.2875
- 869.3000 824.3000
- 869.3125 824.3125
- 869.3250 824.3250
- 869.3375 824.3375
- 869.3500 824.3500
- 869.3625 824.3625
- 869.3750 824.3750
- 869.3875 824.3875
- 869.4000 824.4000
- 869.4125 824.4125
- 869.4250 824.4250
- 869.4375 824.4375
- 869.4500 824.4500
- 869.4625 824.4625
- 869.4750 824.4750
- 869.4875 824.4875
- 869.5000 824.5000
- 869.5125 824.5125
- 869.5250 824.5250
- 869.5375 824.5375
- 869.5500 824.5500
- 869.5625 824.5625
- 869.5750 824.5750
- 869.5875 824.5875
- 869.6000 824.6000
- 869.6125 824.6125
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- 869.6250 824.6250
- 869.6375 824.6375
- 869.6500 824.6500
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